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Module 1 - 1.1 ServiceNow Overview servicenow

Objectives

* What is ServiceNow?

* What is the ServiceNow Instance?

Users and Groups

L ]

Key Platform Ul Components
~ Application Navigator

— Content Frame

- Banner Frame

Mobile Access

L]

Product Documentation
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What is ServiceNow? servicenow

ServiceNow is a cloud-
based platform deployed
in a browser that contains
applications and data that
can vary by instance and

user, automating common SUAPPS
business processes

I

\ CUSTOMER /

SEchy SECURITY

Work at Lightspeed™

A leader in Enterprise Service Management (ESM), the ServiceNow Service Automation Platform
provides a modern, easy-to-use, service management solution in the cloud allowing your
organization to automate manual repetitive setup tasks, manage your core IT processes, standardize
service delivery, and focus on your core business, not just ITSM infrastructure.

ServiceNow provides all of this to users from a configurable web-based user interface, built on top
of a flexible table schema.

The ServiceNow platform and the applications that run on it use a single system of record and a
common data model to consolidate your organization’s business processes.

Another advantage to this single system is that it can be leveraged to build custom applications.

The ServiceNow platform provides a Platform as a Service (PaaS), a cloud-based computing model
that provides the infrastructure needed to develop, run, and manage applications.

It is not limited to a specific department or function but encompasses the entire enterprise.

User Interface & Navigation
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What is the ServiceNow Instance? servicenow

An instance is a single implementation of the ServiceNow platform
* Independent, changeable, and highly configurable
* Not shared with other ServiceNow customers (single-tenant)
* Each instance has applications
* Each instance has customer data that can be exchanged between instances
* Upgrades are made on individual instances

An instance is located (hosted) in one of the ServiceNow Data Centers around the world, or for a
very, very small percentage of our customers, an instance can be implemented onsite at the
customer’s location. Each ServiceNow instance has a unique URL that uses a format similar to
https://<instance name>.service-now.com/.

ServiceNow utilizes an advanced, multi-instance, single-tenant architecture as the default offering
for customers, meaning an instance features an individually isolated database containing data,
applications, and customizations.

The ServiceNow multi-instance architecture, organized in an instance stack, provides these distinct
advantages:

* The multi-instance architecture allows ServiceNow to perform actions on individual customer
instances such as performing an upgrade, on a schedule that fits the compliance requirements
and needs of your enterprise.

* Datais truly isolated in their own databases, making hardware and software maintenance on
these unique customer instances far easier to perform and issues can be resolved on a customer-
by-customer basis.

Each customer organization receives two instances of ServiceNow: production and sub-production.
They have the ability to obtain additional sub-production instances to be used for User Acceptance
Testing (UAT), Review, Development, or Quality Assurance (QA).

User Interface & Navigation
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Users and Groups servicenow

Users -l — Groups-

Within a ServiceNow instance, users are: A collection of users is a group

Users are represented by a record created or
imported into the User [sys_user] table A group is one record stored in the

* Updating records
Groups share a common purpose such as

users approving change requests or users
* Requesting items receiving e-mail notifications
* Implementing workflows

* Importing data

« Approving knowledge content Examples of Groups include:

Running reports * Service Desk

+  Developing applications * Knowledge Base Authors

* HR Administrators

Group [sys_user_group] table

Manage the individuals who can access ServiceNow by defining them as users in the platform.
NOTE: User names (represented by user IDs) are unique in ServiceNow.

Users are authenticated by various methods, including:

Local database: The user name and password in their user record in the instance database

Multifactor: The user name and password in the database and a passcode sent to the user's
mobile device that has Google Authenticator installed

LDAP: The user name and password are accessed via LDAP in the corporate directory, which
has a matching user account in the ServiceNow database

SAML 2.0: The user name and password configured in a SAML identity provider account,
which has a matching user account in the database

OAuth 2.0: The user name and password of OAuth identity provider, which has a matching
user account in the database

Digest Token: An encrypted digest of the user name and password in the user record

User credentials are matched to different saved credentials for each method. Multiple Provider SSO
allows the selection/use of several identity providers (IdPs) to manage authentication as well as
retain local database authentication.

A group is part of the user hierarchy, and a user is part of a group. Groups may be imported from a
corporate directory (LDAP) or created manually in ServiceNow.

User Interface & Navigation
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Key Platform Ul Components servicenow
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The User Interface (Ul) is the main way for users to interact with the applications and information in
a ServiceNow instance. Notable ServiceNow features include real-time form updates, user presence,
an application navigator designed with tabs for favorites and history, and enhanced activity streams

all of which you will explore in this training. This is an example of the System Administration
homepage.

The ServiceNow user interface is divided into three areas:

1. Banner Frame: The Banner Frame highlights important tools and settings that apply to your
instance.

2. Application Navigator: The components of the Application Navigator, the panel on the left
side, are based upon your assigned role(s). The navigator may be expanded (as shown

above) or collapsed. The navigator provides links to all application menus and modules,
based on your permissions.

3. Content Frame: The Content Frame displays information, such as lists, forms, dashboards,
knowledge bases, and service catalogs depending on where you navigate within the
platform. This also impacts how the information is visually represented.

NOTE: The position of these components on your screen may vary depending on your region.

User Interface & Navigation
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Application Navigator servicenow

The Application Navigator is a
list of available applications and

their corresponding modules = Modules enable navigation

to different areas of the
platform, including:

— Links to a new record

Application Menu

— Filtered lists of records
Applications are a collection

of modules; modules and data
that deliver a service and
manage business processes

— Special view pages

Applications are a group of modules, or pages, that provide related information and functionality in

an instance. Modules can contain links to a new record, lists of records with varying filters applied,
and special visual tools.

For example, the Incident application contains modules for creating and viewing incidents. The

Configuration application contains modules for changing and accessing servers, databases, and
networks.

User Interface & Navigation
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Application Navigator: Filtering servicenuw

Use the All Applications Above the application list, use the Filter Navigator to

icon to view all applications quickly navigate to applications and modules

within the navigator ,
Simply begin typing the application or module name:

el

1. All modules with the keyword display

2. All modules within an application that
contains the keyword display

The Application Navigator provides access to all applications and the modules they contain, enabling
users to quickly find information and services.

To view all applications within the navigator, ensure that the All Applications icon is selected at the
top left of the navigator.

TIP: Double-click the All Applications icon to expand and/or collapse all applications. Click any
application to expand or collapse all of its modules.

To quickly search throughout the application navigator to view a particular application or module,
use the Filter Navigator. The Filter Navigator is located at the top of the Application Navigator.

As soon as a user begins typing, the Application Navigator displays only applications and/or modules
matching the keyword. For example, if the keyword “Incident” is typed into the Filter Navigator, the
Incident application and a list of all its modules will display, as well as any modules containing the
word “Incident” within other applications, such as Service Desk > Incidents.

User Interface & Navigation
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Application Navigator: Favorites and Your History

servicenuw

Favorites

Items added as
favorites appear in the
Favorites tab of the
Application Navigator,
which is represented
by a star icon

Service Desk - My Work

Self-Service - Service Catalog

Self-Service - Knowledge
Self-Service - My Profile

Incident - Create New

Favorites display
asiconsina
collapsed view

Incident - Assigned to me

incident - Open

Incident - Resobved

Your History

Your History
provides a scrolling
view of recent
activities including:
* Forms and lists
you accessed
* Homepages you
visited

Simply click on any
recent activity to
open the item in the
Content Frame

*

Incident
1 can\'t laanch my VPN clent since the list\n &

Incidents
Active = troe

Problems
State = Open

Timeline Pages

I3 AGO
Notification
New Record

Notifications
Active = true

Notification Device
New Record

Favorites: Access the favorites menu to see all your favorites in one place. Favorites include
application menus and modules which you may wish to access quickly and often. Favorites will also
display in the Application Navigator even when a filter is applied, so long as the Favorite matches

the search term.

Your History: The Application Navigator contains a scrolling list of your recent history within
ServiceNow. For example, Your History will display forms you were filling out or lists you were
searching on. Simply click on an item to open any recent activity in your content frame. Some
content types are not tracked, including Ul pages and other non-standard interfaces.
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Content Frame: Common Types of Interfaces servicenuw
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Homepage: A homepage consists of navigational elements, functional controls, and platform
information. When a user logs in to an instance, the default homepage defined for their role
appears unless the user switched to another homepage or has set a dashboard to appear.

All users with a role can use the Add content link on the homepage to customize the homepage and
display important changes and emergency information to other users.

List: View data records as a list. Lists display records from a data table, as well as allow users to edit
the record information using the List Editor functionality.

Form: View individual data records as a form. Data is typically entered into ServiceNow through
forms.

Dashboard: Dashboards enable the display of multiple performance analytics, reporting, and other
widgets on a single screen.

Map: Display ServiceNow data graphically on a Google map. Drill-down into a map to view specific
data points.

Timeline: Used to track tasks or projects.

User Interface & Navigation
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Banner Frame Servicenuw

- Click the logo to return Click to open Global Search toolbar
to the homepage +  Type keyword(s) and hit Enter
* Searches for a text string across existing
records
* Results grouped by application v
+ SerVICe Service Management @ System Administrator Q |® @
T F '\
User menu containing
profile information and Connect
a logout option Sidebar
Help Sidebar =

Settings

The Banner Frame runs across the top of every page and contains global navigation controls and
several key functionalities and features:

* Your logo in the top-left hand corner, which also navigates you back to your homepage when
you click on it

* Information about the logged-in user: click the down arrow to the right of the user name to
view the user profile or log out

* Click the magnifying glass to expand the Global Search toolbar and use this to search across
all data in ServiceNow, such as a keyword, record number, and more

* Toggle on and off the Connect Sidebar, which is used to communicate with other users in real-
time

* Get help, including Product Documentation and new features

* Personalize your settings

NOTE: With additional rights, a user may see Impersonate User and Elevate Roles as additional
options from the user menu. These are features useful for testing and visibility.

User Interface & Navigation
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Mobile Access servicenow

How can we help?

o ©

In addition to accessing a ServiceNow instance from a laptop or desktop computer, ServiceNow
supports the following technologies:

Smartphone: The smartphone interface supports many of the features found in the standard
desktop/laptop browser interface, including lists, forms, favorite/shortcut management, and
filtering. There are no special configurations needed for the iPhone or Android phones; the
smartphone interface uses familiar, industry-standard techniques for performing most actions.

Tablet: The ServiceNow instance automatically detects the tablet and redirects to the desktop
interface.

Apple Watch: Features include: notifications, favorites, record monitoring, chat messaging,
dashboard charts, and record interaction via canned responses and voice to text (Siri).

Depending on how ServiceNow is accessed, the user interface and features may vary.

User Interface & Navigation
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Product Documentation: Docs and Community servicenow

service
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If anything in this class seems interesting, we highly encourage you to explore the topic in more
detail through either of the following websites:

docs.servicenow.com is the official documentation resource for ServiceNow, with content produced
by ServiceNow. From features to functionality, and even release notes, this resource should have all
of the information needed to get the most out of the platform.

community.servicenow.com is similar to the Docs website, in that it provides useful information
about the ServiceNow platform. However, where Community really excels is by bringing together
actual ServiceNow users to collaborate, share, and produce ideas, content, and even answers to

guestions you may have!

This is a great resource to learn from users with real-life experience on the platform!

User Interface & Navigation
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Section Summary

* What is ServiceNow? Lab1.1

* What is the ServiceNow Instance?

ServiceNow Overview

* What are Users and Groups? E @‘
* Key Platform Ul Components
* Mobile Access Pages 21 - 27 10 - 15 minutes

* Product Documentation

Lab 1.1 — ServiceNow Overview:

* Log on to your training instance
* Use the Application Navigator and its filter to access different areas of ServiceNow

* Add Knowledge and Service Catalog modules to Favorites

User Interface & Navigation
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LAB
ServiceNow Overview 1 o 1

B e (4 10-15 minutes

Lab Goal

This lab will show you how to do the following:
* Log on to your training instance
* Use the Application Navigator and its filter to access different areas of ServiceNow
* Add Knowledge and Service Catalog modules to Favorites

This course builds on a scenario where you work for a division of a fictitious electronics
company called Cloud Dimensions.

Upon the reveal of their Infinity product; a portable holographic projector, you support a team
of department Subject Matter Experts (SMEs) with the implementation of ServiceNow.

ServiceNow will initially be used by Cloud Dimensions for tracking Infinity inventory, order
fulfillment, and customer support.

You will be required to impersonate various user personas — representing Cloud Dimension
employees — throughout this course’s labs.

To start, you will assume the system administrator identity to accomplish a series of tasks.

NOTE: Screen shots are often cropped so what you see in the participant guide may not
match exactly what you see in your instance.

A. Log on to Your Training Instance

1. Navigate to your assigned ServiceNow Lab Instance in the web browser of your
choice.

NOTE: Your instructor provides you with your own instance URL.

2. Log on using the System Administrator (admin) credentials provided by your
instructor.

User Interface & Navigation
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B. Use the Filter Navigator

1. Set the Application Navigator view to display all applications in an expanded view
(double-click the All applications navigator icon to expand/collapse all), then locate
the Incident application to view the 9 incident modules.

2. Incident > Open.

NOTE: The Application Menu > Module Name formatting indicates the navigation path
to use in the expanded Application Navigator. This shorthand will be used in the lab
instructions going forward. For this step, select the Incident Open module:

incident

Notice how the user interface changed in the Content Frame from the System
Administrator homepage to a list of open incident records.

3. Incident > Create New.

Notice how the user interface has changed in the Content Frame from a list of
incident records to an individual incident record/form.

4. From the Application Navigator, use the Filter navigator to filter the list of
application menus and modules by typing self-service into the Filter navigator:

Y self-service

NOTE: A single application menu, Self-Service, appears with many modules. Scroll down
to see all of the modules under the Self-Service application.

User Interface & Navigation
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5. Self-Service > Service Catalog.
Notice yet another user interface type displayed in the Content Frame.

6. From the Application Navigator, type the keyword service into the Filter navigator.

NOTE: Scroll to see all of the applications and modules that contain the text “service”
display.

C. Set Module Favorites

1. Open the User menu on the Banner Frame, then select Impersonate User:

Q System Administrator ~

Profile

Impersonate User I

Elevate Roles

Logout

2. Impersonate the Cloud Dimensions employee Joe Employee by typing their name
into the Search for user field.

NOTE: After selecting their name from the drop-down list, ServiceNow should reload and
you are now impersonating Joe Employee:

3. Filter the Application Navigator using the keyword self.

4. Self-Service > Knowledge.

5. Open the ServiceNow Fundamentals Class Knowledge Base:

ServiceNow Fundamentals Class

0 Questions and 2 Articles

6. Download the necessary lab files for class by selecting the Class Lab Files article.

User Interface & Navigation
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NOTE: Selecting the Class Lab Files article will download a zip file to your local machine
titled ServiceNow Fundamentals Class Files. At your convenience, upzip the file.

Next, hover over the Knowledge module, then add the Knowledge module as a
favorite by selecting the Add to Favorites icon (star) to the right of Knowledge:

service

I:':-seﬁ

Add To Favorites

NOTE: Upon selection, the module star will appear filled in.

Repeat this step for the Service Catalog module.

NOTE: In addition to application menus and modules, the Filter navigator will also
display favorites based on keywords:

) _{
Self-Service - Knowledge
(i) Self-Service - Service Catalog

Self-Service

User Interface & Navigation
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9. Clear the Filter navigator keyword by selecting the X to the right of the Filter
navigator.

10. Next, navigate to the Favorites tab of the Application Navigator to see the module
favorites you have created:

Self-Service - Knowledge

(i) Self-Service - Service Catalog

11. On the bottom-right of the Application Navigator, select the Edit Favorites icon
(pencil):

® /

NOTE: The Set up your favorites screen displays in the Content Frame. A favorite can be
customized to have any name, color, and icon.

12. Select the Self-Service - Knowledge favorite in the Application Navigator.
13. Select any color and icon for the Self-Service - Knowledge favorite.
14. Repeat steps 12 and 13 for the Self-Service > Service Catalog favorite.

15. Click the Done button:

(). Joe Employee ~

16. Minimize (collapse) the Application Navigator by selecting the Minimize Navigator
icon (circled arrow) at the bottom of the Navigator:

® ,

User Interface & Navigation
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17. From the minimized Application Navigator, notice that the two favorites appear in
the color and icon you have selected:

NOTE: Your color and icon choices may vary from what is shown here for demonstration
purposes.

18. Navigate to the homepage by selecting the Home favorite displayed on the
minimized Navigator:

19. Select Maximize Navigator at the bottom of the minimized Navigator:

20. Next, select All applications:

User Interface & Navigation
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LAB VERIFICATION

The Lab Verification displays screen shots of what you should have created during this lab.

Sometimes the Lab Verifications have already been shown in earlier steps — as is the case
below.

Self-Service Favorites

Self-Service - Knowledge

(i) Self-Service - Service Catalog

Congratulations on completing our first lab, ServiceNow Overview!

User Interface & Navigation
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Module 1 - 1.2 Lists

servicenow

Objectives

* What is a Role?

* What is a List?
— Anatomy
- Views
— Context Menus

* Layout Configuration
* List Personalization

* List Editing

* Tags

* Filters

* Finding Information: ServiceNow Search
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RO I ES ' @, ' A role may contain other roles:

A role is a group of permissions, allowing users personalize

to perform actions in parts of the platform, Role =
|permissions

including lists and forms v
contains

|, |personalize_rules

It can be assigned to a group or a single user;

Role
a user can be assigned more than one role T permissions >
contains
Roles are represented by a record stored in the ui_policy_admin
Role [sys_user_role] table | Role
ui_action_admin
Role

permissions )

A role is a collection of permissions used to:
* Grant access to applications and other parts of the platform

* Assign security rights

Once access has been granted to a role, all of the groups or users assigned to that role are granted
the same access.

Additionally, a role may contain other roles and any access that is granted to one role is
automatically granted to any role that contains it.

In this example, the personalize role is able to personalize forms, lists, rules, controls, and scripts. It
has its own permissions and also contains the personalize_rules role.

The personalize_rules role has its permissions and contains both the ui_policy_admin and
ui_action_admin roles.

The ui_policy_admin role can manage Ul Policies. The ui_action_admin role can manage Ul
Actions.

Taken with all of these relationships, the personalize role contains all of the roles below it in the
hierarchy. However the ui_policy_admin and ui_action_admin roles do not contain the permissions
of the roles above them in the illustration.

User Interface & Navigation
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Provided Platform Roles Servicenuw

System Administrator - -E- Fulfiller - -5 -
The admin role provides access to all platform features, Users with the fulfiller (itil) role may fulfil ITIL activities
applications, functions, and data associated with the ITIL workflow, including incident
and change management |

Specialized Administrator ——— &l Approver o
Users with specialized administrator roles may manage The approver_user role can perform all requester
specific functions or applications, including: actions and allow users to view or modify approval

«  Assignment Rules records directed to them

+  Knowledge Base Requester ] —

8 8

* Human Resources Also known as Employee Self Service (ESS) users, these

* Reports users do not have roles but can submit and manage

+  Web Services their own requests, access public pages, etc.

The System Administrator (admin) role has almost all roles and access to all platform features,
functions, and data, with some exceptions such as HR and Security Operations constraints. Grant
this privilege carefully.

Users holding the admin role can create and modify user roles, as well as impersonate other users.
However, not even users with the admin role can impersonate a security_admin role user and
elevate privileges while impersonating to access higher security functionality.

The impersonator role can be assigned to a user to allow impersonation of other users, excluding
admins, for testing and visibility purposes.

Specialized Administrator roles have broad access but generally manage specific functions or
applications.

Fulfiller/Process users have clearly defined paths and workflows in the platform and have one or

more roles, including the itil and approver_user roles. They can access all functionality based on
assigned roles.

Approvers have the approver_user role, but no other roles.

Requesters use the Service Catalog and Self Service applications. They can make requests only on
their own behalf, and are not assigned roles.
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What is a List? servicenow

A list displays a set of records from a table within the content frame of ServiceNow

service S Bl S o
" User Administration B Usn u Gote Name ¥ 44 4 1 w20d5TT P PP
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i Each row represe nts abraham IncolnEewsmple (om rue 201307-23 171554 2017-12-02 024516
[ one record e CENVBMLNDRRIMOE (DM true 2012-02-1T 150450 2017-12-02 04508
e
alleen.motzern Adewn Mottem aleen motterniesample com true 2012-02-17 150445 2007-12-00 04513
aleandra prenat Alsjandra Prenatt aajandra. prenatt Eenample Com true 012-02-17 190452 2017-12-03 0409
aleandro mascal Abpandre Mascal ddpandnd Pl Gesample com rue 2012-02-17 1704 52 2017-12-02 04516
et rabeck Alre Babwch Barw 2beChPesample (o true Each COIumn
.
atonsag e Attomso Grglen 29710 grgenaerample com trve represents one field
UGS R s Tl Loy Absia Mour £y Enad Mo oy eameie Com rue J013-03-17 1v0a 52 2007-12-02 024513

Lists and forms are the most common ways to interact with data. A list displays a set of records from
a table. Lists can be filtered and customized to display the information you need.

NOTE: Two different versions of list functionality may be encountered; referred to as List v2 and List
v3. List v3 is enabled by a ServiceNow plugin and offers additional functionality such as displaying
information in a split format.

In this example, the system administrator is accessing the User Administration application and a list
of users through the Users module. Other roles, such as user_admin, grant users the permissions to
manage users, groups, and roles.
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© 2018 ServiceNow, Inc. All Rights Reserved 31




List: Anatomy

servicenow

1.

Title Bar

Displays the list title and, in some
cases, the view name, as well as
search list values, and a record count

List Filters/Breadcrumbs
Offers a quick form of filter navigation

Column Headings

Displays column (table field) names
and provides some list controls

Column Header Search
Provides a search within a specific

column

Field Values

Data; right-click a field value to access
additional actions

Goto Mumber V' o« i wmof2d » »»
i A i Number & ( 3 Icponﬂll = Short descngtice &= Caller = Pronty = State = Category
- 2016-12-11 Unabile to get to
( f i
0 INCOOO0002 2er13 e red Lucidy ® 1-Critical  On Hold Network
ps 2016-12-18 Wireless access is down .
@ mcmeom  CE S mj-n-cnbw inProgress  Network
20150812 Need access to sales D8
INCOR0000? s forihe JotEmpioyee @ 1-Critical  On Hold Database
2016-12-03 | can't lawnch my VPN
(1) INCOO00LS 15:38:46 Chent since the st Frediuddy @ 1-Critical InProgress  SoRtware
software updae
2018-11-28 Rasn is leaking on man
Pr
INCOO00016 15:40:23 DNS $ BowRuggerd @ 1.Critical nProgress  Mandware
4 201508-12 How do | create a sub-
. al [
[L‘ INCORQQQLT 1eok1:00 A JotEmpicyee @ 1-Critic On Hold nguiry [ Help
INCO000018 R m«nm Tt ® 1-Crivcal I Progress
15:42:46 P yreeland ' o

Although lists display data captured in different tables, their interface remains consistent with

common features.
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List: Views Servicenuw

Views 0 —

A view is a version of a customized list or
form which defines the layout order and
what fields appear

For list views, the same number of records
for that particular table display — different
fields may be visible and display in a
different order

Default view Mobile view

Views: Views enable users to quickly display the same list or form in multiple ways. System
administrators can create views for lists or forms. For example, different views can be created and
used on Incident for an ESS user, an ITIL user, and a mobile user.

To switch between the different views of columns on a list (as shown here), open the List Context
Menu then select View. Then, select the name of the desired view.

The view name appears in brackets beside the table list title and form record type when a view
other than the Default view is selected.

NOTE: Switching views on a form will attempt to save all changes made to the record. A message
displays asking to save or discard all changes made to the record, before the form reloads and
displays the selected view.

Sort Controls: A list that is displayed to a user for the first time will be sorted by one of the
following:

* The order field, if one is present in the table

* The number field, if one is present in the table

* The name field, if one is present in the table

* The field specified as the display field for the table
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List: Context Menus

servicenow

Context menus provide different
levels of controls for a given list view

Context menus can be accessed by
clicking the list menu icon (=) or by
right-clicking the list header and
column headers respectively

List Context Menu

I_ incidents m Goto Number
EI_.,
_: Filters > Major incidents
~  Geoup 8y > | mobite |
Show > Portal b
Refresh List | Self Service
Create Favorite I b
—

Column Context Menu

umber A = Opened
. to

Sort(ztoa)

Show Visual Task Board

Group By Number

Bar Chant
Pie Chart

Configure >
import
Export >

Update Selected
Update All

Create Application Files

import XML
Show XML

Record Context Menu

== Short description = Caller é

Need access to sales DBI
Joe Emplovee o
for the West

I can't launch Filter Out
client since th

softwareupd: Copy URL to Clipboard

Rain is leaking Copy sys_id

DNS Server o — 3

Howdolcrea  Assign to me
foider Aschive Record

Sales forecast  Follow on Live Feed
spreadsheet i
ONLY

Show Live Feed

Add to Visual Task Board J‘
| Can't laynch 64t

Access the Record Context Menu
by right-clicking in a row’s cell

List Context (or control) menus, also sometimes called Additional Actions, can be accessed from
lists, columns, or on records by using right-click menus which provide different levels of controls:
* List Context Menu: Click the list context menu icon next to the title of the list (Incidents in
this example) to access options related to viewing and filtering the entire incidents list.
* Column Context Menu: Click the column context menu icon in the desired column header to
display actions related to that column, such as creating quick reports, configuring the list, and

exporting data.

* Record Context Menu: Right-click in a row’s cell to see a menu with actions related to the
values in that cell, such as filtering options, assigning tags, and more.
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List: Layout Configuration servicenuw

Configure a list to show or hide < Conguring incidents Ust Cancel ﬂl
fields from a view, as well as change I —
. tive W e
the list column order ctivity due Opened
Aotusl end 3hort desrigt on
Actual et Coller
Click the column context menu icon s g ey
and select Configure > List Layout soprorn Caterory
Boxcecrepd hatery Avgament proun Y
e ] » Assgoed ta
=RBumber a = Opened = short description :: ::T:: ‘..hp . 7 :::;:: - v
Sort{atoz) J ::a :u i!--..: o: %
Sort(ztoa) Buaimess service |+
Unable to get to Caller [»
HC Show Visual Task Board netwark file shares f.a:(‘dh."-ar-gv s S|USthCket
Dhange Request |+
Wireless access is doy Orld incdents
BE Group By Number in my area cancet [
h 2
INC R :"i":::m“‘“ List view Create new field
Pie Charn f the
c Vim At Defauit vaew H N
- Impaort List Calculations | Fraid lengeh Small 4T
Export > List Control -

Users with the admin or personalize_list role can add or remove columns (fields) from a list or
change the order in which the columns appear in the list, for all users.

To do so, navigate to the list, then open the column context menu, then select Configure, finally,
select List Layout.

The slushbucket opens and has two sections: the available items on the left, and the selected items
on the right. Items from the available section can be added to the list and items from the selected
section can be removed from the list.

Once items are in the selected section, there are controls to adjust their order (up or down) on the
list.
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List: Personalization servicenow
= Incidents m Goto Number v Personalize List Columns A

7 All>Active = true Available Selected

O, =Number o =Opened = Shortdescription = wrere

Personalize a list to show or hide fields on a view, as
well as change the list column order

Unlike configuring a list, personalizing will not affect
what other users see while viewing the list

To personalize a list view, click the Personalize List
icon or gear (17) from the list column header

After personalizing a list, this icon will change to look
like this (124)

Actual end

Actual start
Additional ssslgree Lt
Additional corereents
Approsa

Approssl history
Approval set
Byusiness duration
Busness resclve Lime
Businesy service
Caused by Change
Change Reguest
Child Incidenty

Closer (ode

Close notes.

Closed

" Wrap column text Compact rows

v Enabie list edit

v Double dlick to edit

Short descripton
Catier

Prigrity

State

Category

Ass gnment proup
Aaggned i
Updated

Updated by

Active row haghlghting

« Modern cell coloring

Personalize List Columns modifies a list for an individual user; it does not affect the platform
default. List layout changes made using List Layout will affect everyone, across the the entire
instance, except for individuals using personalized layouts set via Personalize List.

The following can be done through Personalize List Columns:

* Add Columns: In the available section, select each column you want to add and press the add

icon

* Remove Columns: In the selected section, select each column you want to remove and press

the remove icon

* Rearrange Columns: In the selected section, select the column(s) you want to reorder and

use the up or down icons to place the columns in the desired order

* Reset Column Defaults: Return the list’s columns to the default list’s view definition
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List: List Editing servicenuow

The List Editor allows a field value to be edited It - B
in a list without opening the form '

B Nember & = Caller

Locate a record with the field value to change: A .
1. Double-click in an empty area of the field D mcwmes PR

2. Enter the appropriate value(s) D) INCOMOO LukeWssen
3. Save the record by clicking the save (~")) icon

~ Clicking the cancel (X)) icon or pressing the
Escape key retains the original value Issue with email

Having problems with
Sales Tools performance = VPN

= Number A = Caller = Short description = Category

INCOO0004 T Joe Employee lssue with email Network

Users can edit data in lists using various methods but certain field types cannot be edited.
Additionally, list editing is disabled for some tables.

The list editor is the quickest method to update a field on multiple records.

Procedure
1. Select the records to be edited.

2. Open the list editor by double-clicking (or clicking, depending on setup) in an empty area of the
field. The number of selected rows that will be edited is indicated. If any rows cannot be edited
due to security constraints, that is indicated. Administrators can configure the list editor and by
default, list editing is disabled for some tables.

3. Enter the appropriate values and click the save icon.

Quick edit functions may also be used to edit records. Right-click a field and select the appropriate
function:

* Assign to me: For records that use assignments, places the logged-in user's name into the
Assigned to field

» Approve: For records that use approvals, changes the approval state of the record
to Approved

* Reject: For records that use approvals, changes the approval state of the record to Rejected

* Assign tag: For records that are to be tracked based on a user-defined label
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Tags

servicenuw

Use tags to categorize, flag, and locate records

Tags can be created against any record from a G

list or form view

Tags can be made visible to any user (global) or |

visible only to specific users

W)

n
F 4
-
>
n

2016-12-11
15:07:12
Show Matching
INCOOOOX  er Out

INCO0COO02

Copy URL to Clipboard
Copy sys_id

INCOQQO

A T‘
T Assigntome

Tag Details

Name

Network

Viewable by

Me| Groups and Users Everyone

Archive Record

Cancel m PO Follow on Live Feed

Show Live Feed

Q) Add to Visual Task Board E

= Shoet description E

Unable 1o get 1o
network file shares

Jaccess 10 sales DB

b Wiest

B
>

New Tag.

Androsd

JavaScript
Development l

= Tags

There are a few ways to assign tags to records:

* From the list view using inline field editing

* From a list using the record context menu

* Configuring tags to assign automatically

Use the Viewable by field when editing a tag to control how it is shared: visible only to the owner
(Me), visible to the owner and specific groups or users (Groups and Users), or visible to everyone

(Everyone).

To use the Everyone option under Viewable by, a user must have the admin or tags_admin role.

NOTE: Editing personal tags can be accomplished using the My Tags or My Tagged Documents

modules.
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What are Filters and Breadcrumbs? Servicenuw

. P (lick the funnel to view Breadcrumbs summarize the s
Filters and edit filter conditions current filter conditions
A filter is a set of conditions
applied to a table to isolate a
subset of the data to work = incdents [ Goto wumoer v
with on a table _’ 7] > rctive e cotegory = sot m—— {

Run Sawve. AND OR AddSort

Bl"ead(‘.l'umbs All of these conditions must be met
Active - i s true $ AND OR X
Breadcrumbs offer a quick
form of filter navigation and e -2 ) S - S
are ordered from left to right ey - C L e g ot L]

Run

Filters are used to specify exactly which records to displaywithin a selected list. For example, you
may start with a list of all incidents but filter those records to view only active incidents assigned to
you. Users can apply, create, modify, and save filters.

To view the filter applied to a list, click the funnel icon on the top left of the list. Here, you can add,
remove, or edit filter conditions and rerun or save your filter.

Click Run to see the results of your filter, displayed in the list. To save a filter, click Save. A new field
will appear where you can name your filter. After naming the filter, click the Save button to the right
of the name field. The new filter will be available by selecting Filters from the list context menu.

The filter conditions applied to the list are summarized in the breadcrumbs, shown in blue letters
across the top of the list. Not only do the breadcrumbs provide an “at-a-glance” view of the filter’s
conditions, but you can also modify conditions and add to favorites your filter directly from the
breadcrumbs.

Click a breadcrumb to remove all conditions to its right. Clicking the condition separator (>) before a
condition to remove only that condition.

Add filter conditions to your favorites menu simply by dragging and dropping the breadcrumbs onto
the navigator

User Interface & Navigation
© 2018 ServiceNow, Inc. All Rights Reserved 39




Filter Conditions and Filter Operators servicenow

Three components of a filter condition: A filter operator represents the
1. Field 2. Operator 3. Value action to take;.lt is a choice list
based on the field type

Run  Save AND OR AddSont %

All of these conditions must be met it 3 !im—

s . - - : e | L E Prigrty - u— ::;wu:ruv

@ @ = @ L SEhumbey EOp :;‘:“ibf‘f ’l: :c::v::\;mﬂ

NCON00043 ”;l E:‘:‘E:":E‘:q Iu! ::_::;W
S -l o
NEOXO004) s ::ﬂ:ﬂ

The three parts of a filter condition are:

1. Field: A choice list based on the table and user access rights. The choice list includes fields
on related tables by dot-walking.

2. Operator: A choice list based on the field type. For example, in the incident table, the
greater than operator does not apply to the Active field but it does apply to the Priority field.

3. Value: A text entry field or a choice list, depending on the field type. For example, in the
incident table, the Active field offers a choice list with the values true, false, and empty,
while the Short description field offers a text entry field.

A filter operator can specify conditions including: it is this, it is not this, it is same as, it is different
from, etc.

Filter operators will change depending on field data type, for example:
« Text value: is, is not, contains, is one of, starts with, ends with
* Numeric: is, is not, greater than, less than, greater than or is, less than or is

* Date: on, before, after, between, is more than, is less than
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Finding Information: ServiceNow Search

servicenuw

Use any of the following search methods
to find information in ServiceNow:

— Lists: Find records in a list; search in a specific
field (Go to), all fields (Search), or in a specific
column

— Global text search: Find records in multiple
tables from a single search field

— Knowledge Base: Find knowledge articles
— Service Catalog: Find catalog items

— Filter Navigator: Filter the items in the
application navigator

List and Global Wildcard Searches

Wildcard Search Syntax Does a Search

*mySearchTerm Contains
1*mySearchTerm Does not contain
mySearchTerm% Starts with
%mySearchTerm Ends with
=mySearchTerm Equals
l=mySearchTerm Does not equal

No leading or trailing

mySearchTerm Greater than or equal to
mySearchTerm when using the

Wildcard(s) list “Go to” search only

Find information quickly in ServiceNow by using any of the available searches:

* Wildcards: Use a symbol to represent zero or more characters

* Phrase Searches: Find a phrase with multiple terms

* Searching Lists: Control the query for list searches of a specific field

* Boolean Operators: Refine searches with operators such as AND and OR

* Attachment Searches: Search in files that are attached to Knowledge Article records

* International Character Sets: Perform searches with any Unicode characters

* Punctuation: Perform searches that contain punctuation

Wildcards use a symbol to represent zero or more characters and are available for searches. Various
wildcards can be used to refine the search in lists (text searches of all fields), the global text search,
and the Knowledge Base. Results with using wildcards may vary depending on the search method

used.

Searches are not case sensitive. Use advanced options for more specific queries.

NOTE: Zing is the text indexing and search engine that performs all text searches in ServiceNow.
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Section Summary

* What s a Role? List:-g: le':ters

* What is a List?

* Layout Configuration @‘

* List Personalization

* List Editing Page 43— 52 15 - 20 minutes
* Tags

* Filters

* Finding Information

Lab 1.2 - Lists and Filters:

* Open an Update Set
* Create a new Infinity list view on the Incident table
* Practice filtering data on an incident list and saving a new filter

* Locate and update incident records using inline editing
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LAB
Lists and Filters 1 .2

B e () 15-20 minutes

Lab Goal

This lab will show you how to do the following:
* Open an Update Set
* Create a new Infinity list view on the Incident table
* Practice filtering data on an incident list and saving a new filter
* Locate and update incident records using inline editing

One goal of Cloud Dimensions with using ServiceNow is handling Infinity support.

Before the product is launched, however, Cloud Dimensions employees are actively testing
Infinity devices.

Winnie Reich — manager of the Service Desk — has requested help from the Cloud Dimensions
system administrator in creating a new Infinity view on the incident table.

This view will be configured to include the necessary fields for supporting Infinity, for both
internal and external users alike.

Winnie has also asked her direct report, Kevin Edd, to create and share a list filter that will filter
active incidents and display only those submitted by Infinity employee testers.

A. Open an Update Set

Before starting the lab, create an Update Set. Update Sets are used to capture configuration
changes made to the platform and are explored later in class. Create an Update Set now and
follow up with it at a relevant time.

1. Impersonate the System Administrator using the user menu.

NOTE: If you have logged out of your instance, use the System Administrator (admin)
credentials provided by your instructor

2. System Update Sets > Local Update Sets.
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3. From the list of local Update Sets, click the New button.

4. Fill out the form as follows:

Name: ServiceNow Fundamentals
State: In progress (auto-fills)
Description: Includes work completed in the ServiceNow Fundamentals course.

5. Click Submit and Make Current.

NOTE: A message appears at the top of your instance indicating the Update Set has been
set to the current Update Set. This means changes made to the platform will be captured
in this Update Set moving forward.

B. Create the Infinity List View

The system administrator user has the appropriate permissions for creating a new list view on
incident —we will assume they have already received the requirements from Winnie Reich.

1. Incident > Open.

2. From the list column header, open the “slushbucket” to create a new list view:
a) Open the Column Context Menu
b) Select Configure

c) Select List Layout

= Intidentsm Goto Number v

tl.f All > Active = true

o) co E«.mm ¥  =0nened = Short descriptio

Sort(atoz) £
Sort(ztoa)
1 3
~ N Show Visual Task Board Issue connecting m
L Infinity to WIFI [cdi]
) " Group By Number Hologram settings g
b won't load
Bar Chart ’
— le to access ted
" Pie Chart [ b
W - B share
Configure > List Layout
@' N import List Calculations
Export > List Control

NOTE: Selecting any field will work, but Number was used in this example.
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3. Beneath the Available and Selected buckets, open the View name drop-down menu
from the List view section.

4. Select New... at the bottom of the list:

List view

View name BRPLEC LRI ’

Major incidents r
Mobile

Portal

Self Service

New...

NOTE: Choosing an existing view from this list will allow you to modify it.

5. Enter the View name: Infinity.

6. Click OK.

Nothing appears to have happened to the page but you should now notice Infinity
as the selected List view:

List view

View name Infinity

7. Working with the Available and Selected buckets, use the Add and Remove buttons
(“>” and “<” icons, respectfully) to create the Infinity list view with the following
fields:

Number

Priority

State

Caller

Category
Subcategory
Short description
Assignment group
Assigned to

Tags

Updated
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NOTE: Ensure the fields are listed in this same order under Selected. Use the Move up
and Move down arrows, on the right of Selected, to set the correct order.

TIP: You may select multiple fields under Available or Selected, then add or remove them
with one click.

8. Once the fields have been added to the Selected bucket, click Save.
9. Impersonate Kevin Edd to confirm the view is available for the Service Desk group.
10. As Kevin Edd, navigate to Incident > Open.

11. Open the List Context Menu and select View, then finally select Infinity:

v Default view

{5 GroupBy > | Majorincidents |
Show > | Mobile '
Refresh List | Portal
Create Favorite Self Service

——— . . - A

NOTE: The list view name now appears at the top of the list in square brackets:

= Incidents [Infinity view] m

12. Confirm the fields appear in order, from left to right, as listed in step 7 above.

C. Apply and Save a Filter

Filters allow users to locate specific data quickly, and filters are also reusable. Kevin Edd will
apply a filter that displays Cloud Dimensions Infinity incidents related to employee testing, then
save the filter to share with his team for future use.

1. Open the filter condition builder by selecting the Show / hide filter icon (funnel):

= Incidents [Infinity view] m
I ? I All > Active = true
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Add the following AND condition:

Tags | EIT

NOTE: This will search for all active incident records with EIT as one of its tags. The EIT
tag is something Cloud Dimensions employees have created to help distinguish internal
testing incidents from customer incidents — it stands for Employee Infinity Testing.

The filter should look like this:

\,;} All > Active = true > Tags has EIT
Run Save... AND OR Add Sort b4
All of these conditions must be met

Active v is v true H AND OR X

Tags v EIT Q, AND OR b4

Click Run to apply the filter.

There should be two incident records returned.
Open the filter condition builder again to save the filter for later use.

Click Save...

Run AND OR  AddSort %2

All of these conditions must be met

Enter Infinity Testing into the Save as field.

Next, select Group for Visible to.

NOTE: The ability to select a group to share wi dth others is provided by additional user

permissions. For this exercise, the Service Desk group was granted the filter_group role.

Input Service Desk into the group reference field to share this filter with its
members.
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9. Click Save:

Run  Save.. AND OR AddSort 42

Saveas: |Infinity Testing Visible to: Me @ Group ServiceDesk Q, m

10. Impersonate Megan Burke, another member of the Service Desk group, to confirm
the filter is now available for the Service Desk group.

11. Incident > Open.

12. Open the List Context Menu and select Filters, then finally select Infinity Testing:

Show > Active - Unassigned I
Refresh List Assigned to me
Create Favorite Infinity Testing

E INCoo0! Closed

My Open Incidents

@ NCOoO Edit personal filters

13. The filtered incident list, containing two records, appears:

= Incidents m Goto Number v

? All>Active = true>Tags has EIT
<3 Q, = Number ¥ = Opened = Short description = Caller
2017-08-10 Megan
@ INC0000042 P password reset request
00 2017-08-10 Infinity showing an error
® 09:24:23 - employee testing Ted Keppel

D. Locate a Missing Incident

Winnie Reich has emailed Kevin Edd to report an incident submitted by another employee that
did not follow the current EIT tagging convention.
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INC0000061 was submitted by Alissa Mountjoy and will need to be updated to include the EIT
tag as the incident reports an error found with the Infinity holographic settings page.

1.

Impersonate Kevin Edd.

Using methods of your choice, locate and open Alissa’s incident record; INCO000061.

HINT: Access the active record by navigating to an appropriate module and using list
column header searches, filter conditions, or a global search for INCO000061.

With the record form displayed, open More options from the form header:

4 -Jt E Follow v  Update

Click Add Tag.

Type EIT into the Add tag... field.

Press Enter on your keyboard to add the tag to the incident record:

Tags o
’/'“ Add Tag
& EIT %
Update.

Apply the Infinity Testing filter to the incident list to confirm all three Infinity testing
records display:

= Number ¥ = Priority = State = Caller = Category = Subcategory = Short description
. Al Infir.lity holographic
INC0000061 5 - Planning New Mounti Network settings page will not
Mountioy display
z Megan
INC0000042 5 - Planning New Database password reset request
Burke
INC0000023 5 - Planni N Ted K T Infinity showing an error
C00 - Plannin, ew ed Keppe nquiry / He .
e 2 e . S s P - employee testing

E. Update Infinity Incident Records

Now that all Infinity incident records are accounted for, Winnie Reich has asked Kevin Edd to
ensure all records’ categories are accurate based on the issue reported and described.
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Use the inline editor to update a record’s category value right from the list.

1. Find INC0000042 and double-click on the category, Database:

M
INC0000042 5- Planning New ;:f:f password reset request

2. Use the Category drop-down to select Inquiry / Help.

3. Click the Save icon (green checkmark) to update the record:

Category: ®
Inquiry / Help H :
Subcategory:
-None -- v
INC0000042 5- Planning New mﬂ Inquiry / Help password reset request

4. Select multiple records to update field values with one set of steps:
a) Press Shift and click the Network category for INCO000061

b) Hold Shift + Ctrl (Shift + Command on Mac) and click the Inquiry / Help category for
INCO000023

= Number v = Priority = State = Caller = Category

553
Moun

INC0000061 5 - Planning New

IN 2 5 - Planning New Inquiry / Help

INC 23 5 - Planning New Ted K Inquiry / Help

5. Double-click on the Inquiry / Help category value for INCO000023 to open the
Category drop-down.
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6. Notice it indicates two records will be updated:

Category: @ ®
Inquiry / Help v
Subcategory:
-- None - v
|2 rows will be updatedl

7. Use the Category drop-down to select Software.
8. Save to update both records.

9. Your Infinity incident list should look like the following:

= Number ¥ = Priority = State = Caller = Category
Al

INC0000061 5 - Planning New : ’ Software
Mountjoy
Megan

IN 2 5 - Plannin New Inquiry / Help

. Burke ¥
INC0000023 5-Planning  New Ted Keppel  Software

LAB VERIFICATION

Infinity Incident List View

List view

a»

Viewname Infinity
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Infinity Incident List Fields

Selected

Number

Priority

State

Caller

Category
Subcategory
Short description
Assignment group
Assigned to

Tags

Updated

Infinity Testing List Filter

Y All > Active = true > Tags has EIT

Run Save... AND ' OR | AddSort ‘%

All of these conditions must be met

Active v s $ | true H AND OR X
Tags v | ET Q | AND OR X
Updated Infinity Incident Records
= Number v = Priority = State = Caller = Category
INC0000061 5-Planning  New Alissa Software
Mountjoy
M
INC0000042 5-Planning  New negan Inquiry / Help
Burke
INC0000023 5- Planning New Ted Keppel  Software

Excellent! By completing this lab successfully, you have set things up perfectly for the next.
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Module 1 -1.3 Forms

servicenow

Objectives

* What is a Form?
— Header Icons
— Field Types

* Formatters and Related Lists
* Configuration

* Personalization

* Templates

* Saving Forms
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What is a Form? servicenow

A form displays fields from one record; users can view and edit the record data

¢ = WmNC00000S3 & W == ceo Follow ~ Update Resolve Delete P

Manage Attachments (2): & sap_hejpg [rename] [view] (& sap_hr.jpg [rename] (view]

Number  INCODOOOSS Contacttype Phone s
Caller  Margaret Grey Q of @ State  In Progress H
Category inquiry / Help $ Impact 1 - Migh H
Subcategory None : Urgency  1-Migh :
Business service Q Priority 1 Critical
Configuration item  SAP Human Resources Q & 0 @ Assignmentgroup  Software Q D)
Assigned o Beth Anglin Q ©
Shont The SAP HR application is not accessible
description

Related Search Results )

Notes Related Records Closure information

Watchlist & 2 Worknoteslist G 2

A form displays information from one record in a table. The specific information depends on the
type of record displayed. Users can view and edit records in forms. Administrators can configure
what appears on forms.

In addition to fields, the form can also contain sections and Related Lists. Related Lists show records
in tables that have a relationship to the current record. For example, the User form features Roles

and Groups Related Lists. Related Lists do not appear on a form until a record has been saved to the
database.

A form can load directly by searching on a record number in the Global Text Search or by clicking a
record in a list.
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Form: Header Icons servicenow

p==== | Form Context Menu e Activity Stream
Additional actions specific Activity Stream is a real
to the form, including Save time, sequential display
of activities
Paperclip Personalize Form
Attach files to Show or hide non-
- the form ol mandatory fields
< = INC0000002 @ V = oo Follow -~ Update Resolve Delete J
Number INC0010002
Asterisks Caller  System Administrator Q MOl‘e Optior'ls
Mandatory fields wachlie @ /@ Form tools including

prior to Save

Templates and Tags

¥ Short
description

Each form has different fields, Ul actions, and options specific to the application under which it was
created.

However, all forms have certain icons and functionalities in common:

L]

The Form Context Menu provides additional options specific to the form. Save can be found
in the Form Context Menu and be used to save a form while remaining on the page.

Use the paperclip icon to attach, remove, or rename files on a form.
Show Activity Stream will display a time stamped history of all actions taken within a record.

Personalize a form to show or hide important fields. NOTE: Mandatory fields can not be
hidden.

All fields marked with an asterisk are mandatory and must be filled out prior to saving the
form. NOTE: The asterisk is red prior to filling out the field and grey once information has
been entered

Click More options to tag a form, use templates, send an email, and more.
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-
Form: Field Types servicenow
{ = PRBO000011 & Y = ceoo  Follow « Updste Delete 4
1. String @ Nembder  PRB00OOLI Cpened 20170318 215815 Fl @ 4. Date /
Confgurationitem  SAP Enterprise Services Q A @ © Openedby  ITIL User Q @ 2
: - - Time
2. Choice priory | 1. Gl ' sun | Open :
Change request Q Assignment group Q
3. Truel @‘.‘!&-ﬂ eriee Assigredte  DavidLoo Q, (D @ 5. Reference
nowlecge Worknotes it 54 B —
False S
Short description  Unknown sowsce of SAP outage LR | Uw-lm.
® “tips SeviD T4 service-now.com h ty
Descrpuon  Seweral Rours Igo we experenced 2 flood
an sutage of unkeown orign. Weareperig = Usen m Goto Mawe a4 1 ool » »»

\ B Name & = Finst name B Last name i Emadl
® Bernard Laboy Berrard Labary bernard Laboy@exampie com
® BethAngin Beth Anglin DethanglnBeramole com
® Bow Augge Bow Ruggen Bow. ruggen@easmple. com
® BudBichean Bud fichman Bud. nchmand@exampie com

Reference fields display records from another table; in this example, the
Assigned to field references records on the User [sys_user] table

Forms include various field types, each with unique attributes.

Some common field types include:
1.

String: Freely populated using letters, numbers, and special characters. For 254 characters or

less, the string field will be a single-line text field. Anything 255 characters or over will

appear as a multi-line text box.

. Choice: Drop down list of choices

ui & W N

User

that can be configured.

True/False: Boolean field that appears as a check box.

. Reference: Query that displays records from another table.

Interface & Navigation
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Date/Time: Day and time of day, which can be selected with a calendar widget.
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Form: Formatters and Related Lists servicenow
Formatter Related List
- ¢ = PRBO0OOOOLL
woduround [Pus Incidents (S) Problem Tasks
Activaty =  Incidents m E Goto Number
6 .

::‘- -‘. ‘II' . er FRBUUUUUL L
Severs Foun A eraread 3 food 41 cplatest to v = Number a = Opened = Short description
SAF WD i B e wd TN 1ol
L O perio "L it . Uahdgt" Can't aocess
.r .“. INCO00003} 22:1;412226 SAP Controlling
gple apphcation

. = o = SAP Financial

A formatter is a form element used to display information ncoooosy  2N10226 Accounting spplication
r 12:48:40 appears to be

that is not a field in the record

The activity formatter provides an easy way to track items
not saved with a field in the record, for example, journal
fields like comments and work notes

down

Related lists appear on forms and show
records in tables that have relationships to
the current record

Examples of formatters in the base platform include:

» Activity formatter: Displays the list of activities, or history, on a task form

* Process flow formatter: Displays the different stages in a linear process flow across the top of

a record

* Parent breadcrumbs formatter: Provides breadcrumbs to show the parent or parents of the

current task

» Approval summarizer formatter: Displays dynamic summary information about the request

being approved

* Cl relations formatter: Displays on the Cl form a toolbar for viewing the relationships

between the current Cl and related Cls

Like any other list, users can view and modify information in related lists, as well as add a new
record to the database. A default filter that is applied to a related list when a form loads can be

created.

Administrators can configure related lists to appear on forms and in hierarchical lists. Related lists do

not have a size limit.

If there are many related lists on a form or many records in the related lists, the form may load

slowly.
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Form: Configuration and Personalization servicenuw

? 2 = E e alow - ) "
Configuration < [Epeoomoe ¢ MEI- el | Lo
. umber  INCOSOD0LE ~ :
Configure a form to show or hide = Personalize Form
' . Caller Bow Rupger L 0
fields from a view, as well as change _ = =
their position on screen pop ] D v Form Frelds
SubCAtRgOy NOne 3 i >
Click the form context menu icon e - Aasignmant growp v
and select Configure > Form Layout - = v
Caller o
Personalization A Congary -

Caused ty Change v

Click the Personalize Form icon (=)
to personalize which fields display

Relat  Close code e

Close rotes o

5 . : Notes Related Records Closure inflormation
Personal form customizations will Closed e

only affect what you see on a form - ok @)s Closed by -
these changes do not affect others

Wy A Configuration tem v -

Additional comements [Customer visiblel

¥ vesdie Post
Contact type o

With the personalize_form role, users can configure a form to show or hide fields from a view.
Nfields can even be created on the table that is associated with the form, although this is not best
practice.

Using the slushbucket, select the fields and the order in which you want them to appear. Available
items that appear in green followed by a plus (+) sign represent reference fields. Accessing these
fields on related tables is referred to as dot-walking.

Warning: It is not recommended to add the same field to more than one section of a form unless
the field displays read-only data. Having two or more instances of an editable field can cause data
loss and prevent the proper functioning of Ul and data policies.

When the form personalization feature is activated, users can personalize fields to appear on a
specific form view according to individual preferences.

In contrast to configuring a form, personalizing a form does not enable users to perform the
following actions:

* Change the order of fields on the form
* Add fields that are not configured to appear on the form

* Hide mandatory fields
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Form: Templates servicenow

Templates allow fields to be populated £dit Template
automatically, simplifying the process of W o = W —
submitting new records Ntte | tockient et

Click the More options icon (°°¢) from
the form header, then click Toggle
Template Bar to work with templates

g §
{ 2. .
§ §f 8

&S N = ﬂ Follow =

62 Email

)
¥
X X X X X X

99 Toggle Template Bar

Use the template bar at the bottom of
the form to manually apply, create, or
edit templates

To use a template, populate the most-used fields for a specific table, save it as a template, and then
make the template accessible to users. Users can manually apply a template when creating records,
or an administrator can define scripts to apply templates automatically. Fields updated by the
application of a template will have a checkmark icon next to the field label.

Create templates for the forms that are used frequently, such as incident, problem, and change.
There is no limit to the number of templates that a user can create or access, but having many
templates for each form makes the templates more complex to manage.

NOTE: Template creation should be restricted to select groups as it can be used to by-pass process,
like mandatory fields, Ul policies, etc. This is especially important for any record using condition
based workflows.
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Form: Saving Forms servicenuw
Save records by using one of the following methods:

Click Submit to save changes = (ko c::'":“ = lewrecre Submit &

on a new form and return to - ik Number 003 ey o

the previously viewed page  Cale :> o :“' :> - ’f:;;'d

Click Update to save changes on i C:::::s o Update 8

an existing record and return to — e Lo ——

the previously viewed page lr = l:> . — wcoal _—

Select the Form Context menu
icon in the header bar, then
select Save to save changes

Changes
Made

—>

= w0l

L. nNC00)

Caller  Bernard LY

f |

Save

|

= mcuol

L MNCDOY
Caller  Bernard LY

Category Mardware

Cacegary I Haaae

without leaving the form view

The Insert, and Insert and Stay options are disabled by default for task records such as incidents and
change requests but these options can be configured for task records.

NOTE: These options are enabled by default on User and CMDB records because they enable bulk
entry of similar items.

Once enabled, select the Form Context menu icon in the header bar then select Insert or Insert and
Stay to save a new record to the database instead of updating the current item.

There is no "Copy" but Insert emulates copy functionality and leaves the form.

Insert and Stay does the same but stays on the form.

When a form is saved, all the text in the Work Notes field is recorded to the Activity Log field. Work
Notes and Additional Comments are fields that share information with various users associated to
certain record types like incident or problem. Additional Comments are visible to all users accessing
the record, whereas Work Notes are visible to only users with the itil role. The content in Additional
Comments is emailed to the Watch List and Caller, and the content in Work Notes is emailed to the
ITIL Watch List and Assigned to user when the form is saved.

NOTE: If you make changes to an existing record and then attempt to leave the form (whether using
web browser controls such as the ‘Back’ button, or through the ServiceNow user interface), you will
be prompted with a message asking if you are sure you want to leave the record without saving.
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servicenovow

Section Summary

* Whatisa Form?

* Formatters and Related Lists

* Configuration E
* Personalization

* Templates Pages 62 - 70
* Saving Forms

Lab1.3

Forms

10 = 20 minutes

Lab 1.3 — Forms:

* Create and configure a new form view using the Form Designer

* Create and update Infinity incident records
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LAB
Forms 1 .3

B e () 10-20 minutes

Lab Goal

Lab Dependency: Requires the completion of Lab 1.2.

This lab will show you how to do the following:
* Create and configure a new form view using the Form Designer
* Create and update Infinity incident records

Internal employee testing of Infinity has proven worthwhile for a number of reasons.

Winnie Reich will lead an initiative to further improve and organize Infinity testing support by
creating a form view on the incident table containing the appropriate fields and being capable
of capturing field values that accurately identify reported issues.

A. Create the Infinity Form View

1. Impersonate Winnie Reich.

NOTE: Winnie is inheriting the personalize role from a group that she belongs to, which
allows her to configure forms and create new views.

2. Incident > Open.

3. Open the record for INCO000061.
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4. Open the Form Context Menu and select Configure, then finally select Form Layout:

¢ | =|"rcident
Save
Manage /

Export

Busines Viow

Add to Visual Task Board
Create Request r
Create Normal Change

Create Emergency Change

Follow on Live Feed 1
Show Live Feed

N Configure (3 > Form Design

:

3 [rename)] [view]

Metrics Timeline Q || o8

4
-

L e

> Related Lists

B

The Configuring Incident form page displays:

€ Configuring Incident form

Available

Active

Activity due

Actual end

Actual start
Additional assignee list
Additional comments
Approval

Approval history
Approval set
Assigned to [+]
Assignment group [+)
Business duration
Business resolve time
Business service [+]
Caller [+]

Caused by Change [+]
Change Request [+]

Cancel

Selected

Number

Caller

Category
Subcategory
Business service
Configuration item
|- split -|

Contact type

State

On hold reason ~

Impact

Urgency

Priority
Assignment group
Assigned to

|- end_split -|
Short description

5. Find and highlight the Location field under the Available list:

Available

Notify
Opened
Opened by [+]
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6. Click the Add button (>) between the Available and Selected list:

Available Selected
Knowledge Number
Location [+] Caller
Made SLA Category
Notify Subcategory
Opened Business service
Opened by [+] oS Configuration item
Order |- split -

Parent [+] > Contact type
Parent Incident [+] State

Problem [+] On hold reason
Reassignment count < Impact

7. Doing this adds the Location field to the bottom of the Selected list.

8. Use the Move up button (*) to move the Location field under Configuration item.

9. From the Configuring incident form page, click Save to return to the incident form.
Modify Form View with the Form Designer

1. Open the Form Context Menu and select Configure, but then select Form Design.

The Form Designer will open in a new tab or window. Go to the page that looks like
this:

brazderd [ncaure]

Finlds Freir) Typon -
£ incident [inccent] m . .
E Number o . § Contect type o .
) ¥ Cater 00 & s ce
§ Active
§ Activity dus § Calegory O @ § Onhokdreason o0
I Actual end E Subcategory o . B imgmet o .
A - i Busness service 4 . i urgency a .
F Additianal assignes list
- - £ Corfiguraton ilem o . 2P ’ o .
£ Approval
£ Assignment group Q .
E Approval histery
I Assigred O
f Approval sat — °

The Form Designer offers an improved experience because of its graphical user
interface, making it easier to visualize the form view’s end result.

Additionally, there are several configuration options available in this single interface.
At the top left of the page are two drop-down menus in the header; the menu on

the left indicates the table the form view is associated with, and the menu on the
right includes the various views defined for the selected table.
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Open the view (right) menu and select New... at the bottom of the list.

Enter the View name: Infinity:

Create New View .

View name

Infinity

Click OK.

Notice the new view is automatically selected in the view menu on the page’s
header:

On the Fields tab of the Field Navigator on the left, scroll down to locate the Created
by field.

Add the Created by field to the form view:
a) Click and hold on the Created by field
b) Drag Created by to the form layout, between Caller and Category

c) Release your click to add the field

Fields Field Types if Incident [incident]
Fields

#i Created a !
ii Created by I fi Createdby Q
ii Delivery plan # Category o0
#i Delivery task "

H Subcategory o N -}
ii Domain

H Business service Q .
#i Domain Path

# Configuration item Lo N )
# Due date
#i Duration
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7. Repeat these steps to add the Updated and Updated by fields to the form layout,
within the Incident section.

NOTE: We will be reordering fields later.

8. Find the Business service field on the form layout, then click the Remove this field
icon (circled x) to remove it from the view:

# Business service 'ﬂ'E

NOTE: Removing a field returns it to the Fields tab of the Field Navigator, so it may be
re-added if desired.

9. Click and drag the Contact type field to be listed beneath the Number field:

i Incident [incident]
i Number L’ O @ | swe & o0
.2 Caller o & Contact type ~ o0
i Created by 8 @ | onhoreason o0

10. Repeat this step to reorganize the fields in the Incident section to match this layout:

 Incident [incident]
i Number O 0 i swe o0
i Contact type £ @ i Onhoidreason o0
i Calter 8 @ i impac o0
§ Location G @ i Upency o0
i Category O @ i prody a0
i Subcategory £ @ i Assignmentgroup o 3 -]
# Configuration item £ @  Assignedio o 0 - ]
# Created by o0
# Updated a0
H Updated by 1o -}
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Define a New Field

1. From the Field Navigator, click the Field Types tab to add a new field to the form
layout:

Incident [incident] 4

Fields | Field Types

Infinity

2. Scroll down to find the True/False field type, then add the field to the form layout
under the Caller field:

# Caller

# New True/False

# Location

3. Click the Edit this field icon (gear) to configure the field’s properties:

# New True/False E’

4. Input the following values:

Label: Employee
Name: u_employee

NOTE: The name features the prefix u_ to indicate it is a user-created item. This is a
common naming convention used throughout ServiceNow.

5. Close the Properties window by clicking the close icon (circled x).

6. Click the Save action from the page header to save the form view:

Form Design [ U0 |

7. Close the Form Designer tab/window, and return to the ServiceNow instance.

8. Use the Form Context Menu to reload the form (Reload form).
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9.

Now open the Form Context Menu and select View, then finally select Infinity.

The new Infinity form view should load and display as designed!

B. Create and Update Incident Records

With the new form view defined, the next step is to create and update Infinity testing records
by inputting the information into the correct fields.

Steps for creating a new single incident with the State “In Progress” and EIT tag, and
“employee” checkbox selected. Make sure Assignment group is set as well.

1.

2.

Incident > Create New.

Fill in the rest of the fields as follows:

Contact type: Walk-in

Caller: Buster Wubbel

Employee: [checked]

Category: Software

State: In Progress

Assignment group: Service Desk

Short description: Issue discovered with two step authentication

Description: Authentication requirements for logging into Infinity are not working
as expected.

NOTE: The Location field may have populated automatically because of the Caller value
inputted.

Save.

Open More options from the form header.
Click Add Tag.

Search for and select the EIT tag.

Update.

If the active incidents list does not display, navigate to Incident > Open.
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9. Apply the Infinity Testing filter.

There are now four total open Infinity employee incident records:

Q = Number v = Priority
[NC0010001 5 - Planning
(i) INCOOOO061  5-Planning
i INCO000042 5 - Planning
(D  1NC0000023 5- Planning

= State = Caller
In Progress ;_::;ﬁ
New 3"&: .
New m
New Ted Keppel

= Category

Software

Software

Inquiry / Help

Software

= Subcategory

= Short description

Issue discovered with two
16 authentication

Infinity holographic
settings page will not
display

password reset request

Infinity showing an error -
employee testing

= Assignment group

= Assigned to

I_!I
B A E S

NOTE: The new incident number may be different in your instance.

Challenge

Update records to change the state, assignment group and check
"Employee” checkbox.

As Kevin Edd, use the strategies of your choice to update the following records:

Number Employee State Assignment group
INCO000023 True In Progress Service Desk
INCO000042 True In progress Service Desk
INCO000061 True On Hold Service Desk

NOTE: If required, set the value for the On hold reason field to Awaiting Caller.
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LAB VERIFICATION

Infinity Incident Form View

< = New record infnity view) @ = ocoo sibmt | Resohve
Number INCO010002 State New B
Contact type -- None - H Impact 3-Low H
% Caller Q Urgency 3-Low ¢
Employee Priority () 5-Planning
Location Q Assignment group Q
Category Inquiry / Help H Assigned to Q
Subcategory - None - H Created by
Configuration item Q Updated
Updated by
s Short description Q
Description

Updated Infinity Incident Records

o2 Q, = Number v = Priarity = State = Caller = Category = Subcategory = Short description = Assignment group = assigned to = Taps = updated
Buster Issue discovered with two 2018-02-26
) 5.PL P
(i)  INCO0I000] g WPoges b Software step authentication Service Desk H 09:09:43
Infinity holograghic
. Alzsa 2018-02-26
(i)  INCODODOE) 5-Planning  On Hold Software settings page will not Service Desk 1%
“ Mountjoy : ar 09:15:49
display
~ Megan . E 2018-02-26
O S-Planning  laProgress o o inquiry / Help passwordresetrequest Service Desk E 09:16:14
o - Infinity shawing an error - ' 2018-02-26
(i)  INCODOOO23 5-Planning  InProgress TedKeppel  Software R : Service Desk ar x 09:11:53

Well done — you have created a new form view!
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Module 1 - 1.4 Branding servicenow

Objectives

* Instance Settings
* Application Configuration: Guided Setup

* Basic Configuration: System Branding
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Banner Frame: Instance Settings servicenuw

@ System Administrator ~ O, () ®

Click the Settings icon from the

banner frame to customize your | e S -—' 1

instance

These settings affect only your user
account and are retained each time
you log in

- s | 1 I r
Ty— (- b [

D
.

e [

The Settings icon (gear) in the upper-righthand side of the Banner Frame contains additional settings
and options for personalizing your view of the platform.

NOTE: Users may be limited to what settings they have access to based on their role.

After selecting the Settings icon, the categories on the left (General, Theme, Lists, Forms,
Notifications, and Developer) provide different settings, including:

General Tab: Compact the user interface optimizes the Ul to display more information in the
browser window when this setting is enabled

Theme Tab: Select a theme for the user interface. Select the System theme to return to the
default theme

Lists Tab: Wrap longer text in list columns allows for long strings to wrap in list columns
instead of appearing as one long line

Forms Tab: Form sections and related lists appear in tabs when the Tabbed forms setting is
enabled. Also Related list loading is used to determine when Related Lists load on forms.

Notifications Tab: Allows you to enable various notification channels, as well as manage your
notification subscriptions

Developer Tab: Settings for ServiceNow Application developers
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Application Configuration: Guided Setups servicenuw
ITSM Guided Setup ]
PR— IT Operations Management Guided Setup
Getting started m
Se
Gt goitg Lisgen Feel #mipower] e
et gourg! Leam be rrgone v
Update Sets
0% ITSM Guided Setup
= Company : 0/ 2 Tasks completed
Ay I(‘ 0% Systemn Confguration
J_,.-L. 5 4:..0'.‘«-1"3('.‘.:.-. g ,,,-_'.- Py - . ~
e it mys £
d time formas: Phace Il Aplty
=3

Users with an administrator role may use a Guided Setup to go through suggested steps to
configure applications on the ServiceNow instance.

Using the ITSM Guided Setup, users can perform structured configuration activities that help
configure ITSM applications and can monitor the progress. Each configuration activity in ITSM
Guided Setup is designed to simplify the configurations by providing access to contextual embedded
help, contextual documentation on the ServiceNow product documentation site, and guided tours
(if available for an activity).

The ITSM Guided Setup configures the common platform settings through the following categories:

* Company: Activities under this category help you to configure company name, logo, and color
theme to reflect your corporate brand and to configure the default system settings such as the
time zone and the date and time formats

* Connectivity: Activities under this category help you to configure your ServiceNow instance to
support inbound and outbound email notifications and to integrate it with your existing LDAP and
Single Sign-On (SSO) solutions

* People: In case you do not use LDAP to import data into your ServiceNow instance, activities
under this category can help you to import Users, Groups, Group Members, Companies,
Departments, and Locations and to assign roles to groups

In addition to the ITSM Guided Setup, there are guided setups for ITOM and HR as well.
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Basic Configuration:

System Branding servicenow

Browser Tab

|C'oud Dimensions ServiceNowl

Banner Image

service

Navigation Colors:

System Properties

Systemn Properties

Basic Configuration

Basic Configuration ULLE

service o—— B i -

[+ = Syite Adninab sen

| =

: Create sre Degiey T1] Duwts Maragerret Dagrewtc
L L]
o aEm

A tmat -+ romepapn tegaer
= H

Q = P £

Many branding activities are grouped together in System Properties > Basic Configuration Ul16.

Customization and branding options include:

* Banner image, text and colors

* Navigator background and text colors

Features which can also be customized:

* Browser tab title

* Color: Use the built-in color pickers to dynamically pick and preview branding options

* System date/time formatting
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Section Summary

* Instance Settings EI;.ab ;.4
* Guided Setups randing

* System Branding @‘

Pages 76 - 78 5 =10 minutes

Lab 1.4 - Branding:

* Use the ITSM Guided Setup to apply branding to the instance
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Branding 14

B e (5 5- 10 minutes

Lab Goal

This lab will show you how to do the following:
* Use the ITSM Guided Setup to apply branding to the instance

Cloud Dimensions recognizes the importance of aligning ServiceNow’s branding with the rest of
the organization so that users automatically feel familiar, seeing it as a trusted platform.
Therefore the ServiceNow instance will be branded to achieve this.

Required Resource: CloudDimensions-CD-Logo.png

A. Apply Branding with the ITSM Guided Setup

Begin the lab by impersonating the system administrator. This user has the appropriate
permissions for defining platform-wide properties. We will work with the ITSM Guided Setup to
get started on company branding.

1. Impersonate the System Administrator.
2. Guided Setup > ITSM Guided Setup.

After the Guided Setup page loads, click the Get Started button:

ITSM Guided Setup

Getting started Get Started

me to ServiceNow's Guided Setup wizard. The goals of Guide

Get going Learn ]\ Feelempowered

Feel empowered to
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Next, click Get Started from the Company section:

ITSM Guided Setup Filter ~Showall W

0/2Tasks

Company Skip completed

0%
Transform the ServiceNow instance by System Configuration

configuring your company name, logo, and

Welcome Page
color theme to reflect your corporate brand,
Configure the default system settings such as

Not Started the time zone and the date and time formats.

The first task to complete is System Configuration.

3. Read the summary text, for what to expect, then click the Configure button:

System Configuration skip  Add Notes ixkneConsiin
Not started yet . -

Configure default settings for the time zone and the date and time formats of the

system. Upload your logo to appear in the banner, and customize the banner and

browser tab text.

Optionally, personalize the background, text, and separator colors of the instance. To
do this, obtain the approved brand color names, RGB, or hex values from your

marketing group.

4. Fill out the fields as follows:

Page header caption: Cloud Dimensions <YourFirstName YourLastName>

NOTE: Replace <YourFirstName YourLastName> with your own name (for example,
Cloud Dimensions Joe Employee).

Browser tab title: Cloud Dimensions ServiceNow

Banner image for Ul16: [CloudDimensions-CD-Logo.png]

Header background color: #2b3a5a

Header divider stripe color: #d84833

Navigation header/footer and navigation background expanded items: #486a93
Navigation selected tab background color: #ffffff

Background for navigator and sidebars: #536171

Currently selected Navigation tab icon color for Ul16: #000000
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NOTE: As you enter values, especially for color fields, changes may display in real time.

5. When finished, click the Save button.
6. Refresh your browser to ensure the changes take full effect.

7. From the Help sidebar, click Mark as Complete for this Guided Setup task:

LAB VERIFICATION

Cloud Dimensions System Theme

w2 Cimernions Joe Tnployes u Syitins Adwistilrat *

+  Syster Admisitration v ® C

Make your life easier, create a dashboard! X
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asly 396, move, i resire widgets. You Cae a3 208 Mutiple tabes, Flexitie Saring lets py user s b ol aborate 0n GasHE0NTs aith you!

ety deaboard verasn

System Administration
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- . ’
N\ P ‘4 —

NOTE: For demonstration purposes, as well as clarity of these training materials, screen
shots in future labs will use the “Cloud Dimensions” system theme as defined in this lab.

Congratulations, you have completed the Branding lab!
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Module 1 Recap M
User Interface & Navigation
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For these selected topics, discuss:

Why would you use these capabilities?
When would you use these capabilities?

How often would you use these capabilities?
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' Collaboration

3 | Database Administration

s | Service Automation

s | Intro to Scripting & Application Tools
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Module 2 - 2.1 Task Management servicenow

Objectives

* What is a ServiceNow Task?

* Task Assignment
~ Assignment Rules
— Agent Intelligence

* Accessing Tasks: My Work / My Groups Work
* Presence

* Notes Tab

* Activity Stream Inline Editing

* Visual Task Boards
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What is a ServiceNow Task?

servicenuw

Tasks

A task is any record that can be assigned or
completed by a user in ServiceNow

A task record is created from a table that
extends the Task [task] table

Work is performed upon a task it and
eventually moves to a closed state

Within ServiceNow, all ITIL processes
(incident, problem, change, etc.) are
handled through tasks

Task
[task]

Incident
[incident]

Problem
[problem]

Change Request

[change_request]

Tasks are created by users who are requesting the task to be performed, and are then updated as
the task moves along a workflow. Tasks can be assigned to specific users or user groups.

The Task [task] table is one of ServiceNow’s core tables and provides a series of standard fields used
on each of the tables that extend it, such as the Incident [incident] and Problem [problem] tables. In
addition, any table which extends Task can take advantage of task-specific functionality for driving

tasks, including:

* Approvals: Approvals can be generated to a list of Approvers, either manually or

automatically, according to Approval Rules. Approvals can be incorporated into workflows or

can stand alone.

» Assignments: Assignment rules can automatically assign tasks to users or groups, ensuring
that tasks are handled by the most appropriate team members.

* Service Levels: Service level agreements can track the amount of time that a task has been
open, to ensure that tasks are completed within an allotted time.

 Inactivity Monitors: Inactivity monitors ensure that tasks do not fall by the wayside by
notifying users when tasks have been untouched for a predefined period of time.

* Workflow: An administrator can specify a specific workflow process to apply to tasks that
meet certain conditions. After a task is created that meets the conditions, the workflow
applies an automated process to the task. The process is defined in the graphical workflow

editor.
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Task Assignment servicenuw

Add Users to Groups Apply Roles to Groups Assign Tasks to Groups
é}@% COQ% Service Desk L] —
— /
: = g
(I < _YI1 e — \
| | 1 | | L
Service Desk Assign Tasks to Users
itil

catalog (‘
Group Roles Grant Users Access to Tasks

Typically, user administration helps to facilitate task assignment in ServiceNow.

Users can belong to more than one group and groups identify a subset of users based on roles.
Users in groups can be assigned permissions to approve, change, or resolve incidents and requests,
provide a reference for alerts and notifications, and receive email notifications.

Every user belonging to a group inherits that group's roles, so the preferred method of role
management is:

* add users to group
* apply roles onto groups

When removing a user from a group, roles inherited by that group are revoked for that user.

Similarly, a group may contain other groups, where a child group inherits all roles owned by its
parent. Users added to child groups gain roles of that child group plus any parent groups.

NOTE: Group names are unique in ServiceNow.

With groups defined, tasks can be assigned to them and then to single users belonging to that
group. In other words, a task record can be assigned to an assignment group and an assigned user.
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Task Assignment: Assignment Rules servicenuw

Assignment rules can automatically set a value in the assigned_to and assignment_group fields of a task record

Conditions defined in the assignment rule determine when the rule will trigger and what values it will set

Applies To  AsaignTo  Script
— A t Data Lookup
< == New record
Takie
InCdent [ncsdent] v
Category ~ None - H
Conchtions
egory ~None - .
Add Filser Condition  Add "OR" Clause Subcat o o
chaose field v oper - valse - Configuration Item Q
L —
ApplesTo  AssignTo  Scrigt Location Q
User S
Assignment Group Q
Geoup Assigned To Q

Create an assignment rule by navigating to the System Policy > Rules > Assignment module.

An assignment rule must also meet these additional criteria to run:

* The task record has been created or updated. Assignment rules do not apply to unsaved
changes on a form.

* The task record must be unassigned. The record cannot have an existing value for either
the assigned_to or assignment_group fields. Assignment rules cannot overwrite existing
assignments (including assignments set by a default value or a previously run assignment
rule).

* The assignment rule is the first rule that matches the table and conditions. If more than one
assignment rule matches the conditions, only the rule with the lowest order value runs

Additionally, assignment rules can be scripted, giving even more flexibility on the trigger and
outcome.

Assignment data lookup rules can be created by navigating to the System Policy > Rules >
Assignment Lookup Rules module. These rules only apply to incident records and have less options,
compared to the other assighment rules.
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Task Assignment: Agent Intelligence servicenow

Agent Intelligence uses machine-

learning algorithms to set field poosmssmmes p Agent R ———

values during record creation | WeuREsTeR In;e’(lfliﬁ;nce E ACTION i
! . 15[ () éﬁ_ |

Improve efficiency and quality, and i i ; ‘:L : E

reduce cost by: : S, - RFE SOIVe | Cutegoisaton  Assignment |

* Reducing task resolution times : Mads with : ahdiic] : :

* Reducing the number of interactions : e E g i Priorisisation E

required to resolve tasks

* Reduce the error rates of categorizing
and assigning work

Users with the admin or ml_admin role will be able to initiate the setup of Agent Intelligence.

This functionality does require multiple plugins — more information about setup and initial
configuration can be found here:

https://docs.servicenow.com/bundle/kingston-servicenow-platform/page/administer/agent-
intelligence/task/get-started-agent-intelligence.html

Once activated and defined, Agent Intelligence is truly personalized machine learning tailored to
your data.

For example, when an incident is created, ServiceNow will automatically assign the right category,
priority and assighment group based on the record’s short description. A requester no longer has to
scroll down multiple lists to choose the most appropriate category, and the incident created gets the
right attention and SLA it deserves; thus increasing the overall service level satisfaction
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Accessing Tasks: My Work / My Groups Work servicenow

My Work

The Service Desk application menu
allows you to locate all work assigned List of all active tasks assigned to you,

to your group or to you in a list including:
* Change Request

* Group Approval

Service Desk

* Incident

* Knowledge Base Submission
* Request

* Security Case

* Visual Task Board Task

The itil role is required to access the
My Work and My Groups Work modules

in the Service Desk application List of all active tasks assigned to your
group but not yet to an individual

My Groups Work

There are various features for managing and closing task records.

You can quickly locate all work assigned to your group or to you specifically in ServiceNow, using the
Service Desk application.

When an active task (which might include work such as incidents, problems, changes, and more) is
routed to your group, it can be located under the Service Desk > My Groups Work module. From
there, a group member or manager may assign the task to an individual within the group.

At that point, locate any active task specifically assigned to you under the Service Desk > My Work
module.
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Presence servicenow

The Presence feature facilitates synchronous collaboration within one record. You can see who is
online, view their current status, and what they are viewing or editing, all in real-time

—s o000 Follow -

Follow

Viewing this record

Q Beth Anglin

Activity
2). System Administrator e, ML User

Systermn Administrator has been added to the group

Open Connect Mini

Open Connect Full

= You are now )(
& INC0000055 in Connect.
ale You will be notified of any
Standwd Order BR Purchase coder o new comments or Wfk
Soigio oAty SUTANA SUITAMA, - R AR |
notes according to your
__ notification settings.

Imagine a scenario in which you have a critical issue, documented in a Priority 1 record. Multiple
stakeholders may need to view and update the record simultaneously. The Presence feature
facilities that collaboration, showing you who is viewing the record, displaying the record activity
stream, and even allowing you to customize notifications alerting you to record updates.

The number of active viewers is listed in the form title bar. Click for a list of viewers.

NOTE: If you do not see this icon, you are the only viewer on this record.

Click the Show Activity Stream icon to jump to the record Activity section, which includes the
record history and updates by you and other viewers.

Follow the record to receive notifications when the record is updated. Open Connect to customize
these notification or start a real-time conversation with record viewers and other stakeholders.
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Presence: Real-Time Editing servicenow

Edit records in real-time, and see edits saved by other users (just like Google Docs) which
improves collaborative efforts

{ = m%, e, & | :—3 000 Follow «  Update Resolve Delete 4 |,
Number INCOO0O0S T Contacttype  Phone H
Caller Joe Employee Q g @ State In Progress H
§Category  Network $ Impact 2 - Medium
¢ Urgency 2 - Medium %
Business service Q, Priority (¥ 3 - Moderate
Configuration item * JEMPLOYEE-IBM Q, o ® S Assignment setwork Q ©
Eroup

SAssignedto  David Loo Q 0

ITIL User has set this field to Bow
Ruggeri

Real-time editing is an extension of Presence. It allows you to work with others on the same record,
indicating their state (editing or viewing) as well as what their edits are (shown through the blue
"pulse" icons in this screen capture).

Connect enables you to work seamlessly with others using entirely different interfaces or devices to
perform tasks. You can use Connect on Visual Task Boards (VTBs), Connect Chat, Apple Watch, and
more.

Connect is about working with others in real-time; reducing record resolution from days to mere
minutes.
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Notes Tab: Work Notes and Additional Comments Servicenuw

Use the Notes tab in a record to communicate to stakeholders
and document task activities throughout the lifecycle

Notes Related Records  Resolution information The Show all journal fields
icon (=2 ) allows you to
Watchlist & Worknoteslist @ | J¢ display multiple fields under
the Notes tab, including

Work notes -2 Work notes and Additional
comments

Additiona Once enabled, you can then
praco click the Show one journal
field icon ( “=) to only display
the Work notes field

(Customer visible)

Post

The Notes tab allows you to document task activities throughout its lifecycle for both an external
and internal audience. Depending on the task record type, additionally fields may be available to
accomplish similar outcomes including, but not limited to, the Additional comments field. In the
example seen here, an incident record’s Notes tab is displayed.

1. The Work notes field provides a log to document all the technical and behind-the-scenes work
on a task. Upon saving, Work notes are stored in the record Activity section, where they can be
viewed and added upon by users with permissions to view the record. Fully documenting Work
notes is beneficial for Knowledge Management and critical for continuity in the task
management process. Work notes are only visible to Fulfillers and are not available to external
users or customers.

2. Use the Additional comments (Customer visible) field to communicate back and forth with the
requester and other stakeholders directly in ServiceNow. For example, you may want to keep the
customer apprised of progress on their record or request additional information. Upon saving,
the Additional comments (including the updated information and comments history) are
emailed directly to the requester. When the requester receives an email notification containing
Additional comments, they can respond directly to the email and their feedback will be
documented in the Activity log of the record, along with your Additional comments.

NOTE: When responding to an email from ServiceNow, do not change the Subject as it may not
be saved to the correct record.
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Notes Tab: Add Stakeholders Servicenuw

Send users additional notifications with .

the Watch list and Work notes list fields Additional Work
comments notes

Users added to the Watch list will receive
anything entered as Additional comments
(Customer visible)

Users added to the Work notes list will
receive anything entered as Work notes

!

Watchliss | & J2

!

Work notes list & R

NOTE: One or both of these fields will appear on the record, under the Notes tab, depending on the
record type. Incident records contain both the Watch list and Work notes list for use.
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Notes Tab: Activity servicenow
The Activity section
located under the Notes " NG ]| who? ¥
tab proVides a comp'ete The SAP Human Rescurces apslication o ot scoemabile "
history of a record = P r—
- e R Ueer v Assignedto
It deta']s: I 1 cannot acorss this application 50 we may have an outage I what? " Attachments
* Who made an update? ~pe -
* What was the update? —— ] Wit
SAP Human Resouroes | Opened by
* When was the update - v Prionity
b JI'IU‘T“ + Relatonshep Changes
madE? 1|c:‘1  Resolution code
" Resolution notes
Clicking the filter icon (%)
allows activity information s When?

to be filtered

From creation through to closure, the entire history of the Incident record is automatically tracked
and recorded in the Incident Activity section, located in the Notes tab.

The Activity section, which is read-only, documents when a change was made and by whom. These
changes include assignment and reassignment, Additional comments and Work notes, updated field
values, State changes, and more.

The funnel icon in the top-right of the Activity section allows you to filter your view to see only your
desired categories of information.
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Presence: Activity Stream Inline Editing

servicenuw

The activity stream inline editor enables users to contribution to actual work within a record
without opening a form interface
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Just like real-time editing on a form, inline commenting on the activity stream means you can
annotate active records as updates are made, allowing multiplied efforts across several pieces of

work simultaneously.

To do so, navigate to a list of active task records, then:

1. Click Show activity stream in a flyout window from the list header

2. With the window open, scroll down to browse the records recently updated and hover over
an update you wish to comment, then click Comment

3. Enter your comment into the text field, then click the Post button

A benefit of activity stream inline editing is that you are able to update multiple active records
without having to open a single record.
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Visual Task Boards servicenow

Transform your lists and
forms into an interactive
graphical experience using
Visual Task Boards (VTB)

Visual Task Boards allow you to:

* Manage your tasks through a
visual, drag-and-drop interface

* Identify process bottlenecks at
a glance, in real-time b o

» Track embedded activity screens “
to view updates all in one place

Trouble getting to ¢

Can’t access SFA software

+ Add Task

Use Visual Task Boards (VTB) to create your personal to-do list, collaborate in real-time with group
members on assignments, and more. Displayed graphically as lanes and cards, VTBs provide a
landing page to view and organize all your work in ServiceNow.

There are three types of VTBs:
* Freeform: Use Freeform boards as your personal organizer, creating individual tasks of any
kind and freely adding, removing, and modifying cards and lanes

* Guided boards: Alternatively, use a Guided board, which is created from a list and uses a field
value (e.g. Incident States) as lanes. Records in that list, which appear as cards, are actually
modified when you edit cards or change lanes in a Guided board.

* Flexible: Flexible boards are also created from a list but lane changes do not update
underlying task data

To get started with VTB, navigate to Self-Service > Visual Task Boards and follow the instructions for
creating a board.
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servicenovow

Section Summary

Lab 2.1

* What is a ServiceNow Task?
Task Management

* Task Assignment

* My Work / My Groups Work @

* Presence

* Notes Tab Pages 96 — 103 10 - 15 minutes

* Activity Stream Inline Editing
* Visual Task Boards

Lab 2.1 - Task Management:

* Browse the Service Portal
« Submit an incident from the Service Portal

* Use work notes, comments, and chat to cooperatively manage an incident
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LAB
Task Management 2.1

B . (4 10-15 minutes

Lab Goal

This lab will show you how to do the following:
* Browse the Service Portal
* Submit an incident from the Service Portal
* Use work notes, comments, and chat to cooperatively manage an incident

In addition to internal testing, Cloud Dimensions has begun allowing major partners to test
Infinity devices.

Before submitting an incident to report a problem, these partner users have been instructed to
first browse the Knowledge Base in Cloud Dimensions Service Portal.

If the user is unable to find a solution to their problem, submitting an incident will receive
attention by a support agent in the Infinity Customer Support group.

The Infinity Customer Support group has defined processes for incident assignment and
resolution, which uses assignment rules and connect chat to ensure the best help is offered to
an end-user.

A. Browse the Service Portal

Start this lab by logging into the Cloud Dimensions Service Portal as a partner user experiencing
problems during Infinity testing.

TIP: Open up another browser to complete these steps.
1. If you are not using a different browser, log out of your instance.

2. Add /sp to the end of the URL:

https://instance-###.lab.service-now.com/sp

3. Press Enter on your keyboard.
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You should be brought to the Service Portal:

service

Search the knowiedge base

Welcome to the —_—
Service Portal

Log in to order things, get help or report an issue

4. Log in using the following user credentials:

User name: jon.floyd
Password: floydpass

5. Type infinity holograph broken into the How can we help? search bar on the home
page; then press enter on your keyboard.

No Results will display:

He > Search
> HKnowledge Base Your search - infinity hologram broken - diid not match any documents

2 Questions and Answers Suggestions:

® Make sure all words are spelled comectly
? Service Catalog * Try different, more general, or fewer keywords

NOTE: Typing either infinity or Infinity will result in No Results.

At this time, we will assume Jon Floyd continued browsing the Knowledge Base, but
was unable to discover a solution for the issue he is experiencing.

As established by partner procedure, he will now submit an incident to receive help
from Cloud Dimensions.
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6. Click the ServiceNow logo in the top-left corner to return to the homepage.
Submit an Incident

1. Select Get Help:

Get Help

Contact support to make a
request, or report a problem

2. Scroll down and select Create Incident.

3. Fill out the form as follows:

Urgency: 3 - Low
Please describe your issue below: The Infinity is having trouble displaying clearly.

4. Click Submit.

You may briefly see a message on the top of the screen indicating your incident was
created and your profile badge should show one Request.

5. Log out of the instance as Jon Floyd.

NOTE: If you opted to use another browser for these steps, return to the original session
and move to step 1 of the Update the Incident section below. Otherwise, continue on to
the next step.

6. From your instance URL, remove the /sp suffix (including everything that follows).

7. Press Enter on your keyboard to return to the normal login screen.

B. Update the Incident

1. Loginto the instance as the System Administrator.

NOTE: If you experience issues with the interface caching, refresh the browser and click
on the ServiceNow logo.

2. Impersonate Rita Center.
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NOTE: Rita is a Customer Support Agent on the Infinity Customer Support group
specializing in software-related issues.

Service Desk > My Groups Work.

NOTE: The incident was automatically assigned to Rita’s group (Infinity Customer
Support) by an assignment rule created for the purpose of this exercise.

Open the incident record and update it as follows:

State: In Progress
Assigned to: Rita Center

Save the record, staying on the form.
Assume Rita has remotely accessed Jon’s device and found no apparent issues.
Update the incident record to inform Jon that it must be escalated to another team:

a) From the Notes tab, type into the Work notes field: Hello Jon, | wasn’t able to find
anything on my end but this incident will be escalated appropriately.

b) Check the Additional comments (Customer visible) checkbox

NOTE: Confirm the Work notes field label changed to Additional comments (Customer
visible before posting.

c) Click the Post button

Notes Related Records Resolution Information

Watchlist & @2 ° Worknnoteslist & @ S

Work notes Hello Jon, | wasn't able to find anything on my end but this incident will be escalated —

appropriately.
m Additional comments (Customer visible) Post
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8. The comment now appears under the Activity section:

Activity
RC Rita Center 2017-07-19 13:00:10

Hello Jon, | wasn't able to find anything on my end but this incident will be escalated appropriately.

9. Update the incident as follows:

Category: Hardware
Assigned to: Trey Tout

10. Save.

11. From the form header, click the Follow button:

Rita will now receive notices when any new comments or work notes are added.
Additionally, Rita can now use chat to facilitate the resolution of this incident with
peers.

12. Open the Connect Sidebar to locate the conversation around the incident:

13. Select the “Infinity is having trouble” conversation from the Connect Sidebar to open
a chat window.

Collaboration
© 2018 ServiceNow, Inc. All Rights Reserved 100




14. Add Trey Tout to the conversation:
a) Click the Add User icon
b) Search for Trey Tout

c) Select his name

Traci Toomey

Travis Brockert
TreyTout w |
Tricia Kruss

Jon Lloyd 22m ago Trudy Worlds
The Infinity is having trouble displaying clearly.

JL

Rita Center 8m ago
Hello Jon, | wasn't able to find anything on my end
but this incident will be escalated appropriately.

RC

15. With Trey added to the conversation, type the following message into the Worknote
text field at the bottom of the chat window:

Hello Trey, | thought you could help with this as there are no software issues
detected. Thanks!

16. Press Enter on your keyboard to send the message.

C. Update the Incident

1. Impersonate Trey Tout.

NOTE: Trey is an Engineer on the Infinity Customer Support group. If you are unable to
find his name while impersonating Rita, switch back to System Administrator before
impersonating again.

2. Open the Connect Sidebar to view the conversation from Rita:

. The Infinity is having troubl...

Hello Trey, | thought you could h. ..
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3. Service Desk > My Work.

4. Open the incident.

NOTE: You could also access the incident directly from the chat window by clicking on
the View Document icon on the chat window header:

. TheInfinityishavin... & B & _ X

5. If open, collapse the chat window and close the Connect Sidebar.

6. With the record open, under the Notes tab, click the Show all journal fields icon to
the right of Work notes:

Work notes E

Additional comments (Customer visible) Post

7. Update the record as follows:

Work notes: Not enough information provided, contacting the customer to request
more.

Additional comments (Customer visible): Hello Jon, I've been added to help resolve
your issue. Could you please provide additional information about what you’re
experiencing? Thank you.

Your fields should look like this:

Work notes Not enough information provided, contacting the customer to request more.
Additional Hello Jon, I've been added to help resolve your issue. Could you please provide additional information about what you're
comments (Customer experiencing? Thank you.
visible)

8. Click the Post button to add these comments to the incident.
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9. Notice the Connect Sidebar icon has changed, indicating two new messages have
been received:

10. Set the record’s State to On Hold.
11. Select Awaiting Caller as the On hold reason.

12. Save the record.

NOTE: Although the incident was not resolved at this time, Jon will be able to respond to
Trey’s inquiry and provide more information to identify a solution.

LAB VERIFICATION

Updates to an Incident

Review the updates made to the Activity section, recognizing internal (work notes) and
external (additional comments) communication:

TT Trey Tout 2017-07-19 13:17:39

Hello Jon, I've been added to help resolve your issue. Could you please provide additional information about what you're experiencing?
Thank you

TT Trey Tout 2017-07-19 13:17:59

Not enough information provided, contacti ng the customer to request more,

RC Rita Center 2017-07-19 131112

Hello Trey, | thought you could help with this as there are no software issues detected. Thanks!

RC Rita Center 2017-07-18 13

Trey Tout was Rita Center

RC Rita Center 2017-07-19 13:00:10

Hello Jon, | wasn't able to find anything on my end but this incident will be escalated appropriately.

Congratulations, you have completed the Task Management lab!
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Module 2 - 2.2 Communication servicenuw

Objectives
* What is an Event?
* What is a Notification?
* Creating Notifications
* Dot-Walking
* Subscriptions

* Connect Chat and Workspace
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Events and Notifications Servicenuw

T : Events
review Email

An event is an indication to the ServiceNow processes
Summary detalls Events are triggered by:

Closed by: System Administrator 3 " " .
R e « User actions: Logging in, approving a request,

losed notes: F .
HONOEE FS T renaming an attachment, etc.

You can view all the details of the incident by following the link below
Take me to the Incident
Thank you Notifications

Notifications can be triggered by events in the
platform, and require no scripting knowledge

* Scripts: Business Rules and Workflows

Ref:MSGO000004

All baseline events have built in logic to respond when an event occurs. Possible responses include
making a change to a record in the database, creating a new record, sending a notification, or
logging a message. The event definitions are in the Event Registry [sysevent_register] table. The
Event Log displays records from the Event [sysevent] table. To see a log of every generated event
navigate to System Policy > Events > Event Log. By convention, events are named using the syntax
<table name>.<unique event name>. For example, incident.updated, or problem.closed.

NOTE: Use email notifications to send selected users email about specific activities in the platform,
such as updates to incidents or change requests.

A Notification is a tool for alerting users that events that concern them have occurred, including the
following methods:

* Email
* SMS
* Meeting Invitation

Notifications are received by configured users and voluntary recipients.

The platform enables you to send Notifications to email addresses of your choice and to any SMS
capable device (such as a mobile phone).
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Creating Notifications servicenuw

Choose When to Send Choose Who will Receive Choose What it Says
Whe 3 send Wi will rective | What K wil costsin Whan o send Who wll receve What £ will contain B 1 Q . » Font F4
T ) A~ B~ & R ™

Conditions e ' Groega in ks Subrad nhatie
${mail_script:incident_has_been_closed}
${mail_script:incident_closed_incident_detail

e = o ${mail_script:incident_take_me_to_the_incid

Add Filter Condition  Add "OR™ Clavse

i

- HR may use notifications to communicate an office closure due to inclement weather

Feature
Use - Inform customers of the latest information on their open incident
Cases - An account executive is notified that a contract is expiring

Use Notifications to notify users about specific activities in ServiceNow, such as updates to incidents
or change requests. Notifications allow administrators to specify:

* When to send the Notification
* Who receives the Notification

* What content is in the Notification

Notifications can be sent when a record is Inserted or Updated (or both) into the Table specified
above, only if the specified Conditions are met.

Notifications can be sent to specific Users and Groups. If you address the Notification to a user with
an inactive record in the User [sys_user] table, the system does not send the notification to that
user.

TIP: Consider limiting the recipient list of any notification to 1000 users. By default, if a Notification
has more than 100 intended recipients, the system creates multiple notification messages with up
to 100 recipients each. If you want to change the recipient limit, set the system

property glide.email.smtp.max_recipients.

If using an Email Template then Subject and Message will be used from the template unless
overridden with a Subject and Message on this form.
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Notifications: Dot-Walking servicenow

Dot-Walking can get information from a series of referenced fields from different tables,
including Users and Groups

1. From Users/Groups in fields, select the Who will receive
reference field you will dot-walk through Uses B 2
vailabl Availabd Sel d
2. Click the Expand Item icon (+) e (? %@ C,._ij.m.
3. Select the field which holds the value to be (e > _ T a4
referenced Shortdescription £ Buding [+ <
Priority Business phone
4. Click the Add Itemicon ( > ) sl e
fEp—i— .
Starting Incident [incident] + User [sys_user]
Table Caller Field: David Loo Manager Field: Bud Richman

Who Will Receive Notifications?

Users and Groups - You might send Notifications of an incident update to the person who opened
the incident and the person to whom the incident was assigned by including the Opened by and
Assigned to fields. You may also want to send Notifications to the group assigned to the incident by
including the Assignment group field.

If the user or group field you want to reference is not on the current table (e.g., Manager), add the
field by dot-walking to the table it is found on.

To achieve this, from the Notification Who will receive tab, click the Unlock icon for Users/Groups
in fields and find the reference field under the Available column. Then click the Expand Item (+) icon
to dot-walk through this field onto the table it is referencing. In doing so, all fields on this referenced
table will be accessible to the table it is found on via a reference field.

In the example illustrated above, the Caller field on an incident is David Loo. By using dot-walking,
this Notification can be sent to the caller (David Loo) of the incident, as well as the caller’s manager
(Bud Richman). These values are automatically populated because of fields selected — not
hardcoded individuals names. In other words, this Notification will automatically identify the caller
and the caller’s manager (if applicable) based on the information provided in the incident.
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Notifications: Subscriptions servicenuw

Subscriptions —A\— [ B

Subscriptions allow users to be informed of @ Genenl .

g e 4 i Allow Notifications S
various activity occurring in the platform, B8 Theme
whether it directly relates to them or not B i

& Create Channel

In addition to email notifications, Short 8 rfoms P® ] —7
Message Service (SMS) is supported, also mary m.l |
known as text messages on telephones 5= Developer e — -

@ Create Personal Notification
Approval
Assessment

Asset Management

VWV WV WV

Automated Test Framewaork

The Notifications page of the Settings is where users can define Notification channels (methods of
receiving Notifications), as well as manage their subscriptions to system Notifications.

SMS (Short Messaging Service) is the standard protocol used to deliver short text messages to
mobile phones.

Most mobile phones support SMS, even if they do not support more sophisticated messaging, like
email.

Alerts and Notifications can be sent to SMS devices as well as standard email notifications.

Notifications to SMS devices are particularly useful when critical events require immediate
attention, and waiting for an email notification to be accessed and viewed is too slow.
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Connect Chat and Workspace servicenow

Chat service

< o ee R @ VS e rulmeg o Uptse Rk | Dwes

Connect Chat is a messaging - :
tool that lets you work with e e S
others in real-time g Mchomacts 2 G sap. by (e i beipg rars s The SAP 1A application s et oc

YUY A MY T M e achied

Workspace

The Connect Workspace
provides a full-screen view
of all your Connect Chat
conversations in one place

L igh

Click the Open Connect
standard interface icon
(tP) to open the Workspace

ServiceNow provides several tools to help you communicate with your team in real time, based on
information within the platform. Connect Chat is accessible from the Collaborate > Connect Chat
Module (opens full view in new tab) or from the Connect icon in the Banner (opens a sidebar within
Content Frame). You can create new conversations with individual ServiceNow users or create
custom chat groups. A green dot indicates participants who are currently online. Additional options
allow you to add attachments to the chat, customize your notifications to stay in the loop on the
conversation, and easily view and update related records.

The Connect Workspace provides a full-screen view of all your Connect Chat and Connect Support
conversations in one place, plus additional tools to help keep track of important information in
conversations. To open the Connect Workspace, navigate to Collaborate > Connect Chat or click the
Open Connect standalone interface icon from the Connect Sidebar. If you do not have any recent
conversations, a screen appears with helpful information about Connect.

The Connect Workspace interface is made up of three major components:

* Connect Sidebar: Provides access to conversations. The Connect Sidebar behaves the same
way in the Workspace as it does in the Connect overlay. The only difference is that the sidebar
appears on the left edge of the Connect Workspace.

* Conversation Pane: Displays the currently selected conversation

* Conversation Tools: Provide quick access to key information, conversation members,
attachments, and notification preferences for the currently selected conversation. Some of
the conversation tools vary depending on the type of conversation.
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servicenovow

« What is an Event? Nﬁ::fi’cit'ii )

* What is a Notification?

« Creating Notifications @‘

* Dot-Walking

* Subscriptions Pages 111 -117 10 - 15 minutes

Connect Chat and Workspace

Section Summary

Lab 2.2 — Notification:

* Develop a new email notification

* Test the notification
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AB
Notification 2.2

B . (4 10-15 minutes

Lab Goal

This lab will show you how to do the following:
* Develop a new email notification
* Test the notification

Buster Wubbel — manager of Infinity Security — has requested that a notification be created to
alert him and his team whenever a critical employee Infinity incident is active, and categorized
with Security.

Additionally, the notification should alert any manager of the assigned group, seeing as the
incident as urgent.

A. Develop a Notification

We will assume Buster Wubbel has shared the notification requirements with the system
administrator — whom which you will impersonate to create the new notification.

1. Impersonate System Administrator.
2. System Notification > Email > Notifications.
3. New.

4. After the new notification record loads, open the More options menu from the form
header, then select Toggle annotations on / off:

¢ =R

. 99 Toggle Template Bar

(? Toggle annotations on / off J

NOTE: Annotations appear on various forms and contain useful information. It is always
recommended to read them before toggling them off.
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5. Set the Name to P1 Infinity Incident:
Name P1 Infinity Incident
This notification will be defined to inform the Infinity Security group and the
assignment group’s manager whenever a critical (Priority 1) employee Infinity
security incident is active as a result of being created or updated.
6. Under the When to send tab, set the following values:
Inserted: [checked]
Updated: [checked]
Conditions:
Active | is | true AND
Priority | is | 1 — Critical AND
Category | is | Security AND
Short description | contains | infinity
OR Short description | contains | Infinity
Your When to send tab should look like this:
Send when Record inserted or updated H
Inserted v Updated x s
Conditions Add Filter Condition = Add "OR" Clause
All of these conditions must be met
Active v is ¢! | true H AND  OR X
Priority v is ¢! 1-Critical ] AND OR X
Category v is ¥ | Security v AND OR X
Short description v contains » | infinity AND | OR X
or Short description v | contains & Infinity X
NOTE: The Security category choice was previously defined for this exercise.
7. Select the Who will receive tab.
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8. Click the Unlock icon (closed lock) for Users/Groups in fields:

10.

11.

Users/Groupsin fields | & |

Instead of selecting a user by name, thus hardcoding that particular user to the
notification, select a field that contains the data of a user account. Doing so will
require dot-walking tables.

Highlight the Assignment group (+) field (formatted in green) under the Available
bucket:

Available

Number

Opened

Short description
Caller (+)

Priority

State

Catego
Assignment group (+
Assigned to (+

lUndated

NOTE: The (+) icon indicates a field is a reference field, which can then be used to dot-
walk from one table to another.

With Assignment group (+) highlighted, click the Expand Item icon (+) between the
Available and Selected buckets:

—

NOTE: Doing so successfully dot-walks from the Incident table into the User table.

Scroll down in the Available list to find and then highlight Manager [+]:

Available

Group email
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. Click the Add Item icon (>).

This adds Assignment group.Manager to the Selected bucket or, in other words, the
notification will be sent to the manager of the incident’s assignment group.

. Click the Edit Groups icon (closed lock) on the Groups field:

Groups

14.

15.

16.

Search for and select Infinity Security.

Click the What it will contain tab.

Type the following into the Subject field:

IMPORTANT! P1 Infinity Security Incident Created
. Add a dynamic value placeholder to the subject:
a) From Select variables, expand the Fields list by clicking the + icon

b) Scroll down and select the Number field variable

Select variables:

Select variables:

a8 Made SLA

\J DI

@Opened

Notify
(b
as
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c) Highlight ${number} from the Message HTML field, then copy the text to your
clipboard

d) Click your cursor into the Subject field at the end of the text

e) Press the spacebar on your keyboard once

Subject ‘ IMPORTANT! P1 Infinity Security Incident Creat

Message HTML o

I U & » Font Family

> B_~-~ & 2 =B =

Number: ${number} °

f) Paste the ${number} text from your clipboard

Subject IMPORTANT! P1 Infinity Security Incident Created ${number}

NOTE: The S{number} placeholder is added to the end of the subject text and is dynamic,
meaning it will automatically populate with the incident number value of the record that
triggers the notification. Additional placeholders can be found and added from the Select
variables section to the subject and Message HTML fields.

18. Update the Message HTML field to include the following text, replacing any existing
text:

Critical Incident S{URI_REF} has been created with an Infinity Security category.

NOTE: The S{URI_REF} placeholder includes an upper-case “i” after the “UR” text. Check
to see how this placeholder behaves after the notification is generated.

19. Click Submit to save the notification.
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B. Test and Verify the Notification

Create an incident to trigger the notification, then check to verify it was sent.

NOTE: Email is not enabled for the ServiceNow Lab Instance.

1. Impersonate Buster Wubbel.
2. Incident > Create New.

3. Fill out the record as follows:

Caller: Buster Wubbel

Category: Security

Impact: 1 - High

Urgency: 1 - High

Priority: 1 — Critical (autofills)

Assignment group: Service Desk

Short description: Testing P1 Infinity Security Notification

4. Submit the incident.

Because email is disabled on the instance, impersonate System Administrator to
check the instance’s email logs.

5. Impersonate System Administrator.
6. System Mailboxes > Outbound > Outbox.

7. Locate the record with the Subject IMPORTANT! P1 Infinity Security Incident
Created INCH######, then click on the Created timestamp to open the record.

8. After reviewing the Recipients list, scroll down further, then finally click the Preview
HTML Body related link to display a preview of the message received by the
recipients:

Preview Email

Critical Incident INC0010008 has been created with an Infinity Security category.

NOTE: The S{URI_REF} placeholder renders as a direct link to the incident record.
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LAB VERIFICATION

Outbox: Infinity Security P1 Notification

= Emails [Outbox view] u Goto Created v 44 <
? All> Mailbox = Qutbax > Created on Today
& Q = Created = Recipients = Subject
(i) 2018-02-2717:03:50 cdisecurity@clovdd.com,winnie.reich@clou... IMPORTANT! P1 Infinity Security Incident Created INCD010008

Recipient List

Subject IMPORTANT! P1 Infinity Security Incident Created INC0010008

Recipients cdisecuritv@cloudd.com.winnie.reich@cloudd.com

Great work! You have successfully created and tested a new email notification.
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Module 2 Recap
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For these selected topics, discuss:

Why would you use these capabilities?

When would you use these capabilities?

How often would you use these capabilities?
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servicenvw

4

5

' Database Administration

Service Automation

Intro to Scripting & Application Tools
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Module 3 - 3.1 Data Schema

servicenow

Objectives

* Database Structure and Hierarchy
— Tables
— Records
~ Fields

* Reference Fields
* Table Relationships

* Table Types
-~ Base
— Core
- Custom

* Schema Map
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ServiceNow Database servicenow

Everything in ServiceNow is built on a MariaDB
database, containing tables, which you access through
the ServiceNow Graphical User Interface (GUI)

The Database contains Tables, Tables contain Records,
Records contain Fields — a Field is an individual piece of
data in a record

Data in ServiceNow is stored and managed according to a structure that administrators can view and
configure. A table is a collection of records in the database. Each row on a table list corresponds to a
record in a table, and each column on a table list corresponds to a field on that table.

Instance information is stored in database Tables, which contains Records. A Table is a data
structure or database component and data is stored in tables. The individual pieces of datain a
record are called Fields. When looking at data in a list view, data in these fields can be modified
using the record List Editor functionality.

Lists and forms provide a friendly user interface (Ul) for managing tables and records.
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Record Hierarchy

servicenuw

Information is documented

and saved in fields

Many fields make up a

record, which can be viewed .

and edited using a form

One or more records make
up a searchable, sortable list
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Data in ServiceNow is entered into individual fields, which are displayed on a form. Once saved,
these forms make up lists. A list typically comprises forms with a common theme, such as a record

type, an assignment group, or a priority.

You can then sort or search in these lists to locate a particular form, which contains data in its fields.

NOTE: ServiceNow often uses the term record to describe all the data saved within a particular
form. The form is simply the way that the user can view and modify that record.
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Table Components servicenuw
A table is a collection of records in the database
Records Users
Each record corresponds User ID Name Email Location
to arow in a table _
abel tuter Abel Tuter abel tuter@ Brasilla
In thls case, infOl'matiOl"l adela.cervantsz Adela Cervantsz | adela cervantsz @ Miamu
about a single user aileen_mottern Aileen Mottern aileenmottern@ Rome
alejandra prenatt Alejandra Prenatt { alejandra prenatt @ Paris
| |

|

Fields

Each field corresponds to a column
in a table and represents individual
pieces of data in a record

In this case, one element such as
the user’s name or email address

Records are identified by a 32-character, globally unique ID, called a sys_id.

Record numbers are automatically incremented, and the number format per table in the system can

be changed by visiting the Number Maintenance application.

For example, change the default incident record number prefix from “INC” to “IN.”

Fields are available in a variety of different types, including: Choice, Date/Time, Journal, Reference,
and more. Field types define how a field is interacted with through the interface, as well as the type

and format of data it can store.

Database Administration

© 2018 ServiceNow, Inc. All Rights Reserved

123




Field Attributes

servicenuw

Each field has three key attributes: Field Label

a label, a name, and a value

The label is a user-friendly term which allows people to
identify the field in the user interface

Example: User ID, Name, Location

Field Name

The name is a unique term that the system uses to
identify the field in scripts and automated business

alejandra. prenatt

alejandro.mascall

I Alleen Mottern

Users

User ID Name Location
abel.tuter Abel Tuter Brasilla
adela cervantsz Adela Cervantsz Miami
aleen.mottern Rome

processes

| Alejandra Prenatt

Algjandro Mascall

Paris

Frankfurt

Example: user_name, name, location

alene.rabeck

| Alene Rabeck

i

London

Value

The values are actual data

Each field has three key attributes: a label, a name, and a value.

The field label in this example includes User ID, Full Name, and Location

The name is a unique term that the system uses to identify the field in scripts and automated
business processes. For example, the name attribute of the Location field on the User table is
sys_user.location. Do not confuse the name attribute with the Name field on the user table, which is
a label. The name attribute of the Name field on the User table is sys_user.name.

NOTE: The Name field is a combination of the First name and Last name fields of the user record.

Values are the actual data, such as this user’s name, Aileen Mottern, or her location, Rome. In some
cases, the value may be empty, or null.
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Reference Fields servicenow
Source Table
Reference fields are identified with Incident
the reference lookup icon ( ©. ) Number Caller Category

The reference lookup icon opens a
dialog box for locating a record to
reference, presented as a list of the
referenced (target) table

If a record is specified in the
reference field on the source table,
you can hover over the reference
icon ((1)) to preview the referenced
record (on the target table)

INCO000015 Fred Luddy Software

INCO000016 Bow Ruggeri Hardware

INCO000017 Joe Employee  Inquiry / Help
KN

Q, Reference |
' LN N N N N ]

! Target Table
+ User
Name User ID Department

Bow Ruggeri bow.ruggeri Development
Fred Luddy fred.luddy Development

Joe Employee employee Sales

A reference field stores a unique system identifier (known as the sys_id) of a record on another
table which is what establishes the reference relationship. For example, the Caller field on the
Incident table is a reference to a record on the User table.

When you define a reference field, the platform creates a relationship between the two tables.
Adding a reference field to a form makes the other fields in the referenced table available to the

form.

Administrators can create new reference fields and configure several options for reference fields.

NOTE: A reference field can refer only to records from one other table. To add a field that can refer
to records on any table in the platform, regardless of a shared reference, use the Document ID

element type.

Additionally, wildcard searches can be used in reference fields.
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Table Relationships servicenow
Tables can be related to each other in various ways
One-to-Many Many-to-Many Database Views Extensions

-

M

Incident Table
Extended Table

Task Table
Parent Table

One-to-Many: Within a table, a field can hold a reference to a record on another table. There are
three one-to-many relationship fields:

1. Reference Fields - Allows a user to select a record on a table defined by the reference
field. Example: Caller field on the Incident table allows a user to select any record on

User table.

2. Glide List - Allows a user to select multiple records on a table defined by the glide list.
Example: The Watchlist field on the Incident table allows the user to select any record or
records on the User table.

3. Document ID Fields - Allows a user to select a record on any table in the instance.
Example: Document field on the Translated Text table.

Database Administration
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Many-to-Many: Two or more tables can be related in a bi-directional relationship, so that the
related records are visible from both tables in a related list. Example: software vendors can sell
multiple products and products can be sold by multiple vendors.

Database Views: Two tables can be joined virtually using the Database Views Plugin to allow for
reporting on data that might be stored in more than one table. Database Views are read-only. Create
Database Views by navigating to System Definition > Database Views.

Extensions: A table can extend another table. The extended table includes unique fields plus all of
the fields and their properties from the parent table.
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Table Relationships: Extended Tables servicenow
Tables can extend
other tables, creating Parent Class Child Class
parent and child Incident
tables Number | Location Number Location | Caller
A table that extends
another table is a
child class
A child table inherits A child table may also
The table it extends the fields of its parent contain fields that are

is the parent class

unique to that child class

In ServiceNow, you can create a new table that stands alone or that extends another table.

The Task table and Configuration table are examples of parent classes that are extended to child

classes.

For example, child tables extended from the Task table include Change Request, Incident, and
Problem. Child tables extended from the Configuration table include Database, Hardware, and

Software.

Extending a table incorporates all of the fields of the original table and allows for unique fields to be
created on the new table. The inheritance of the fields of the original table is used to create
subcategories of data. Examples include the Incident, Problem, and Change Request tables, which
are all subcategories of the Task [task] table.

Using the Dictionary overrides feature provides the ability to define a field on an extended table
differently from the field on the parent table. Examples include overriding the default values, field

dependencies, or read-only

status of a field.
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Table Types: Base Tables servicenuw

Children Classes

If a table is extended but itself is not | incident

extending another table, it is called a
base table

-

The task table is such a table, making
it both a parent and a base class

Parent, Base Class

If a field is on a base parent table such as the Task [task] table, for example, a different label can be
defined for each extended table, such as Incident or Problem. To add a different label for an
extended table, navigate to System Definition > Language File, then create a new entry for the

extended table.

Every child table is a specialization of the previous base table or previous child table. The Task [task]
table provides a series of standard fields used on every table that extends it.

To extend a table, select the table to extend in the Extends Table field on the table record.

NOTE: This option is available only when you are creating a table but not all tables are extensible.
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Table Types: Core vs. Custom servicenuw

Parent, Base, Core = — Custom

-'..L:;“"“”"" B leddncd anse
Task Binookadigand il

Child, Core Tables that Tables that are Custom
| incident | exist in the created and do
> base system not exist in the ==
are called base system are
core tables custom tables
Core Custom

Team Awards

Although custom tables are not in the base system, they can still interact with existing core tables.

For example, a reference field on a custom table can access data stored on a core table. By doing so,
a relationship between the tables is created which makes them related tables. This relationship is
not exclusive between just a custom table and a core table. Related tables can be a combination of
multiple core tables and/or multiple custom tables.
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Schema Map servicenuw

The Schema Map — — e ‘

. - B g Srow reeenced tatien B g Whow referecing taties @ g Show etended tabies [ g Shom etending tases
provides a graphical » e — e
representation of = )R e
other tables related g i mEe =
to a specific table S |_SS= o

.'m:_"""""' . -EE ’E.:_
Relationships can be Sl = e L PEES
filtered by extension === e =
e J—— D crugn srme

or reference classes | i e
This tool is available m—— — _—
to admin users only e | B e

In this example map, you will see the Task table as the focus of the map (highlighted in yellow).

Tables with blue bars, including Problem and Change Phase, are tables that extend the Task table.

Demonstrated with the Problem table, you can use the Schema Map to identify what columns
(fields) originate on Problem, and which columns are inherited from the Task table. Additionally, you
can see what field type they are.

Tables with red bars, including Location and User, are tables that are referenced by the Task table.

A series of filters at the top of the Schema Map allow you to show/hide tables based on criteria such
as whether they are referenced by the Task table, reference the Task table, are extended by the Task
table, or extend the Task table.

The Tables window on the far right of the screen provides a summary of all the tables presented and
their relationships.
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Section Summary

Lab3.1

Database Structure and Hierarchy
Data Schema

Reference Fields
Table Relationships — @
Table Types E

Schema Map Pages 132 - 139 10 - 20 minutes

Lab 3.1 — Data Schema:

* Create a new table
* Configure the table form view

* Update the application menu and create new modules
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AB
Data Schema 3.1

B e () 10-20 minutes

Lab Goal

This lab will show you how to do the following:
» Create a new table
* Configure the table form view
* Update the application menu and create new modules

With an active procedure of testing Infinity devices, Cloud Dimensions needs a method for
managing inventory; tracking how many devices have been issued and to whom.

The various teams involved with Infinity testing have come up with a solution but will need the
help of the system administrator to implement it.

Their plan is to have this information accessed through an application menu with a series of
modules.

The primary data point being tracked will be the Infinity devices but information about the users,
such as name and email, will also be available.

A. Create a New Table

1. As System Administrator, navigate to System Definition > Tables & Columns.

The Tables & Columns module provides a clean interface for browsing a list of
existing tables in the database. Selecting a table name will display its contents:
columns (fields) and their attributes.

This interface provides an easy way to navigate between multiple tables, without
having to open individual records to see and compare table content. Please note
that all data displayed on this page is read only — it may not be edited, unless you
select a table and click the Edit Table button.

2. Navigate to System Definition > Tables to create a new table.
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3. From the list header, click the New button:

= Tables Goto Name v

4. Fill out the top of the Table form with the following changes:

Label: Infinity

Name: u_cmdb_ci_hardware_infinity (auto fills with u_infinity)
Extends table: Hardware [cmdb_ci_hardware]

New menu name: Infinity (auto fills)

NOTE: The Name field automatically populates with u_infinity. The table name can be
changed, as long as it starts with the u_ prefix indicating it is a custom table. It is best
practice to rename the table to indicate it is a custom CMDB Cl table.

5. Submit.

B. Add Fields to the Infinity Form

1. Use the Application Navigator filter field to navigate to Infinity > Infinities:

(Y Infinity

*

Infinity
Infinities

NOTE: During the creation of the Infinity table, the Create module checkbox was
selected. As a result, this automatically created the new module Infinities which is a
pluralized form of the table name, Infinity.

2. An empty List (No records to display) is displayed with default fields.

NOTE: In a future lab, you modify the Infinities list layout before importing device
records from spreadsheets.

3. Click New to open a form displaying default fields.
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Open the Form Context Menu, select Configure > Form Layout.

Remove the Assigned to, Category and Fault count fields, keeping Name, Asset tag,
Installed, and Status in the Selected list.

Add the Owned by and Support group fields to the Selected list from the Available
list.

Using dot-walking, add Owned by.Email to the Selected list:
a) From the Available list, locate and select Owned by

b) Click the Expand selected reference field icon

Available

Monitor
Most recent discovery

Operational status
Order received
Ordered

Owned by [+]
PO number

c) From the Available list, scroll down and select Email

d) Select Add

Available ° o Selected
Employee number Asset tag
<

Failed login attempts Installed
First name Statig

You should now see Owned by.Email under the Selected list:

Selected

Name
Asset tag
Installed
Status
Owned by

Support group
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NOTE: The Owned by.Email field’s value represents the email of the device’s owner, and
will automatically populate when a value is entered into the Owned by field, as long as
the user record includes an email address..

8. Next, in the Create new field section, enter:

Name: Device Number
Type: String (autofills)
Field length: Small (40) (autofills)

9. Click Add.

10. Add two additional fields:

Name Type Field Length/Reference
Device Version String Small (40)
Device Notes Journal

11. After adding the new fields, rearrange the fields under the Selected list to look like
this:

Selected

Device Number
Name

Asset tag
Device Version
Support group
Installed

Status

Owned by
Owned by.Email
Device Notes

12. Click the Save button.

13. Close the Saving Form Section window.
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14. The Infinity New record form displays:

4 E :::izmra y E ooo  Submit
Device Number
Name
Asset tag
Device Version
Support group Q,
Installed G
Status Installed v
Owned by Q,
Email =
Device Notes

C. Update the Infinity Application Menu

The new Infinity application menu and its modules will be used to create new Infinity device

records from the form you have just designed, as well as display a list of all devices.

1.

In the Application Navigator filter field, type Infinity.

Hover your curser over Infinity and click the Edit Application icon (pencil):

Infinity

Infinities

This brings up the Application Menu record for Infinity.

NOTE: You could alternately access this record by navigating to System Definition >
Application Menus and searching for Infinity in the list.

Update the Title to Infinity Inventory.

Save the record.

Database Administration
© 2018 ServiceNow, Inc. All Rights Reserved

136




6.

10.

11.

From the Modules section, open the Infinities record:

= | Modules m Goto Order "

g
0

Application menu = Infinity Inventory

e O =Title  =Table = Active

b

@ Infinity [u_cmdb_ci_hardware_infinity] true

Update the record as follows:

Title: All Devices
Order: 200

Click Update.

Next, click New from the Modules section:

= Modules“ Goto Order v

<
0

Application menu = Infinity Inventory

03 O = Title = Table = Active

b Y

(i)  AllDevices Infinity [u_cmdb_ci_infinity]  true

Fill out the form:

Title: Add Inventory
Order: 100

Click the Link Type* tab and fill out the fields as shown:

Link type: New Record
Table: Infinity [u_cmdb_ci_hardware_infinity]

NOTE: The Table field appears to be read-only (indicated by gray), but clicking on the
table name will open the drop-down menu.
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12. Your screen should look similar to this:

< — Module
= New record

Title Add Inventory

Applicationmenu  Infinity Inventory Q@
Order 100
Hint
Display name

Visibility | Link Type
Select the type of link for the module or select separator to create a horizontal line.

Link type New Record

4k

Table Infinity [u_cmdb_ci_hardware_infinity] v

View name

13. Click Submit.

Knowledge Check

Before creating any table in ServiceNow, the question to always start with is: should the table
be created from scratch or by extending an existing table?

Why do you think the Configuration Item table extended instead of creating a new table?

LAB VERIFICATION

New Table - Application Menu and Modules

Infinity Inventory

Add Inventory
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Add Inventory Module (Form View)

< = ey & = oo submit
Device Number
Name
Asset tag
Device Version
Support group Q,
Installed
Status Installed H
Owned by Q
Email =
Device Notes

Cloud Dimensions now has its first custom table, thanks to you!

Database Administration
© 2018 ServiceNow, Inc. All Rights Reserved

139




Module 3 - 3.2 Data Security servicenow

Objectives

* User Permissions Summary

* Access Control Rules
— What is an Access Control?
~ Access Control List (ACL)
— Rule Types
- Requirements
~ Using the Wildcard
— Evaluation Workflows

Database Administration
© 2018 ServiceNow, Inc. All Rights Reserved 140




Access Overview servicenow

User
Authentication User Interface Database
/ Login )
— Users ‘ Applications and 1 __' Tables
" Modules (Records and Fields)
— Groups s
] —‘ Governed by Roles Governed by
) — Global System
—] Roles L Properties )
| | Governed by
Access Control Rules

ServiceNow provides several levels of security before an end user has the capability to perform
CRUD (Create, Read, Update, Delete) operations on a table:

* User Authentication/Login: Users, Groups, and Roles

* Application and Modules Access: Controlled by roles configured at the Application and
Module level

* Database Access: Access to tables and their records and fields are controlled via globally
defined system properties as well as table and field level Access Controls. If a row level rule
and a field level rule are in conflict, both rules must be true before an operation is allowed.

There are three security modules typically used by the System Administrator:
* System Properties > Security
* System Security > Access Control (ACL)
* System Security > High Security Settings
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What is an Access Control? Servicenuw

Access CO nt rOI T - These rules restrict ServiceNow-specific

An Access Control is a security rule defined to and CRULY cherations

restrict the permissions of a user from viewing

and interacting with data ‘ reate

It is executed when attempting to access any

ServiceNow table and may be set at the: R

ead

row-level and/or  column-level

i

( ] U pdate (write)

(access to (access to D elete

the record) the field)

Most security settings are implemented using Access Controls.

In addition to restricting CRUD operations, Access Control rules can restrict ServiceNow-specific
operations on tables and fields.

ServiceNow operation examples include:
* execute: user cannot execute scripts on a record or Ul page

* Edit_ci_relations: user cannot define relationships between Configuration Item [cmdb_ci]
tables

* Save_as_template: controls the field that should be saved when a template is created
* Report_on: user cannot create reports on the object

* Personalize_choices: user cannot right-click a choice list field and select Configure Choices
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Access Control List (ACL)

servicenuw

The Access Control List (ACL) contains all of an instance’s Access Control rules

Users with the appropriate permissions can modify rules and their definitions

Acvaan Cortrd (ACL )

iped_change

Silatinele

fopd

a0s

uograde Chent

Supgrade oty

o Oper atier

il

el

g
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e

u_pae

ulaege

o Segr

[

ecard

=]

| Usdated by

aaaaa

! mudEm b bp

1680 0% 13500

M16-11-14 011499

01691-19 12510

S iR RL VS )

All users with the admin role have special access to all platform features, functions, and data
because admins can override Access Controls and pass all role checks so grant the admin privilege
carefully! With this said, in order for a user to create or update Access Control roles, they must have

the security_admin role.
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Access Control Definition: Rule Types

servicenow

table.None

table.field

table.*

Name »

incident [incident] v = Mone - v

Incident [incident| v Caller v

Name »

Incidert [incident v - v

No specific field selected - this
rule applies to the whole table
including its records

This rule applies to only one field
on a record and in this case, the
Caller field on an incident record

Wildcard — this rule applies to
every field on a record without a
table.field rule

Each Access Control specifies the table or type of record (including fields), operation being secured,
and unique object identifier. Access Control rules are defined for and applied to a specific table so
that the rule is within the context of the table and the type of data stored.
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Access Control Definition: Requirements

Each Access Control rule specifies
* The object being secured

* The permissions required to
access the object

Access Control rules require users
to pass a set of requirements in
order to gain access to particular
data:

1. Roles

2. Conditional Expressions

3. Scripts

servicenuw
@ Requires role
3 = Role
x
@ Condition nong
Add Filter Condibon Add "OR" Clause
Actrew v n trae
@ Script E 3= 4 w A » 9O H w &
var transaction = GlideTramsaction.get();
((transaction.getRequestParameter (“sysparn_record_target™) ==
“sysapproval_approver™) 66 hasAccessToDecumenticurrent)) || (typeof
g_approval_form_request != “undefined™ &b g_spproval_fors_request ==
true);

Access Control Rules can be defined with the following three components, which relate to the set of
requirements a user must pass in order to gain access to particular data:

1. Roles: If you put one or more roles there, then only users with at least one of those roles
are allowed to perform the requested operation.

2. Conditional Expressions: You will see a condition widget where you can add conditional
expressions to your ACL. For example, you might have a conditional expression that says
“Active = true" if you want this rule to evaluate to true only for database records that

meet a specific condition.

3. Scripts: If the Advanced checkbox is selected, you then have an opportunity to apply
security based on user defined script. Your script has access to the current record and
has responsibility for setting a global "answer" variable to allow, or deny, access to the
requested resource/operation. A script is evaluated in addition to other conditions you

set on the rule.

All must evaluate to true.
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Access Control Examples servicenow

Rule Example 1 Rule Example 2
Rule Name: incident Rule Name: incident
Rule Operation: read Rule Operation: read
Definition: Definition:

Script Requires role

o current.opened_by == gs.getUserID() ||

current.caller_id == gs.getUserID() || o

current.watch_list.index0f(gs.getUserID()) > ~1; 193 = Role
gzaee X G) il
Description: ™
You can read an incident if you opened it, are Description:

the caller of record, or are on the watch list
You can read an incident if you have the itil role

In the first rule example, the access control’s definition includes only a script requirement which
roughly translates to: is the user that opened this record the same user attempting to access it, or is
the user that is listed as the caller the same user attempting to access it, or is the user that is listed
on the record’s watch list the same user attempting to access it?

If the user meets any single one of these criteria, they are able to read (or view) the incident record.
If they do not meet a single one of these criteria, then they are not able to read the incident record.

To further illustrate this, think of the following scenario: Joe Employee called in to the Service Desk
to report an issue. The support agent receiving Joe’s call created an incident and added Joe’s name
to the Caller field. Later, when Joe attempts to view the record — possibly to see any progress made
with it — he will have no problem doing so, because of this rule.

Now, while still thinking of this scenario, the agent that opened the incident record would
technically be able to view Joe’s record because of that same rule. However, what happens if they
reassign the incident to another fulfiller user?

Luckily, the second rule example would allow that other fulfiller the chance to view the record. This
rule states that in order to read an incident, you have to have the itil role.

In the case of these two rules, because they are applied on the same object level (reading an
incident record), passing either rule will grant access to the user.
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Using the Wildcard servicenuw

The selection of the change_request.None read Access Control for itil_admin and itil roles
wildcard (*) symbol change_request.* read Access Control for itil_admin role
from the Named rop change_request.type read Access Control for itil role

= Parred tan date

L]
7
X

-

down list on the

Access Control form IR 1 T P oar—
mean§ that th.e rule in role is able
question applies to all to see:

WIH L5507 N

CHGON000SS Upgrase OWA-SD-01 13 MS Windows. Server 2016 2018.05.08 07:30:00

RGO worease d9b_bloca_bufers from 5000 1o 7300 20180545 05 3000

fields on the selected

= Type = Suee = Parred i dase

table except for those
with explicit rule itil role is
able to see:

One of the real benefits of using the wildcard type of rule is to reduce the amount of rules required
to control access, which also results in less required maintenance.

For example, taking the same series of rules above — it could accomplish the same end results
without a wildcard rule. However, in order to do so, it would require six separate rules. That is a
significant more amount of rules to manage, should changes be needed in the future.
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Start User requests access 1o
- a reterd obpet
Access Control Evaluation 1
Find ACL rules
matching clyect
One of the most powerful items behind 1
Contextual Security is that it can apply - 2 ’ 4 s ¢
1 H i i ACL name ACL name
elt‘her tq a particular field or an entire row, —4 = =l = k=l k=
using this process: wate? e e w2 SO0 "~
Find first matching FIELD ACL Ruie
fossnd
1 2 3
' a.
e = ACL name ACL name ACL narme Pase - -~
matcte matchey mutches AL
Wk hes Firerd table ! parent table " L3
r.u..:qm Ful Find first matching TABLE ACL Rule
l—’“m“ he Match l
matches found Fal
Y [ ALL Pe —
End lbv!:l:;w! |(-y::u- . l 3
Geant Al Grart uber Bccais 10 the
record object
- .

Record ACL rules are processed in order of most specific to most general: Match the object against
field ACL rules. Match the object against table ACL rules.

This processing order ensures that users gain access to more specific objects before gaining access
to less specific ones. A user must pass both field and table ACL rules in order to access a record
object. If a user fails a field ACL rule but passes a table ACL rule, the user is denied access to the
field described by the field ACL rule. If a user fails a table ACL rule, the user is denied access to all
fields in the table even if the user previously passed a field ACL rule.

In most cases there is not an individual field ACL rule for every field in the table the users is trying to
access. If no field ACL rule matches the record object, the user must pass the table ACL rule. Since
the base platform includes wildcard table ACL rules that match every table, the user must always
pass at least one table ACL rule. The base platform provides additional table ACL rules to control
access to specific tables.

Table ACL rules are processed in the following order: Match the table name. For example, incident.
Match the parent table name. For example, task. Match any table name (wildcard). For example, *.
Just like with field ACL rules, the platform grants the user access to the record object secured by the
ACL rule and stops searching for matching ACL rules the first time a user passes a table ACL rule's
permissions. A user who passes the table ACL rule for Incident has access to all fields in the Incident
table. A user who passes the table ACL rule for task has access to all fields in the Task table as well
as the fields in extended tables. A user who passes the table ACL rule for any table has access to all
fields in all tables.
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Section Summary

* User Permissions Summary
* What is an Access Control?

* Access Control List (ACL)
* Rule Types
* Rule Definition Criteria Pages 150 - 156

* Evaluation Workflows

Lab 3.2
Data Security

®

15 = 20 minutes

Lab 3.2 — Data Security:

* Update arole
* Provide application menu and module access for a specified role

* Create an Access Control rule to grant data permission
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Data Security

LAB

3.2

B e () 15-20 minutes

Lab Goal

Lab Dependency: Requires the completion of Lab 3.1.

This lab will show you how to do the following:

Update a role
Provide application menu and module access for a specified role
Create an Access Control rule to grant data permissions

After much deliberation, Cloud Dimensions management have decided to limit access to Infinity
device data to only those teams actively supporting the product.

The result is a requirement to restrict access to the Infinity Inventory application menu and
modules, as well as controlling which fields the users can update.

As the system administrator, you will act upon the requirements provided by Cloud Dimensions
management to successfully secure Infinity device data.

A. Modify the Infinity Table Role

1.

System Security > Users and Groups > Roles.

Search for and open the u_infinity_user role record.

NOTE: This role was automatically created when the Infinity table was added to the
database, along with the creation of four table Access Control rules. All of these are
optional during the table creation process and can be avoided through settings.

Change the name to u_infinity_support.
Type into the Description field: Support role for the Infinity.

From the Form Context Menu, select Insert.
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NOTE: Two infinity roles now exist which will allow for more granular access provisioning
in the future:

= Name A&

u_infinity support

y_infinity user

B. Confirm and Modify Access to the Infinity Inventory Application

1. System Definition > Application Menus.

2. Use any method to find and open the Infinity Inventory application menu.

3. Notice the value next to the Roles field, u_infinity_user:

Title

Roles

Infinity Inventory

y u_infinity_user I

4. Click the Edit User Roles icon (pencil) next to the Roles field:

Title

Infinity Inventory

Roles

P I u_infinity_user

5. Add the u_infinity_support role from Available to Selected.

6. Click the Done button.

7. Update the Application Menu record.

Update the Infinity Support Group

1. User Administration > Groups.

2. Locate and open the Service Desk group record.
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Select the Roles tab, if needed, then click Edit...
Add the u_infinity_support role to the Roles List.
Save.

The Service Desk Roles list should look like this:

= Roles ﬂ Goto | Created v

=
\

sroup = Service Desk
A

fo Q = Role

D il
G) filter group
(i u_infinity support

template editor_group

®

Test the Visibility Settings

1.

2.

Impersonate Rita Center.

Confirm Rita Center has been denied access to the Infinity Inventory application
and to the modules it contains.

Impersonate Kevin Edd.

Expand the Infinity Inventory application menu to notice only one module displays:

Infinity Inventory

A module is missing from the application menu. Which one?

Click on the Add Inventory module.

Although Kevin Edd has inherited the u_infinity_support role because he is a
member of the Infinity Support group, which has access to the Infinity Inventory
Application, the role does not currently have the rights for creating new data.
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As a result, the Infinity New record page is blank when Kevin attempts to access it.

Access Control rules can be created to allow users with a certain role access to work
with a table’s data, but first let us update Rita and Kevin’s group permissions so
Service Desk and Infinity Customer Support group members are granted access to
the application and all of its modules.

Update Roles and Groups

1.

2.

10.

11.

12.

As System Administrator, User Administration > Roles.
Locate and open the u_infinity_support record.

Under the Contains Roles section, click Edit...

Add u_infinity_user to the Contains Roles List.

Click Save.

NOTE: You have added the u_infinity_user role and its permissions under the
u_infinity_support role. This means all users with the u_infinity_support role now
automatically inherit the permissions found with u_infinity_user.

User Administration > Groups.
Open Infinity Customer Support.
Under Roles, click Edit...

Add the u_infinity_user role.
Save.

Impersonate Rita Center.

Confirm the Infinity Inventory application menu is accessible and its two modules
display.

NOTE: Both Rita Center and Kevin Edd can now access both of the Infinity Inventory
modules. Additionally, they can now create new records and update existing ones.
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C. Create an Access Control Rule

Now that the group permissions have been set and only the right groups of users can access the
application, create an Access Control rule that allows only the System Administrator to update
the Asset tag field on the Infinity record, and no other role.

1. Impersonate the System Administrator.
2. Open the User menu.

3. Next, choose Elevate Roles:

@ System Administrator ~

Profile
Impersonate User
I Elevate Roles I

Logout

4. Select the checkbox next to security_admin:

security_admin

5. Click OK.

6. Notice the page refreshes and there is now an unlocked pad icon next to your name
on the User menu:

@ System Administrator & ~

7. System Security > Access Control (ACL).
8. Filter the list of rules to find the four u_cmdb_ci_hardware_infinity rules.

9. Open the rule with the write operation:

= Name A = Operation

u_cmdb ci_hardware infinity write
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10. From the Name field, select the drop down next to the drop down with the value
Infinity [u_cmdb_ci_hardware_infinity]:

Name p Infinity [u_cmdb_ci_hardware_infinity] w

11. From the drop down, select Asset tag.

12. Open the Form Context Menu and select Insert and Stay.

13. From the Verify Security Rules window, click Continue:

Verify Security Rules for "u_cmdb_ci_hardware_infinity.asset_tag" X
Write
Row level u_cmdb_ci_hardware_infinity
Field level  u_cmdb_ci_hardware_infinity.asset_tag Adding
Show All

14. Scroll down to the Requires role section.
15. Double click on Insert a new row...

16. Type admin and click the save icon to add the role.

Definition
Requires role
@ = Role
X | admin
17. Update.

NOTE: The u_cmdb_ci_hardware_infinity.asset_tag rule was created and added to the
Access Control List.
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LAB VERIFICATION

Access Control List — Infinity Rules

= Access Controls m Goto | Name v

¥  All>Name contains infinity
{03 Q. = Name A = Operation
(i) ucmdb d hardware infinity create
\l, u cmdb ¢i hardware infinity delete
) u cmdb ci hardware infinity read
|_’\i"5 u cmdb ci hardware infinity write
() u cmdb ci hardware infinity.asset tag write

Test New Security Settings

1. As Rita Center, Infinity Inventory > Add Inventory:

Tt

| = Infinity j eoe | Submit

w— New record

Device Number
Name
Asset tag

Device Version

NOTE: All fields but Asset tag and Email should be editable. These same fields would
also be uneditable for existing records, for all users in Service Desk or Infinity Customer
Support groups. As system administrator, all fields on the form are editable.

With this lab, application and module access was adjusted, and an Access Control rule was
created to limit permissions to table data.

This is not an easy topic nor lab, so well done completing it!
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Module 3 - 3.3 Import Sets servicenuw

Objectives
* What are Import Sets?
* Import Set Table
* Transform Maps

* Coalesce Fields
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servicenow

Import Sets — A\ — o .

An Import Set is a tool used to import
data from various data sources, and
map that data into ServiceNow tables

L
- HR Implementers may use Import Sets to
copy a large number of HR Stories into the

Development instance during
implementation

- Security does not approve an integration
with a data source vital to IT operations
and use Import Sets to periodically update
a significant number of records

Import Sets provide a mechanism to pull data into ServiceNow. Import Sets store data in Import Set
tables. Any user logged in with the admin or import_admin role can manage all aspects of Import
Sets.

Data Sources are records in ServiceNow that contain information regarding an Import Set data
source. You can import a file from a local source (i.e. XML, CSV, Excel) or from a network server by
providing a path and authentication information. A data source can come from a file, an LDAP
connection, or a JDBC connection.

The Import Set Table acts as a staging area for records imported from a data source.

Transform Maps provide a guide for moving data from Import Set tables to “Target” tables; field
mapping provides direct field-to-field data moves.

A Transform Map is a set of field maps that determine the relationships between fields in an Import
Set and fields in an existing ServiceNow table (such as Incidents or Users). Once defined, existing
Transform Maps can be reused for mapping data from an Import Set to a ServiceNow table. The
Transform Map Module enables an administrator to define destinations for imported data on any
ServiceNow tables. Transform mapping can be as simple as dragging and dropping to specify linking
between source fields on an Import Set table and destination fields on any ServiceNow table.

The Target Table is an existing table in where the data will be placed, post-transformation.
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Import Set Table servicenuw

Data Sources Import Set Table

| — IMPORT SET Importing Best Practices

TABLE
ﬂ Plan time before an import to verify your data:
* Remove obsolete data
* Inaccurate data takes time to fix after a data import

The import set table is a staging area for records
imported from a data source

Fields on these tables are generated automatically
based on imported data

Understand what data you are bringing in and where
it should be placed

Before importing any data, it is important to understand what data you are bringing in and where
that data should go.

You should verify the data before you import it since bad data will complicate things later in the
import and transform processes. Extra time spent planning and examining data before import will
save time and potential problems later.

Data should not be imported in extremely large chunks. Creating an extremely large Import Set can
cause extensive delays. The imported file label is used to determine the name for the Import Set
table that data will be loaded into.

NOTE: It is also possible to choose an existing Import Set table to use for loading data from the
same source, or data that has the same field/column designations. When an existing Import Set
table is chosen, the table fields are added when the incoming source of data contains
fields/columns that do not exist.
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Transform Maps

servicenuw

A transform map is a set of field maps that define the relationships between
fields in an import set table and fields on a target table

Transform Map

( Table Fields Table Fields \
Username First name
[username] T [first_name]
- -\ gy -

F‘irst Name = e Last name User Table

[first_name]) _ -t — [last_name] (Target)
- ~G

Surname e User ID

[last_name] [user_name]

Transform mapping is flexible; the specification can be as simple as having the application auto-
match field names from source and destination, or mapping can use advanced logic and leverage
the full power of the ServiceNow scripting environment. A single Import Set field can also be
mapped to multiple fields on a Target table. Any table is a potential destination for transformation
of an Import Set, and any field within a table can serve as a potential destination for transformation
from a field within an Import Set.

Select the table where you want transformed data to be placed. You can select only tables within
the currently selected application scope, the global scope, or tables that grant write access to other
applications. Name and Source table are set based on the label which was assigned to the Import
Set. It is necessary to assign a target table into which the data can be transferred.

Automatic Mapping Utility: The simplest mapping method is where all of the field names of the
Import Set match the name of the fields on the Target table where the data will be transformed. In
this case, simply click Auto Map Matching Fields in the related list in the Table Transform Maps form
and confirm proper matching. If there are any discrepancies in terms of how fields were
automatically matched, these can easily be corrected using the Mapping Assist utility. When all
fields are matched properly, click Transform in the related lists to begin transforming data onto the
destination table.

Mapping Assist Utility: The Mapping Assist utility provides a visually intuitive environment for
specifying mapping between Import Set fields and Target table fields. With the Mapping Assist utility
it is possible to map a single source field (field on an Import Set table) to multiple destination fields
(fields on a Target table).
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Coalesce Fields servicenow

Coalescing a field (or set of fields) means the field will be used as a unique key
during imports

9 &

If a match is found using the If a match is not found using the
coalesce field(s), the existing coalesce field(s), then a new
record will be updated with the record will be inserted into the
information being imported database

There are several possible configurations you can use to coalesce data in Import Sets:

* No coalesce: If no coalesce is defined, all imported rows are treated as new records. No

existing records are updated. If the import is executed again, duplicate records will be
created.

Single-field coalesce: You can coalesce on a single field to update an existing record. If a
target table record exists with the same value in the coalesce field as the staging table record,
the target table record is updated using the Import Set record values.

Multiple-field coalesce: You can coalesce on multiple fields to update an existing record. If a
target table record exists with the same values in all coalesce fields as the staging table
record, the target table record is updated using the staging table record values. All coalesce
field values between the target and staging tables must match to coalesce with multiple
fields.

Conditional coalesce: You can use a script to determine if a staging table row should coalesce
to a target record. Most conditional coalesce scripts are defined in the source script field of a
field map for the sys_id field. To update a target record using the staging table record values,

the script must return the sys_id of the target table record.
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Section Summary

Lab 3.3

What are Import Sets?
Import Sets

Import Set Table
Transform Maps r—7 @‘
Coalesce Fields E

Pages 163 -171 20 - 25 minutes

Lab 3.3 — Import Sets:

.

Modify a list layout as preparation

-

Create an Import Set Table and Transform Map

Transform multiple imports

Clean up import data
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LAB
Import Sets 3.3

B . (4 20-25 minutes

Lab Goal

Lab Dependency: Requires the completion of Lab 3.1.

This lab will show you how to do the following:
* Modify a list layout as preparation
* Create an Import Set Table and Transform Map
* Transform multiple imports
* Clean up import data

In this lab, you will use Import Sets to load data that has been collected outside of ServiceNow
into the Infinity table.

The data will represent asset registration by Cloud Dimensions employees and partners, and
include information about the user and their registered Infinity device.

This lab has three parts:
1. Aninitial load, with all of the foundational work required.
2. Anincremental load.
3. Adata cleanup.

In the initial load, you will:

* Gather Excel data files

* Organize a list layout for the Infinity table

* Create a new Import Set by importing data from an Excel spreadsheet to a staging
table, then validate the data

* Create a Transform Map based on the staging table: use automapping and mapping
assist to establish the mapping between the source and the target tables

* Complete the transform and verify the resulting data

In the incremental load, you will:
* Upload a second Excel spreadsheet, reusing the staging table and Transform Map
* Identify a coalesce (key) field to ensure that existing records are updated from the
new imported data and not duplicated

In the cleanup, you will clean up the Import Set Table’s data.
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A. Part 1: Initial Load

Gather Excel (.xIsx) Data for Lab

Before you begin, download the two Infinity MS Excel Knowledge files: infinity-data.xlsx and
infinity-updates.xlsx, and save them to your desktop.

Open both the infinity-data.xlsx and infinity-updates.xlsx files to review their contents;
columns, fields, and data types.

Modify the Infinity All Devices List Layout
1. Asthe System Administrator, navigate to Infinity Inventory > All Devices.

2. Open the Column Context Menu from any field, then select Configure > List Layout:

) O E""‘“ = sanufacturer

n
N

Sort (zto a)

Group By Name

Actions on sels Bar Chart

Pie Chart

Import List Calculations

Export > ListControl

3. Using the slushbucket, organize the Selected field list to include the following fields
in the order seen here:

Selected

Device Number
Device Version
Name

Owned by
Location
Status

Support group
Updated

4. Click Save.
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5. Your All Devices list header should look like this:

=  Infinities n Goto Name v

= Device Number = Device Version = Name & = Owned by = Location = Status = Support group

= Updated

Create a New Import Set

1. System Import Sets > Load Data.

NOTE: The following steps (process) can be completed by any user with the role
import_admin or import_set_loader and import_transformer.

2. Populate the Import Set form:

Import set table: Create table (auto selected)

Label: Infinity Imports

Name: u_infinity_imports (automatically populates)
Source of the import: File (auto selected)

File: Choose file, then select infinity-data.xlsx

3. Click Submit.

4. Review the Progress screen, you should see 7 inserts:

Progress
Name ImportProcessor
State Complete
Completion code Success

Message Processed: 7, inserts 7, updates 0, errors 0, empty and ignored 0, ignored errors 0 (0:00:00.940)

Validate Data in Import Set

1. To verify the data in the new Import Set, in the Next Steps... section of the Progress

screen, click the Loaded data link:

Next steps...

Importsets Go tothe import sets

Loaded data I Go to the newly imported table: u_infinity_imports

Create transformmap A transform map links the imported data and fields

Importlog View the import log
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2. Confirm the seven Infinity Imports records loaded correctly:

= Infinity Imports m Goto Set -

T

() Q, = Row =Setvy = State
(i) 6 ISET0010001 Pending
@ 4 |SET0010001 Pending
) 2 [SET0010001 Pending
@ 0 ISET0010001 Pending
) 1 ISET0010001 Pending
@ 5 ISET0010001 Pending
O) 3 ISET0010001 Pending

NOTE: You may notice a different order.

Create Transform Map
1. System Import Sets > Create Transform Map.

2. Fill out the form as shown:

Name: Infinity Assets
Source table: Infinity Imports [u_infinity_imports]
Target table: Infinity [u_cmdb_ci_hardware_infinity]

3. Save.

4. Scroll to Related Links, then click Auto Map Matching Fields.

NOTE: A verification message displays at the top of your form.
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5. Verify that four fields auto mapped: Name, Device Number, Device Version, and

Support Group:
Field Maps (4)  Transform Scripts
=  Field Maps m 44 4 1 tw4ofs P PP

£o3 = Source field = Target field = Coalesce
(i) wdevice version u_device_version false
(i) ALsSUppOTt group support_group false
(] u_name name false
() u device number u_device_number false

NOTE: Your field order may be different.

6. In the Related Links list, click Mapping Assist.

7. From the Source: Infinity Imports staging table, move Device Owner and Owner
Location into the Field Map.

8. From the Target: Infinity table, move the Owned by, and Location into the Field

Map:
Field Map

Device Version Device Version
Support Group Support group
Name Name
Device Number Device Number
Device Owner Owned by
Owner Location Location

9. Click the Save button, then verify that there are now six mapped fields: Name,
Device Number, Device Version, Support Group, Owned by, and Location.

Run the Transform
1. In Related Links, click Transform.

2. Verify the Infinity Assets — u_cmdb_ci_hardware_infinity map is selected.

3. Click the Transform button.
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4.

The Progress screen displays the transformation confirmation messages:

Progress
Name Transforming: ISET0010001
State Complete
Completion code Success

Message Transformation complete

Verify Infinity Inventory Import

1.

2.

Infinity Inventory > All Devices.

Your screen should show seven total records.

B. Part 2: Incremental Load

Import Additional Data using an Existing Import Set Table

You will now work with the second spreadsheet you downloaded at the start of this lab:
infinity-updates.xlIsx. For the incremental load, you will use the same Import Set Table (Infinity
Imports) and Transform Map as this spreadsheet is in the same format as the first.

Upload the Data

1.

2.

3.

System Import Sets > Load Data.
For Import set table, select the Existing table radio button.

Fill out the form as shown:

Import set table: Infinity Imports [u_infinity_imports]
Source of the import: File (auto selected)
File: Choose file, then select infinity-updates.xlsx

Click Submit.
You should see 19 inserts.

The import of the Infinity data to the staging table is complete, but you are not
ready to run the transform yet because you need to add a coalesce. Rather, tell the
system what the key field is to ensure that existing records are updated rather than
adding duplicate records by the imported data.
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Define the Coalesce Field

System Import Sets > Administration > Transform Maps.
Open the Infinity Assets Transform Map.
Scroll to the Field Maps Related List.

Set the device number (u_device_number) field as the coalesce, as it contains a
unique value. If a match is found for this field, the record will be updated instead of
creating a new record.

In the u_device_number row, in the Coalesce column, double-click the word false,
then select true from the list:

Ci y_name name false

(i) uw.device number u_device_number true 2| @
i) udevice owner owned_by false

Click Save (green checkmark) to update the value to true.

NOTE: A system message displays at the top of the form.

Prepare and Run the Transform

1.

2.

3.

4.

Under the Related Lists section, click the Transform link.

In the Selected maps box, verify you are using the correct Transform Map: Infinity
Assets — u_cmdb_ci_hardware_infinity

Click the Transform button.

Verify the transformation complete message.

Verify Infinity Inventory Import Updates

1.

2.

Infinity Inventory > All Devices.

There are 19 total records that show.

Notice that some of the records have an updated time from the initial upload
(infinity-data.xlsx) and some have an updated time from the incremental upload
(infinity-updates.xlsx).
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Also notice that in the infinity-updates.xIsx spreadsheet, in record CDE0100102,
there was no Owner Location information. Compare this to the same record in the
infinity-data.xlsx spreadsheet, which had Owner Location information.

If you had Copy empty fields checked and active in the Transform Map, it would
have removed the location data for this record. Since Copy empty fields was not
active, the data from the original import still remains in the table.

C. Part 3: Clean Up Import Set Tables

1. System Import Sets > Import Set Tables > Cleanup.
2. Add the Infinity Imports [u_infinity_imports] table to the Delete these tables box.
3. The checkbox for Delete related transform maps should be unchecked.

4. The checkbox for Delete data only (preserve table structure) should be selected.

NOTE: This will remove the data collected in the Infinity Imports staging table.

5. Click the Cleanup button —you should see a Cleanup completed verification message
and actions taken displayed in an Import Log.

NOTE: If you wanted to delete the Import Set table and any reference to it, including the
Infinity Assets Transform Map, you would have checked the Delete related transform
maps checkbox.

LAB VERIFICATION

Transform Map

Field Maps (6] = Transform Scripts
- s.e|dmpsm 44 4 1 twEof6 P PP F

= Source field = Target field = Coalesce

y device version u_device_version false

u_support group support_group false
u_device owner owned_by false
u_name name false
u_device number u_device_number true
u_owner location location false
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Imported Infinity Inventory Data

= wioves [ cow reme -

v a

L Q = Device Number = DeviceVersion = Name a = Owned by = Location
@ comione Ao MeganBuke 1121 Migh Soint Sosd, Geesnshor, A
P— = S i SleRssens s
@ cosmiones apoL o WineieReich 3243 Cicero Avenue, Ook Lawn,
© comme e ooy Tt ppgnggy  LSliauhilemAme e
® comonn 001 AT ek SR
@  comionw — m'rem‘ Kevin Edd mw
@  eanmicooss ooz Doy T8 cofd  10338Leewy Fada
(O  cosmioms Tou: Doy T4 winmeRah 3249 Ocer Avenue, Oak Lawn, 8

= Status

Installed

Instalied

Instalied

Instalied

Instalied

= Suppon group

= Updated

20180227
1830:24
2018-02-27
182651
2018-02-2T
18:26:51
2018-02-27
1826:51
2018-02-27
18:3€:51
20180227
183024

2018-02-27
18:26:51

2018-02-27
18:26:51

Congratulations, you have completed the Import Sets lab!
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Module 3 -3.4 CMDB servicenow

Objectives
* What isa CMDB?

What are Configuration Items (Cls)?
Using the CMDB
Relationship Editor

L ]

Dependency View

Implementation Considerations
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The CMDB and Configuration Items servicenow

CMDB

The Configuration Management Database
(CMDB) is a series of tables and fields that
contain all of the Configuration Items (Cls)
controlled by your company, as well as their
attributes and relationships

(0

Access to the CMDB tables and underlying
data requires certain permissions, such as
the following roles:

= asset
» itil
* itil_admin

Configuration Items -]+

Configuration Items can be tangible or intangible
devices or applications in the CMDB such as firewalls,
computers, email services, and business services

Computers Devices on the network
CEENTID
CEENTD
Applications Business services
- | sea I

The Configuration Application provides core functionality for the Configuration Management
Database, including modules for hardware and configuration items. This functionality is part of the
CMDB plugin, which is activated in a base install.

ServiceNow provides a logical model of your company infrastructure by identifying, controlling,

maintaining, and verifying the Cls that exist.

ServiceNow's CMDB, in contrast to a static list, tracks not only the Cls within your platform, but also

the relationships between those items.

Two key CMDB tables are Configuration Item [cmdb_ci] which contains Cl data, and CI Relationship
[emdb_rel_ci] which contains Cl relationship data.

A Configuration Item is any component that needs to be managed in order to deliver Services. Cls
typically include business services and their underlying components, such as business applications

and hardware.
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Configuration Item Form servicenow

Configuration item Email Q & ©0 106 S S e ey | g
= Name  Email '..G.I.- Approval group Togg[e between Cl
Ownedby  Jerrod Bennet al @ Suppert e Health Dashboard view
and Form view
Business critcality 1 - most critkcal H Maraged by
Version SLA Q
Cl Attrlbl.ltes — Used for Praduction : Location Q
Operationasl status Operationasl
Service classification Business Service
Comments
—
Related Rems Related Items toolbar Q + A @
REIBtiOﬂShipS & = | Applicative Flow From - Computers
(0.7 [L2) [ Blackberry ] DCOZ
tO Other C|S ('} (L2) [ Blackberry - | MacBook Pra 17°

Click the reference icon to the right of the Configuration item field to be redirected to the selected
Cls record in ServiceNow.

A Cl record contains all of the relevant attribute data about an item such as name, version,
descriptions, ownership, etc., which are documented in fields on the form.

Toggle between the Cl Health Dashboard view and the Form view using the options in the form title
bar.

The form also contains information about the relationships between Cls. Search for Cls, add new
relationships, view the Cl Map, or adjust the relationship view settings using the options in the
Related Items toolbar.

ServiceNow relationship rules use separate tables to define the relationships between specific Cl
base classes and dependent classes. When you extend a table in the CMDB, you must create a new
relationship rule in Configuration > Suggested Relationships.

You can view relationships between the current Cl and other Cls. An advanced feature is the Related
List in Cl records which displays additional components contained by that particular Cl.
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Service Processes: Using the CMDB servicenuw

Service Processes Benefits

:] m Typically in businesses, a high

percentage of incidents are
caused by failed changes

=~ The ServiceNow Database 3 Benefits of having an accurate
and up-to-date CMDB include:

* Locating failed changes and
associated incidents

Servers

Network Devices - . . .
* Facilitating quick analysis of
Hardware

Extended Table impact, helping reduce or
CMDB Ci Table eliminate downtime

The Configuration Management Database is a repository of information related to all of the
components of an information system. Although repositories similar to CMDBs have been used for
years in IT, the origin of the CMDB stems from the Information Technology Infrastructure Library
(ITIL). CMDBs help monitor and discover what system components are needed for effective and
efficient business processes and IT service management.

All service management processes relate to and involve the CMDB.

For example: someone calls with an issue, and you want to do a root cause analysis, the CMDB gives
you insights to effectively troubleshoot.
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Cl Relationship Editor servicenow
The Cl relationship editor i ®
Suggrised relatonshag types
uses a concept of suggested e s
relationships to help users e oy P e
see reasonable relationships '
between configuration items | ™
Lecation - 1 arythng AND »
Examples:
Operacoral status v 3 aything § AND *
* A database runs on a server =
* Arack provides power for a
Server Configuratson Rerm
O, MName & Manutacturer  Locateon Descrigtion  Class Updated Maten ance sohedie

TANMIE 1BM Lenove

TASSET- 1M Lenevy

15 £ St San Diegn (A

3 Whaekall Court, Lomgon

Computer 0170815 01:4&29

Use the Configuration Item relationship editor to create Cl relationships. Use the Cl relationship
editor to create Cl relationships. It is access from the Related Iltems toolbar on a Configuration ltem

form.

When you use the relationship editor, the Cl from which the editor was launched is designated as
the base Cl. You can then select one or more Cls as a second Cl for the relationship. Depending on
the selected relationship type, the base Cl can become the parent Cl or the child Cl in the new

relationship
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Configuration Items: Dependency View servicenow

Dependency Views graphically display an infrastructure view for a configuration
item and the business services that it is part of and that it supports

Dependency Views indicate the status of configuration items, and allow access to the Cl's
related alerts, incidents, problems, changes, and business services

A B.uaress Sevew ) Detstasew
B oy =
) Datatasew & Ciuster:v
= NV BAC :T'J nycoracie racc...
Spoms e B

The maps generated by Dependency Views are based on D3 and Angular technology, providing a
modern interactive graphical interface to visualize configuration items and their relationships.

Use the Dependency View to view other configuration items “upstream” that feed data into an

email service, for example, and then “downstream,” where you can view all of the other Cls that the
email service is dependent on.

Database Administration
© 2018 ServiceNow, Inc. All Rights Reserved 177




Dependency View: Map Icons servicenow

T4
Q Business Service ¥
= Email o
I
G?
Hover over A l&, View Map
CO"“e‘Ct'O" line Icons: View lists of active View Related Tasks
to view the m———r problem, incident, or View Affected Cls
current — change records for this Cl View Flelated Outages

relationship \ \ Add Relationship
Run Layout From Here

Load More | Rijght-click on
Email Server ¥ Email Server ¥ Email Ser :
IronMail-SD-02 EXCHANGE-NY-02 = IronMail-9 _c' icon to
n view menu
options

In a Dependency View Map, icons and glyphs indicate whether a Cl has an active, pending issue. You
can investigate the tasks that are connected to a Cl to get more details. The map collapses and
expands clusters to make them easier to view.

Understanding the dependencies and other relationships among the Cls will enhance the
operational delivery of incident, change, and problem management processes.
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CMDB: Implementation Considerations servicenow

Questions to consider before implementing a CMDB:

1. How is data entered or imported then managed?
Consider people, process, and technology

2. Where is data stored?
Identify and extend tables accordingly

3. What data is necessary?
Store only the data being used and omit unused data fields

4. When should imports or refreshes of Cl data happen?
Schedule imports to maintain up-to-date data

A core component in IT best practices, the CMDB serves to maximize the alignment of human
capital, technology, and business processes. Setting up a CMDB is a company commitment with
measurable financial benefits once everything is set up. You need to keep data current and plan
refreshes.

Review the base instance tables when implementing the CMDB. A table you want to create may
already exist. Also, prepare and draw out your CMDB schema beforehand so you know what tables
you are going to use, which ones you are going to turn off, and what relationships you are going to
allow.

Methods for populating the CMDB include: Import Sets, integrating with external CMDBs, and
manual input.

Additionally, tools in ServiceNow such as Help the Help Desk and Discovery, a licensed offering, are
efficient methods for gathering configuration item data.
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Section Summary

* What is a CMDB? - Lg;g:

* What are Configuration Items?

« Using the CMDB @

* Relationship Editor

* Dependency View Pages 181 - 186 10 - 15 minutes

Implementation Considerations

Lab 3.4 - CMDB:

¢ (Create a new Cl class in the CMDB

* Define Cl relationships
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LAB

CMDB 3.4

B e (4 10-15 minutes

Lab Goal

Lab Dependency: Requires the completion of Lab 3.1.

This lab will show you how to do the following:
* Create a new Cl class in the CMDB
* Define Cl relationships

All Infinity devices rely upon a media server, to process and stream data, which will require
tracking in the CMDB.

The media server can be categorized under the existing Cl Server Class.

With both the Infinity and media server being tracked in the CMDB, a relationship between the
two Cl Classes will be established — this relationship could be used by Cloud Dimensions to
potentially identify an impact of a change mangement request or outage.

Explore the Cl Class Manager

To begin, explore the Cl Class Manager interface. The Cl Class Manager displays the entire Cl
Class hierarchy in a tree-view format, consolidating class definitions into a central location. It
enables an easier method for viewing, modifying, or extending Cl Classes.

A Cl Class represents a type of Configuration Item or essentially a table collecting certain data,
such as Applications, Computers, Printers, Servers, etc.

In the last lab, a new Cl Class was defined for the Infinity — categorizing it as a Hardware Cl
because of the cmdb_ci_hardware table extension.

1. Impersonate Darrel Tork.

NOTE: This user is the Configuration Manager of Cloud Dimensions. They were provided
the itil role, in order to access the Cl Class Manager. If your company does not have a
Configuration Manager, this responsibility could fall onto the system administrator.
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2. Navigate to Configuration > Cl Class Manager.

3. Select the Heiarchy button:

Cl Class Manager

e Hierarchy

Configuration

Cl Class Manager

4. From the Cl Classes menu, scroll down to locate and expand the Hardware section,
to find the Infinity class:

Cl Class Manager

Cl Classes X
Q,
B %

» Fibre Channel Port

Group

I ¥ Hardware (917)

Cisco UCS Chassis

Cisco UCS Equipment
» Computer (852)

Infinity (19)

Mass Storage Device (3)

P Network Gear (9)

NOTE: This confirms that the Infinity table and its consequential data records are tracked
in the CMDB, even though they are accessed from their own application menu and
respective modules.

B. Add a New Infinity Device to the CMDB

Unlike existing Cl Classes, the ClI Relationships section is not visible on the new Infinity Cl Class.
The form needs to be configured to display this section

1. Infinity > Add Inventory.

2. From the Form Context Menu select Configure > Form Layout.
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3. Scroll down the list of Available fields to locate Cl Relations:

Available

Vendor [+]
Warranty expiration
- begin_split -|

- split -
-end_split-|

* Annotation

* Chart

Cl Relations

CMDB Baseline Diff

NOTE: This field displays after the alphabetically sorted list of available fields, as it is a
formatter rather than a standard field. It will not display on the form layout until the
record has been saved.

4. Add the Cl Relations field to the bottom of the Selected list.
5. Click the Save button.
6. Fill out the Infinity New Record form as shown:

Device Number: CDE0100100

Name: Infinity Beta Prototype

Device Version: BPO1

Support Group: Service Desk

Installed: [today’s current date and time]
Owned by: Darrel Tork

Email: darrel.tork@cloudd.com (auto-fills)

7. Submit.

C. Create a New Suggested Cl Relationship

Switching back to system administrator, you will create a new suggested Cl relationship
between Infinity and the Infinity Media Server, using Darrel’s new incident.

The Infinity Media Server is responsible for sending content to Infinity devices.

With a Cl relationship defined, tools like the Cl dependency view can be used by Infinity Support
agents to identify the level of impact when issues occur.

1. Impersonate System Administrator.

2. Configuration > Relationships > Suggested Relationships.
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3. Click New.

4. Fill out the form as shown:

Base class: Infinity
Relationship: Receives data from (parent)
Dependent class: Server

5. Submit.

6. Configuration > Servers > All.
7. New.

8. Name: Infinity Media Server.

9. Save.

10. Scroll down to the Related Items section, then click the Add Cl relationship icon:

Related Items Q, + | & &

11. In the Suggested relationship types field, select * Sends data to (Child)...

< Relationship Editor - Infinity Media Server{Server) Cancel ﬂ

v | Use suggested relationships @

Suggested relationship types

* Powered by (Child)... Hide Cl relationships

* Receives data from (Parent)... Hide user relationships
* Runs (Child)...
* Sends data to (Child)... Hide group relationships
* Used by (Child)...

Applicative Flow From (Child)...
S T P R < . A | e —

12. From the Configuration Items section, use the Updated field to sort the records by
last updated.

13. Use the checkbox to select the Infinity Beta Prototype record:

Configuration Items

."\.l

&2
e

v

O\ Name Manufacturer Location Description Class Updated ¥
Infinity Beta Prototype Infinity 2018-02-28 09:24:08

Database Administration
© 2018 ServiceNow, Inc. All Rights Reserved 184




NOTE: While only the Sends data to (Child) relationship was created, suggested
relationships also accounts for the converse relationship, Receives data from (Parent).

14. Scroll down to the Relationships section and add Infinity Media Server by selecting
the Create new relationships icon (+):

Relationships @ ®

Q Type Parent Child

~

Receives data from::Sends data to Infinity Beta Prototype  Infinity Media Server

15. Click the Save and Exit button.

16. A Save Confirmation pop-up message may display, click OK:

Save Confirmation

This will change data in the CMDB, do you want to
continue?

LAB VERIFICATION

New Infinity Media Server Cl and Relationships

1. Infinity Inventory > All Devices.
2. Locate and open the Infinity Beta Prototype record; CDE0100100.

3. Verify the Related Items section looks like this:

Related Items

g Receives data from - Servers
(@ & ©[L1] Infinity Media Server
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4. Open the Dependency View by clicking the Show dependency views icon from the
Related Items toolbar:

Related Items O\ + S

Receives data from - Servers
@ &7 [L1] Infinity Media Server

5. The Infinity Testing Device Dependency View displays in a new browser tab/window:

@ Infinity ¥
Infinity Beta Prototype

Server ¥
Infinity Media Server

NOTE: This displays an example relationship between the Infinity device and Infinity
Media Server Cl Classes.

That concludes the CMDB lab. Excellent work so far!
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Module 3 Recap servicenuw
Database Administration

Rafareace Flskds —— Table Petationshgs R Tabie Melatiorahgn | atended Taties ¢
e e
N*—*--_I ,.”. o Taties Lam be reieted e each ohet o waTEL wary ;r"m P G i
e g f— P e ] [ = ]
e slurarce ok £on spss 5 . Gt w— e ey | m——] N L tatben — — ,-—l! |
oy bum b mating @ le [ i i P, " "I s h b
ivleirnr remered g 02 F e M ot g e [ e & .
srtermnind gt Weive e -— —— RES, | | — W e 8
| g = : ‘ - b
¥ & record i o e n e + |~ — W — — i . o e
wetereec Pk on te loune Lt L : | e A T e B et o b oy
el e m——teanae

b 0 e T et S JEE (pe=
e

What is an Acoess Control ¥ - o The CMDB and Cordg.ranen meme S
Access Control [ — —— — cMDB Configuration Items
- A ¢ iy S e SRS a— Lot e rate n cryte
v T Pyt oo it el st - =
s sty C"'l" S S ot M K] i st e, 4 s s

R — —————— g ——
R T T RM B e e
e b - Lt Sty o e ——— et e D
— e I
—— | U osate e - e i
= — D - — =}
s wiete as

For these selected topics, discuss:

Why would you use these capabilities?
When would you use these capabilities?

How often would you use these capabilities?
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nService Automation
s | Intro to Scripting & Application Tools
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Module 4 - 4.1 Service Catalog servicenow

Objectives
* What is the Service Catalog?

* Major Components
— Catalog Items
— Variables/Variable Sets
— Record Producers
- Order Guides
~ Workflows

* Service Catalog Item Request Output
* Service Catalog Security: User Criteria
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. )
Service Catalog = [
The Service Catalog is a robust ordering system for &R - ®
services and products offered by various departments YQ‘: | Hl o
for users: — o
)
* (Categories organize catalog items @ SR |——| -
* “One stop shopping” for users - . > )
«  Access to the Service Desk i ——
Office
* Help and Training Portal EH an —
* Multiple catalogs are supported =~
T Peripheraly D Motilen

The IT Service Catalog lets users see a list of things they may need (to create a request for), or would
like to have from IT. Administrators and users with the catalog admin role can define catalog items,
including formatted descriptions, photos, and prices.

Categories define the organization for Service Catalog items. Categories organize service catalog
items into logical groups. Categories can have a parent-child relationship, such as IT and Laptops. A
child category is a subcategory of its parent category. Each Catalog Item, Order Guide, Record
Producer, Content Item, and subcategory appears as a single item within the category.

In Service Catalog, Employee Self Service (ESS) users can order pre-defined, bundled goods and
services from the IT organization, or other departments. ITIL users or Administrators see additional
choices; Administrators can view all the Service and Item categories. Top Requests is a dynamic
category displaying the five most ordered items.

The ServiceNow platform supports multiple Service Catalogs. System Administrators and Catalog
Administrators can manage multiple Service Catalogs and provide services to different teams within
the organization. Examples include: IT Services, Human Resources, and Facilities Management.
Views can be defined for groups that view a Catalog, and Catalog Items can be shared by multiple

Catalogs
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Service Catalog Major Components servicenuow

-
Items - [,]A — Record Producers - [IE <
NV AT,
Items are the building blocks of the Service Catalog, Record Producers are a form that produce a task record |
including:
*  Hardware Order Guides - -[i=] -

" Softwfvare Order Guides assist customers in ordering a complete
Services set of needed items and help users identify the item
m——| . .

. S relationships
Variables - 25 - .
Variables provide questions to help the requestor Workflows - i % .
specify what item, option, or service to order

Workflows run behind the scenes and communicate

. = the stages of the approval process to the requestor, as
2 f— M
Variable Sets well as drive the request fulfillment

Variable Sets are a modular unit of variables that can
be shared between catalog items

Items: In the Service Catalog, users locate a category for an item or service they want to order, and
then click the subcategory link.

Variables: Provide options gather specific information related to the customer's needs. Questions
that define item options can be added to ask the end user ordering the catalog item. Variables can
affect the order price. Service Catalog variables are flagged as "Global" by default and will display in
all the execution tasks of a requested item. A variable is defined once and can be used in multiple
places. The Service Catalog allows you to attach variables to a catalog item.

Variable Sets: You attach variables either to a Catalog Item or to an Execution Plan.

Record Producer: An interface used as an alternative to lists and forms. Each Record Producer
focuses on a specific process or task and can be used anywhere in the ServiceNow platform. In the
Service Catalog, Record Producers are presented in categories along with catalog items. Users can
use Record Producers to create an incident, request an emergency change, and more. This enables
the Service Catalog to be used as a complete front-end Ul.

Order Guides: Order Guides provide the ability to order multiple, related items as one request.
Questions can be used to present item options; present users with only relevant questions and
choices at the appropriate time in the ordering process.

Workflows: When you create a new service catalog item, you can create a new corresponding
workflow at the same time.
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Service Catalog Items and Variables

servicenuw

To create a new item or modify an existing item, navigate
to Service Catalog > Catalog Definitions > Maintain Items

5 g [ s e

B a B et dee g
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-----

Variables

Global by default

Define the questions to ask
the end user ordering the
catalog item

Question choices can define
the available options and
may affect the order price

Examples:

Which monitor size?
Who is the hiring manager?

Once an item is published to the Service Catalog, users .
will be able to order it

What is the budget code?

Service Catalog variables are global by default and provide options to tailor a catalog item to the
customer's needs. For example, a computer may be available with different operating systems.

The Service Catalog lets you attach variables either to a catalog item or to an execution plan.

Common Variable Types
* Multiple Choice: Creates radio buttons for user-defined question choices.
» Select Box: Creates a choice list of user-defined question choices.
» Single Line Text: Creates a single-line text input field.
» Reference: Specifies a record in another table, similar to a reference field.

* Checkbox: Creates a checkbox that may be selected or cleared; list checkboxes in order under
a label to create an options question.

Functionally, a Variable Set is just a container, so it has only two fields: Name and Description. From
the Application Navigator, select Service Catalog > Catalog Variables > Variable Sets, and create a
new variable set. After you save the variable set, you will get a Related List at the bottom where you
can add as many variables as you want.

Used by items and variables, the Order field establishes the sequence for displaying information. For
example, an item with 100 in the Order field, displays first in the list. An item with 200 in the Order
field will display second.
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Record Producers

servicenow

Record Producers appear as simplified forms, allowing users to provide information that is
translated into records being added or modified in the database

€ e Dy T iy - e F

a2

- When employees use the Service Catalog
on the HR Service Portal to submit a
request for Direct Deposit setup, a record
producer transfers the request into an HR

case

- Incident management may use a record
producer for users who need to open an
incident easily via the web

- Facilities management uses a record
producer for users to open requests for

printer service

A Record Producer focuses on a specific process or task and can be used anywhere in the
ServiceNow platform. In the Service Catalog, Record Producers are presented in categories along

with catalog items where each table has its own record-identifying designation.
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Order Guides servicenow

Defln_e an Order Guide to assist cus.tomers in Order Guide
ordering a complete set of needed items and

to help users see item relationships What do you need?
Questions can be used to present item options; E Option 1
present users with only relevant questions and E Option 2
choices at the appropriate time in the ordering [D Option 3
process

g O &

i

Items are the building blocks of the Service Catalog. Once you have built a complete item with
variables and a delivery workflow, you can do a number of things with it, such as add it to an Order

Guide.

Order Guides provide the ability to order multiple, related items as one request. Remember that
variables are presented by the Order field number.

Use an Order Guide to assist users in determining what items they need.

Service Automation
© 2018 ServiceNow, Inc. All Rights Reserved 195




Service Catalog Item Request Output servicenow

Service Catalog

Summary of order, Request State

RITM# RITM# .

Sy Request ftam Item Ordered, Quantity, Stage
SCTASK# SCTASK# What to do, Assignment Group,
Catalog Task Catalog Task Assigned to, Task State, Work Notes
SCTASK# SCTASK#

Catalog Task Catalog Task

For Catalog Items, a request, an item, and a task are all created when an order is placed, each on a
corresponding table:

REQ# Request [sc_request] table: A request number generated to keep track of an order.

RITM# Requested Item [sc_req_item] table: Within a request generated from a catalog order, each
discrete item ordered is given a specific “Requested Item Number” known as an RITM (number).

SCTASK# Catalog Task [sc_task] table: In the Catalog Tasks section for an ordered item, the different
tasks display for what has to be done to get the item ready for delivery to the user, for example; the
Assignment group, the Due date, Work start, and Work end dates.

In this example, a manager orders two new computers for the team.

The first requested item is a desktop computer with two catalog tasks associated to it: order
equipment and configure equipment.

The second requested item is a laptop computer with two catalog tasks associated to it: order
equipment and configure equipment.

Although the requested items share similarly named catalog tasks, these tasks are tied directly to
their respective item because the required steps for completion may be different from item to item.
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Progress Stages for a Requested Item servicenuw

While viewing the requested item, you can expand the workflow stages which provide
summary-level feedback about the progress or state of an item in the delivery process

Requested tems (1)  Approvers(l) Group approwals (1)  Recurring Prices (1)
i Fequestediterms Goto Number v d4 4 1 wiell P PP E
= Numbir W = Quantity = Catalog Emem = Duedate = Price = Asugredto = Stage
ot Waiting for Approval [Wating for Approval [in progrens

Depl. Head Approval - 2 Days (Dept. Head Approval - 1 Days [Pending - has not started)
©0 Approval - 2 Days (C10 Approval - 2 Days (Pending - has not started

RITMICL0GR 1 W01801-20 13:0806  $1.100.00 Order Fulfilment - 4 Days (Order Fulfilment - 4 Days (Perdng - has not started))
Backordered - 14 Days (Backordered - 14 Days (Pending - has not started))
Deploymwat - | Day [Deployment - | Day (Pending - "us not starnted)
Compileted [Completed (Pending - has not started’))

ACTom o0 wiwed rows. 44 4 1 wiof P PP

After an request has been submitted, users are able to easily track it by navigating to Self-Service >
My Requests and opening the record associated with the request.

Workflows attached to an item may indicate the progress or state of an item in the delivery process
with one of the following stages:

* Waiting for approval (In Progress)
* Approved

* Pending (has not started)

* Fulfillment (In Progress)

* Deployment/Delivery

* Completed

Additionally, workflows can have multiple rounds of approval actions as it relates to Service Catalog
requests. Each approval action can share the same stage value or their own separate stages.

Stages can be grouped into a Stage Set for convenience of applying related stage values from
workflow to workflow.
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Service Catalog Security: User Criteria servicenuw

User Criteria defines conditions that are evaluated against users to determine
which users can access Service Catalog items

< EE nn i ey oke P = e Vo v
You can apply several user R Peerererererers —
criteria records to a single o 5
catalog item or category i (212 s [2
User Criteria is applied to s [ e Apa—
an item or category

To apply user criteria to an item or category, open the respective record and navigate to the
Available For or Not Available For related lists.

NOTE: These related lists are not on the form by default and must be added by configuring the form.

Next, click Edit to add an existing user criteria record, or click New to create a new one.

Save the record to associate the user criteria record with the item or category.

NOTE: The Not Available For settings override the Available For settings. A user on the Not
Available For list cannot access an item or category, even if that user is also on the Available For list.
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Section Summary

* What is the Service Catalog? lab4.1
Service Catalog
* Catalog Items

* Variables/Variable Sets E @‘
* Record Producers
* Order Guides Pages 200 - 206 10 - 15 minutes

* Request Output
* Service Catalog Security

Lab 4.1 - Service Catalog:

* Create an Infinity Service Catalog item
* Add item variables
* Validate your work with “Try It”
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LAB
Service Catalog 4. 1

B . (4 10-15 minutes

Lab Goal

This lab will show you how to do the following:
* Create an Infinity Service Catalog item
* Add item variables
* Validate your work with “Try It”

Up until now, the employee ordering and fulfillment process for an Infinity has been entirely
“off the books” — unofficial, to say the very least.

With the availability of the Service Catalog, Cloud Dimensions would like to improve the process
and ensure every employee has a chance to receive an Infinity device. Additionally, tracking
orders and inventory in one convenient location is appealing.

Infinity is offered to employees in either Crimson or Silver, with optional, additional
specifications to choose from.

Required Resource: CloudDimensions-Infinity-Logo.png

A. Create New Service Catalog Item

1. Impersonate Asset Manager.

NOTE: This user account is provided the catalog_admin role, which grants them access
to the Maintain Items module in order to complete Service Catalog administration tasks.

2. Service Catalog > Catalog Definitions > Maintain Items.
3. Click New.
4. Fill out the top of the form as shown:

Name: Infinity
Price: $395.99 USD
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5. Click the lock icon (Edit Catalogs) next to Catalogs:

ar

Availability = Desktop Only
Catalogs @
Category (@

If you want users to be able to search for
this Item, add it to a Category

6. Start typing ser then select Service Catalog:

Catalogs (2

| ser

= ervi
Category (2 - ce Catalog

7. Inthe Category field, select Hardware.

NOTE: Category is used to determine where a catalog item appears within the Service
Catalog. From the left navigation pane, under Service Catalog > Maintain Categories,
additional categories can be created and categories can be created hierarchically.

8. Add a Short Description and Description as shown:
Short description: VR, but without the glasses

Description:
The Infinity is a portable holographic projector (PHP) that is capable of projecting
immersive environments around you. What are you waiting for? Get Infinity!

9. Inthe Picture field, select Click to add...

Name Infinity Application Globel
Active v Price $ v e
Mvallability Desktop Only : Recurring price 5 v 0.00 rd
Catalogs (3 & Service Catalog Recurring price frequency Nane
Category (2 Mardware Q, ®
Warkflow Q Picture Click to add
cution Plan (3 DEFAULT Q
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10. Choose File: CloudDimensions-Infinity-Logo.png

11. Click OK.

12. Click Update.

Verify the Service Catalog Item Creation
1. Self-Service > Service Catalog.

2. Click the Hardware category header.

3. Select the Infinity item from the list to open the order screen.

Add a Memory Variable to the Service Catalog Item

From this form, a user could order an Infinity, but the form does not yet allow users to specify
options for the device. Let us fix that!

1. Service Catalog > Catalog Definitions > Maintain Items.

2. Filter the list by adding a “Name contains Infinity” condition:

= Catalog Items m Search  for text v

? All>Type != Bundle>Class != Order guide > Type != Package > Class != Content Item § Name contains Infinity
1o Q = Name = Short description = Active = Roles = Catalogs
*Infinity
~ . VR, but without the
(i)  |Infinity gl true

Service Catalog

m Atlons = set(‘m zixs :

3. Select the Infinity record:
@ Infinity
«

Click the Deactivate button.

NOTE: This button deactivates the catalog item(s) selected on the list, making them
inaccessible to users in the Service Catalog.
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5.

6.

10.

11.

12.

13.

14.

15.

Open the Infinity record.

From the Variables tab, select New:

Variables = Variable Sets | Approved By Group

= Variablesu Goto Order v

<
0

Catalog item = Infinity

) Q, = Type

Fill out the form as shown:

Type: Multiple Choice
Mandatory: [select checkbox]

Under the Question* tab, enter the Memory question as shown:

Question: How much memory do you want in your Infinity?
Name: memory

NOTE: The corporate-approved version of the Infinity is available in both 256GB and
512GB models.

Click the Default Value* tab.

Enter the Default value: 256.

Save the form, instead of Submit, to define the Infinity memory Question Choices.

Scroll to the Question Choices section then click the New button.
Fill out the Question Choices form as shown:

Order: 100
Text: 256GB
Value: 256

Submit.

In the Question Choices section, click New.
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16. Fill out the form for the second memory choice:

Price: $100.00
Order: 200
Text: 512GB
Value: 512

NOTE: The Price field is utilized by the 512GB choice, as it adds 5100 to the overall price.
Additionally, the order value is set to 200 which will place the 512GB memory option
second in the choice list.

17. Submit.

18. You should now see both question choice values:

Question = How much memory do you want in your Infinity?

Q, = Text = value
() 25668 256
(i) 51268 512

19. Click Update to return to the Infinity item record.

B. Add Color Variables to Service Catalog Item

With the first variable defined to provide end users with a choice of memory options, you will
now create a second question for choosing a color choice by configuring a second variable.

1. Inthe Variables related list, click New.
2. Complete the form as shown:

Type: Select Box

In the Question* tab,
Question: What color Infinity would you like?
Name: color

In the Default Value tab,
Default value: crimson

3. Save.
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9.

Scroll to the Question Choices section then click the New button.
Fill out the form for the first color choice:

Text: Crimson
Value: crimson

Save.
Change the following field values for the second color choice:

Order: 200
Text: Silver
Value: silver

Open the Form Context Menu, then select Insert to return to the color variable
record.

NOTE: You have just defined the values for the What color would you like? variable,
using question choices.

Another option for providing value choices is to use reference tables or fields from the
database. See the Choice table and Choice field options under the Type Specifications
section on the Variable form.

docs.servicenow.com defines all of the possible variable types.

Click Update to return to the Infinity item record.

LAB VERIFICATION

Test the Catalog Item

1.

From the top of the Infinity Catalog Item form, click the Try It button to view the
new variable options added.

NOTE: The Try It button is only available if the item is active.

Change the Infinity color to Silver.
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3. Choose 512 GB and notice how the item Price changes:

{ Service Catalog > Hardware > Infinity

VR, but without the glasses

< Cloud Dimensions

JNGEINITY

What color Infinity would you like?

Silver H
How much memory do you want in your Infinity?

256G8 [subtract $100.00]

® 51268

’qu

The Infinity is a portable holographic
projector (PHP) that is capable of
projecting immersive environments
around you. What are you waiting for?
Get Infinity!

Order this item

Price $495.99|

Quantity -

Subtotal $495.99

Delivery time 2 Days
Add to Cart

Shopping Cart

Empty

Congratulations! With this labs success, adding a workflow to the item will be no problem!
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Module 4 - 4.2 Flow Designer & Workflow servicenuw

Objectives

* What is the Flow Designer?

* What is a Workflow?
~ Using Workflows
— Workflow Execution

* Workflow Editor
* Workflow Activities, Transitions, Conditions, and Stages

* Workflow States
— Versions
— Contexts
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What is the Flow Designer? servicenow

ertace for i and T
interface for building and W
enabling rich process et

automation capabilities, S T tenen | e SR il - = = : =
known as flows '

Flows automate business ) resos.
logic for a particular
application or process
such as approvals, tasks,
notifications, and record

0o
operations -
0o

Flows include a trigger
(an activity that initiates
the flow) and actions
(operations executed by

ServiceNow)

Launch the Flow Designer by navigating to Flow Designer > Designer in the Application Navigator.
The following roles may be required to work with the Flow Designer in one capacity or another:
flow_designer, flow_operator, and action_designer.

Example actions available include:

* Ask for Approval — create approvals on any record, including rules for an approval, rejection, or
cancellation, and a due date

* Create Record — create a record on any table with configurable fields and field values

* Look Up Record — look up a single record on any table, confirming whether or not it exists and
using this in conjunction with other actions

* Add User to Task Conversation — add a user to a task record conversation (accessible via Connect
Chat)

* Create Flexible VTB — create a data driven Visual Task Board (VTB), including default lanes and
other configuration details

In addition to these core actions, new application-specific core actions can be created by activating
the associated spoke.

The natural-language descriptions of flow logic helps non-technical users understand triggers,
actions, inputs and outputs, allowing all subject matter experts the ability to develop and share
reusable actions with flow designers.
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What is a Workflow? servicenuw

A workflow is an automated multi-step process occurring across the platform

Wrkme o] Seprw Fad

B Serew Pd i Mdoard D 2 a

This is a workflow model which represents the entire structure of the workflow and the
definition of the processing a workflow can accomplish

Each workflow consists of a sequence of activities, such as generating records, notifying users of
pending approvals, or running scripts.

The workflow starts when a triggering event occurs. Common triggers include a record being
inserted into a specific table, or a particular field in a table being set to a specified value. For
example, you might create a workflow that runs whenever a user requests approval for an item they
want to order from the catalog. When an activity completes, the workflow transitions to next
activity. An activity might have several different possible transitions to various activities, depending
on the outcome of the activity. Continuing the example above, if the user's request is approved, the
activity might transition to an activity that notifies someone to order the item; if the user's request
is denied, the activity might transition to notifying the user that their request has been denied.

The graphical Workflow Editor provides a drag-and-drop interface for creating workflows and
represents workflows visually as a type of flowchart. It shows activities as boxes labeled with
information about that activity and transitions from one activity to the next as lines connecting the
boxes.

An activity is processed for each step in the workflow (the “behavior” is determined when the
activity begins).

When this action completes, the workflow checks each of the activity's conditions. For each
matching condition, the workflow follows the transition to the next activity. When the workflow
runs out of activities, the workflow is complete.
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When to Use a Workflow

servicenow

9

Use

To automate a repeatable
process

When a standard response
is needed for every record
insert, update, and delete

When automation is
needed in the platform
(not limited to Service
Catalog and SLAs)

X

Do Not Use

When doing a simple
discrete record change

If the process being
defined does not have a
standardized response
(new processes that are
being refined)

g8
- Change manager establishes a workflow that
controls the progression thru states to ensure

that a state is not skipped by manual
progressing the states

- In conjunction with Orchestration, workflows
can be used to automatically resolve an issue
with a Cl, for example restart a server when
the CPU utilization hits 95%

- Project manager has tasks automatically
assigned as previous tasks are completed to
reduce human error and delay, and increase
accountability

- After being resolved for 7 days, the Incident
Manager has resolved records automatically
closed

You can create a workflow with the Workflow Editor to automate a multi-step process.

NOTE: You must have the workflow_admin or workflow_creator role to use the Workflow Editor.
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Workflow Execution servicenow

Workflows use conditions and a table association to determine when to start,
execute, continue, and end

Scenarios when workflows are started:
* Schedule or SLA launch
* Execute on table interaction (conditions are met)

Invoke from a Script Include or Business Rule
Associate with a Catalog Item in the Service Catalog
Call a workflow from a workflow

Only published workflows can be instantiated. Unpublished workflows can not be started.

Notes about workflow execution:
» If the processing conditions are met, a workflow can be automatically started on a table
record insert or update operation.

* Workflows that are built for the Requested Item [sc_req_item] table can be manually
associated with a Service Catalog Item. Once associated, the workflow will start
automatically. This is also true for SLA Workflows.

* The startFlow(workflowid,current,operation,vars) method is one method that can be used
to call a workflow from a Script Include or Business Rule.

* Workflows that are called from other workflows are called subflows to that workflow.
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What is the Workflow Editor? servicenuw
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The Workflow Editor is an interface for creating and modifying workflows by arranging and
connecting activities to processes. Activities can be added, removed, or rearranged. Transitions can
be drawn or changed, and the workflow powers the process as defined visually. All workflows need
to have a Begin and an End.

The Workflow Editor user interface is divided into the following areas:
* Canvas Tabs: Contains tabs for accessing workflows being edited or created

» Title Bar: Displays the workflow name and status. Provides a menu and controls for
configuring, testing, and validating workflows.

* Canvas: Provides the working surface for creating new workflows or editing existing ones

» Palette Tabs: Contains all available workflow activities and existing workflows you can use as
subflows, displayed in the Palette. Drag activities and subflows to the canvas to create new
workflows or edit existing ones.

Workflows need to be checked out before they can be edited. When a workflow is checked out,
changes only apply to the user who has the workflow checked out. Other users can continue to use
the published workflow. After the changes are complete, the workflow can be published so that it is
available to all users.

To design a workflow model, drag an activity into the Workflow Editor and connect it to other
activities by drawing transitions. You can also copy an existing workflow to add, delete, and connect
activities. In the Workflow Editor, scrollbars are used to view parts of the workflow and the Expand
Transitions command to redraw lines.
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Workflow Activities, Transitions, Conditions, and Stages servicenuow

v Ca Core Activities
¥ (3 Acprcas

igh Aoproval - Group

Activities

An activity is a workflow block that organizes the individual actions the workflow performs as it runs

SL, Approval - User

| Aoproval Actien - " . . :
4 romonicondnsee | ACtivities are connected by transitions (lines) that establish the possible processing paths
o Generate

1, Manwal Approvals

) Rolback To

¥ (3 ComActivites Conditions . Stages
:g ::T: Conditions are an activity type Workflows can provide a summary of workflow progress
< available for a workflow by updating any field designated as a Stage field
43 Switch

Conditions are used to transition - v
to move from activity to activity,
you can add conditions

@ Wait lor condition HMJNMD\‘O\N "Wo"m

g, Wait for WF Event ) Fulfiliment (In progress)

Activities are the organizational element that defines the individual actions a workflow performs as
it runs. A transition, or line, establishes the processing paths or order in which activities are
executed.

The three basic workflow activities are Approval, Notification, and Task. Approvals allow approvals
to be generated and managed, while driving a record to fulfillment. Notifications allow users to be
notified of events that occur during the workflow. Tasks allow task records to be created and
modified. These activities are only available when the workflow is defined to run on a table which
extends Tasks. Other activities include Timers which pause the workflow for a set period of time and
Utilities which provide useful controls over the path of the workflow. Plugins can add specialized
activities to the Core Activities list and custom activities can be created.

Conditions are the start of a transition to the next activity in the workflow model, and all activities
(except End) use conditions to route processing. Add conditions to activities by right-clicking the
activity header. Approved, Rejected, Always, Skip and Error are common conditions.

Stages show workflow progress, but work a little bit differently for workflows that run against
Service Catalog Request Items [sc_req_item]. Still, add a designated stage field to any table (for
example, Incident [incident]) for progress summaries.
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Workflow States servicenow

Checked Out Published Unpublished
The Workflow is available to run Workflow version that is Workflow version that is no
only for the user who has it available to all users and the longer available for new
checked out platform that meet the contexts, but may be required for
conditions of the workflow already running contexts

(Published = false)

The workflow version is the currently published model that is available to the instance

A workflow context is the instantiation of the version that is executing for a given record,
showing the processing path executed

The version is the published model of the workflow. The published version is available to the
platform to use for creating new workflow contexts.

A workflow version maintains these properties:
* The workflow table association
* The conditions, published status, and permissions of the workflow

* The workflow model, which is the workflow in its entirety as the set of workflow activities
and their transitions (lines)

When a workflow version record is updated and the State changes to published, a table insert
action occurs and adds the version record to the platform’s current Update Set. Only published
workflows are captured in Update Sets.

NOTE: There can only be one active published version of a workflow at a time and past versions are
kept as unpublished so there is a historical record. Additionally, executing workflows will not be
affected when a new version is published.

Contexts can use different versions of the same workflow, and all of these contexts can be running
at the same time.
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Section Summary

Lab 4.2

What is the Flow Designer? ,
Flow Designer & Workflows

What is a Workflow?
Workflow Editor @‘
Workflow Terminology

Workflow States Pages 216 — 225 20 - 25 minutes

Lab 4.2 - Flow Designer & Workflow:

* Copy and edit an existing workflow to create a new workflow
* Validate and publish the workflow

* Associate the workflow to a Service Catalog item

* Test the workflow

* View the workflow history
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Flow Designer & LAB
Workflows 4.2

B . (4 20-25 minutes

Lab Goal

Lab Dependency: Requires the completion of Lab 4.1.

This lab will show you how to do the following:
* Copy and edit an existing workflow to create a new workflow
* Validate and publish the workflow
* Associate the workflow to a Service Catalog item
* Test the workflow
* View the workflow history

Now that Cloud Dimensions has opened up enrollment for testing the Infinity across the entire
organization and the Infinity has been created in the Service Catalog, it is time to implement
procurement automation through a workflow.

There is a baseline workflow, Service Catalog Item Request, that the system administrator will
copy and modify to fit the processes in place at Cloud Dimensions, as it relates to order
fulfillment and deployment of employee Infinity devices.

A. Copy and Modify the Service Catalog Item Request Workflow

1. As System Administrator, navigate to Workflow > Workflow Editor.

NOTE: The Workflow Editor opens and displays in a separate tab or browser window.

2. From the Workflows tab on the right, select Service Catalog Item Request:

Workflows  Core

Q, service @ +

Published Checked Out Help m

“§ Pwd Change - Local ServiceNow

= Name == Table = Updated by = Updated = Publishex *§ Pwd Reset - Local ServiceMow
Service I § Service Catalog Item Request ]
¢ L:1I it Reguested Item did ¢ 2009-01-14 -
TAORTER  [sc_roq_item Grrrm— 09:46:52 - *0 Service Catalog Reguest
Request
 Service Task Processing
Knowledge
Hngwl 2014-11-0%
Instant wieces admin 105 true
[kb_kmowledge 01:52:29

Publish
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3. From the Workflow Actions menu, select Copy:

Welcome  off Service Catalog Item Requ...

Service Catalog Item Request - Published
New Workflow »

Open Existing

' & Approval - User
D . cucc oo tecs soom

4. Name your workflow Infinity ltem Request.

5. Click OK.

Verify the workflow tab displays the title Infinity Item Request:

Welcome o@ Infinity item Request

= Infinity Item Request - Checked out by me

Workflow Overview (What the Checked Out Workflow Looks Like):

Welcome o iInfinty hem Reqeest

= Iefinty Hem Reqamt - Checked cut by me ﬂ

(B@G)

OL. 0 L - 2 =
Sepn & Stage: Dect Hand Approvsd (2 " Semge: (10 Agprvesi 2 Doy

J Daws)
— [ —

[+ Mppoowel Action ® [3 Natficason @

Va SeT axcwed worn of Secrrdee Sas

Mo _\I
Apgrreet
CT

L {
[B] conmeg ress @ {
Stage e FufTect (4 Q [T P @
Owys!

Assat Mg Fusiia Order

[] stage Backcrsesed (14 S

ﬂ Gty Toni @

Roseve Racspdew Foe

Amap —

Bachz-teres

" Aspraesl Achon O

Ao gzon Saraatan

Stags Aagear Tavadad
Wark Feched

]

L._—J

a) Sequential Approval Tasks

b) Set the Approval field to Approved

c) Assigned to the Procurement group to backorder or procure
d) Notify the Requested for user

e) Assigned to the Procurement group to check if backorder was received

f) Set Approval field to Rejected

g) Assigned to the Field Services group to deliver
h) Writes to the Workflow Log

i) Automated workflow stop
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NOTE: All new Service Catalog requests have an initial approval rule that is evaluated by
a separate Workflow, Service Catalog Request, shown here:

Wekcome  off Servie Catalog Reguest

= Service Cataleg Reqesst - Aubiched

(®) Begnn _ X e vt L
o PR -
g K= st vuns

[ Asproval Acsien

| Apzrrew Actien

If the request amount is under 1,000 it is automatically approved. This automated approval
then instantiates any Workflow associated to requested items of the request.

In the Service Catalog Item Request Workflow, which you copied and will now modify in this
lab, there are two User Approval Activities: Department Head and ClO. These are approval tasks
for the item the Workflow is associated with (Infinity for example). A successful Department
Head approval then triggers the ClIO approval which, when successful, triggers the next
Workflow activity, Mark item approved, and so on.

When the item is marked approved, then the first Catalog Task, Order Fulfillment, triggers. You
will customize the Order Fulfillment activity in the lab. If the Infinity is in stock, a notification is
sent. The second Catalog Task, Deployment, will end the Workflow after the task is completed

successfully.

Customize the Workflow

Begin by customizing the two Catalog Tasks: add a description of the steps involved for Order
Fulfillment and Deployment, define the groups responsible, and customize the names to align
with Cloud Dimensions processes.

1. Double-click the Catalog Task with the Stage: Order Fulfillment (4 Days) and the
Name: Asset Mgmt. Fulfills Order:

f

i e

Stage: Order Fulfillment (4
Days)

Asset Mgmt. Fulfills Order

Backordered ]

In Stock -

2. Modify the Name to: Infinity Order Fulfillment.
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3. Under the Populate task variables section, change the Procurement to Service
Desk.

4. Modify the Short description field, overwriting existing values with the following
values: Tasks to fulfill an Infinity

5. Click Update.

6. Double-click the Catalog Task with the Stage: Deployment (1 Day) and the Name:
Deploy Item to User:

t
e

e Stage: Deployment (1 Day)
Deploy Item to User

Always -

7. Modify the Name to: Infinity Delivery.
8. Change the Fulfilment group to Service Desk.

9. Modify the form fields, overwriting existing values with Infinity values shown below:

Short description: Deliver Infinity
Instructions: Deliver Infinity to requester or requester’s manager.

10. Click Update.
Validate and Publish the Infinity Item Request Workflow

1. Validate the Workflow by clicking the Validate icon (Checkmark):

Welcome | off Infinity Item Request

== Infinity Item Request - Checked out by me @ @

2. A Workflow Validation Report displays.

3. Close out of the Workflow Validation Report window.

NOTE: If you have warnings or critical errors, correct them before continuing.
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4. Next, publish the Workflow to make it available for other users to checkout; from
the Workflow Actions menu (which was used to copy a Workflow before), select
Publish:

Welcome  off Infinity Item Request

= [infinity Item Request - Checked o\
New Workflow

Open Existing

Copy

5. The workflow state updates in the header to Published.

B. Associate Workflow to Service Catalog Item

In this next step, associate the Infinity ltem Request workflow to the Infinity Service Catalog
item created in the last lab.

1. Close the Workflow Editor tab (or window) to return to the main ServiceNow
interface.

2. Service Catalog > Catalog Definitions > Maintain Items.
3. Search for and open the Infinity catalog item.
4. Inthe Workflow field, select Infinity Iltem Request.

5. Update.

C. Test Workflow — Order an Infinity

In this next step, you will impersonate Joe Employee and request an Infinity from the Service
Catalog.

1. Impersonate Joe Employee.
2. Self-Service > Service Catalog.
3. Click the Hardware Category, then select Infinity.

4. You can request either color, and, if desired, additional memory.

NOTE: If your order amount is greater than 1,000, additional approvals (not documented
here) are required.
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Click the Order Now button to make the request, and initiate the workflow.
Verification that the request was submitted is displayed at the top of the form.

Record the Request number here: REQ

Click the Infinity item description and record the Requested Item number here:
RITM

Test the Workflow — User Approval

Next, review the progress of the Infinity Item Request Workflow, then approve the Department
Head and CIO User Approval activities by impersonating the System Administrator. You could
impersonate the individual users but this is quicker.

1.

Impersonate System Administrator.
Service Catalog > Open Records > Requests.

Open the Infinity Request created with Joe Employee’s account.

NOTE: The REQ record is the parent record of the request.

In the Requested Items tab, click on the Requested Item Number (RITMnnnnnnn):

Requested Items (1) Approvers  Group approvals  Recurring Prices
= Requesteditems Goto MNumber ¥

Y Request = REQ0010011

10 Q, = Number ¥ = Quantity = Catalog = Item

(U RITM0010001 1 Infinity

Scroll down to Related Links and click Show Workflow.

This opens up summary of the running workflow context for the Infinity request:

(L8 oo J—

Begin » Stage: Dept. Head Approval (2 Stage: CIO Approval (2 Days)

} Days) CI0 Approval
- Dept. Head Approval
Approved -

Approved Rejected —

Rejected —W

Blue indicates activities that have been completed and green indicates the activity
that the workflow is currently at.
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6. Next, return to the main instance tab/window and select the Approvers tab on the

RITM form.

7. Click Requested from the State column:

Catalog Tasks = Approvers (1)

- -

Group approvals

Y Approval for = RITM0010001
50 Q, = State
©O) Requested

= Approver

Nelly Jakuboski

8. Click the Approve button to approve the request.

NOTE: You have approved this request as the system administrator, but for this
workflow, you could also have impersonated Nelly Jakuboski to approve.

9. Now, repeat steps 6-8 to complete the second approval, CIO Approval, on Bow

Ruggeri’s behalf.

TIP: From the RITM Approvers tab, you can also right-click on the Requested record,
then select Approve from the context menu as opposed to opening the approval

record.
10. Impersonate Joe Employee.
11. Self-Service > My Requests.

12. Open your Infinity Request.

13. Scroll down to the Requested Items section and expand the Stage field by clicking on

the “>” icon:

Risgesdit = RE QD101 1

= Quantity = Catalog = em = Oue date

Q = Number v

RITMO010001 1 infinity 2017-07-25 21:3%44

I
3

= Assigred 1o

539559

= Stage

-

Waiting for Approwal (Approwed (Approwed))
Dept. Head Approval - 2 Dy (Dept. Head Approval - 2 Days (Completed]|

10 Approval - 2 Dirys (CI0 Approval - 2 Deys (Completed))

) Order Fulfiliment - 4 Days |Order Fulfillmens - 4 Days (In progress)

Bacherdirnd - 14 Days (Bachoedered - 14 Darys (Pending - has not started))
Deployment - 1 Day (Deplcyment - 1 Doy (Pending - has Aot sartid)|

Completed [Completed [Pending - has not started))

Notice the current Stage is set at Order Fulfillment.
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Test the Workflow — Complete Fulfillment and Deployment Tasks

Next, impersonate Kevin Edd to approve the Order Fulfillment task since he belongs to the
Service Desk group and is responsible for completing the next phase in the Workflow.

1. Impersonate Kevin Edd.
2. Service Desk > My Groups Work.

3. Locate and open the Service Catalog Task associated with the Fulfillment workflow
activity.

HINT: Search the Short description column for Infinity.

4. As Kevin Edd, assume the four items listed in the Description field are complete —
click the Close Task button.

Challenge

View the progress of the Stage field for Joe Employee’s Infinity request:

Stge
v Waiting fee Approval (Request Approved (Appeoved))
Dept. Head Approval - 2 Days (Dept. Head Approval - 2 Days (Completed)

CI0 Approval - 2 Days (C10 Approval - 2 Days (Completed))
Order Fulfillment - 4 Days (Order Fulfllmert - 4 Days (Completed))
+) Deployment - 1 Day [Deployment - 1 Day (In progress)

Completed (Completed (Pending - has not started]))

Test the Workflow — Complete the Deployment

Service Desk is also responsible for delivering the Infinity once it is received so, as Kevin Edd,
close the deployment task.

1. If needed, impersonate Kevin Edd.
2. Service Desk > My Groups Work.

3. Locate and open the Service Catalog Task associated with the Deployment workflow
activity.

HINT: Search the Short description column for Infinity.

4. Assume the Infinity has been delivered — click the Close Task button.
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Test the Workflow - Verify Request Complete
1. Service Catalog > Open Records > Requests.

2. Confirm that the REQ is no longer in the list.

LAB VERIFICATION

Final Verification: View Workflow History
1. Impersonate System Administrator.
2. Workflow > Live Workflows > History.

3. Click the Ended column header to date sort most recent at the top.

NOTE: The history for all requests and their workflow steps are displayed in a single list
view. The list can be personalized to add other fields or a filter can be created to view
only steps associated with a particular workflow or workflow activity.

4. Click the Infinity Item Request title in the Context column where the Activity is Item

Deployed:
= Workflow Activity History Goto Ended v 44 4 1  to200of420
Y A
{51 Q, = Started = State = Ended ¥ = Context = Activity
(i)  2017-07-2021:46:42 Finished 2017-07-20 21:48:50 Infinity Item Request Infinity Delivery
() 2007-07-2021:48:50 Finished 2017-07-20 21:48:50 Infinity Item Request ltem Deployed
@ 7-07-20 21:48:; Finished 2017-07-20 21:48:50 Infinity tem Request End

NOTE: This workflow context shows all of the workflow steps completed for the Infinity
request; ordered, approved, fulfilled, and delivered.

5. Select the Workflow Activity History tab and notice the nine Activities.
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6. Under Related Links, click Show Workflow to show which path the workflow
executed for the Infinity catalog item request:

o B S D — B
Bagn r - Stage: Depr. Head Approwss (2 = Snagn: Ci0 Agpreveai (2 Days) Ny it of Backaetersd Stats Stage Backiotiewt (1 Dins)
pr— e Dayw) CIO Appeovel = Racass Rackorsnd bsm
Dt Humat Aporovel | ) arps —, ays
Aggrired — 2
e todd
Bom g
Sge: Osder Fusliwan |4 [ wosncation
Q)
irfirsty Orcler Futirant Irtarr Basccartensd recmreed
B b dered — -
" Stace e
e L O A—
Hugecon Moo Stepe: Faguesl Cerculed B -
g Vekaem Congennt ::WHM _— t Complaing
Ay . e— Sy . .
Erd
Impressive!

In this lab you took an existing workflow and modified it to fit within a Service Catalog item
fulfillment and delivery process.
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Module 4 - 4.3 Service Level Agreements servicenow

Objectives

* What is a Service Level Agreement?
— SLA Types
— Definition and Conditions

* Default SLA Workflow
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What is a Service Level Agreement?

servicenuw

SLA &

A Service Level Agreement (SLA) defines a set
amount of time for a Task to reach a certain
condition, the table(s) to access, and what type
of SLA is being evaluated

SLAs include actions that can be triggered at
different times during its life cycle

If the Task SLA does not reach the condition,
the Task is marked breached

SLAs are represented by a record stored in the
SLA [contract_sla] table

Types of SLAs

1. Service Level Agreement (SLA)
2. Operational Level Agreement (OLA)
3. Underpinning Contract (UC)

2
- Facilities management defines fulfillment

times of request for meeting rooms

- HR may use SLAs to track average Case
resolution time

- Field services has commitments for on time

arrival with defined discount if late

Several major components work together to power the Service Level Agreements plugin:
* SLA Definition: The record which defines the conditions that trigger the SLA
* Task SLA: The individual instances of the SLAs associated with particular tasks

* SLA Workflow: Workflow powers events or actions based on the SLA definition and is
designed to be used over and over

* SLA Automation: The Business Rule and Scheduled Job that automate the SLA

* SLA Conditions and Script Include: A Script Include and reference record that can be used to
customize the transitions between different SLA states

The Task SLA [task_sla] table stores each of the individual SLAs attached to particular tasks.
Unlimited SLAs can be running against a record but SLAs can only run against a table that extends
the Task table.

Types of SLAs: While each type of Service Level Agreement may involve different stakeholders, their
basic structure in the tool is the same, they track things you want tracked. The only difference
between SLAs, OLAs, and Underpinning Contracts is the Type field on the Task SLA form. These SLA
types basically all behave the same way.

» An Operational Level Agreement (OLA) defines how departments work together to meet the
service level requirements documented in an SLA

* An Underpinning Contract (UC) is a type of SLA that defines and monitors the guarantees
established with an outside supplier; it is a tool for supplier management
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SLA Definition servicenow
= SLA Definition -—
| == Priority 2 resolution (8 hour) ’ w —+ oo Update Delete ’r \Lv
Name Priority 2 resolution (8 hour) Application Global ®
Type SLA - Duration type (7 User specified duration $

Target Resolution e Duration Days o0
Table Incident [incident) v Hours 08 00 00

Workflow (3 SLA notification and escalationworkfle Q. A @ Schedule source (2 SLA definition B
Active Schedule 8-5 weekdays 2@

Enable logging

Timezone source (? The caller’s time zone

When defining a Service Level Agreement, there are many important fields including:

» Duration type: You can choose a specific duration from the list, or you can define your own.

The SLA performs the calculations and sets a day and time as the deadline for the SLA.
Typically, you would apply User specified duration.

Duration: When User specified duration is selected from the Duration Type list, an
administrator can define the number of days and hours of the timer for the SLA.

Schedule: Defines what is calculated as hours in a work day and number of days in a work
week to use for the SLA. Before you begin to look at how to calculate conditions for the
scheduling of the SLAs, you can check to see what platform schedules have been set up for
hours per work day and the number of days in the work week.

Timezone source: Specify the time zone for the SLA. The SLA definition's time zone is used
when creating Task SLAs if the Use the following time zone for SLA property is selected in
Service Level Management > Properties > SLA Engine. The time zone can be definition,
schedule, location, or configuration item
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SLA Definition: Conditions

servicenuw

Start

Enables you to define the
conditions under which
the SLA will be attached

Retroactive start, when
activated, works with the
Set start to field and
calculates the SLA start
time

For example, an incident
is received saying that
email is down; an hour
later the incident is
updated with the email
server being offline, but
the start time is the same
for both actions

Pause

Enables you to define the
conditions under which
the SLA will suspend
increasing elapsed time

Use the When to resume
drop-down list to choose
the condition under which
the SLA will resume
increasing elapsed time

Stop

Enables you to define the
conditions under which
the SLA completes

If all of the specified stop
conditions match, then
the task SLA will complete
regardless of whether it is
breached

Reset

Enables you to define the
conditions under which
the running SLA will be
completed and a new SLA
will be attached

For a new SLA to be
attached, the start
condition must match

Start condition

Pause condition

Stop condition

Reset condition

While defining an SLA, you can set up to four SLA conditions: Start, Pause, Stop, and Reset.

SLA Definition Evaluation - Every task in the platform is evaluated in the following order:

* Process new SLAs to determine if a new SLA record must be attached to a task

* Process existing SLA records attached to a task

SLA Condition Evaluation:

* Attach if start condition matches and both the stop and cancel conditions don't match

* Complete if the stop condition matches

* Pause if the pause condition matches

* Resume if the pause condition doesn't match or resume condition matches

* Reattach if both the reset and the start conditions match

* Cancel if the start condition doesn't match or cancel conditions matches

Service Automation
© 2018 ServiceNow, Inc. All Rights Reserved

229




Default SLA Workflow servicenuw
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As you saw earlier, ServiceNow also provides Workflows for Service Catalog Requests, Service
Catalog Item Requests, and other types of Workflows, such as Routine Change and Emergency
Change.

The Default SLA Workflow is designed to be used with multiple service level agreements of any
types. This workflow will create events that send out notifications automatically after a task reaches
50%, 75%, and 100% of its allotted SLA duration.

There is also the SLA Notification and Escalation Workflow which will create events that send out
notifications automatically. When a task reaches 50% of its allotted SLA duration, for example, the
workflow will trigger a notification to be sent to the assignee and the user listed in the Supported by
field on the configuration item. At 75% and 100%, a notification is sent to the assignee and the
assignee’s manager.

SLAs allow an IT service desk to track if their representatives are providing a specific level of service,
and run reports on the success rates of the SLA actions.

For example, notify the manager when the SLA reaches 75% of its allotted time. Most commonly
used to ensure incidents are being resolved within a certain amount of time.
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Section Summary

* What is a Service Level Agreement? _ lab4.3
Service Level Agreements
* SLA Types

» SLA Definition and Conditions @‘
» Default SLA Workflow

Pages 232 - 235 5 =10 minutes

Lab 4.3 - Service Level Agreements:

* Create an SLA for Infinity security incidents
» Test the SLA
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LAB
Service Level Agreements 4.3
EEEE e (4 5- 10 minutes

Lab Goal

This lab will show you how to do the following:

* Create an SLA for security incidents
* Test the SLA

Buster Wubbel and Winnie Reich have agreed upon a reasonable duration for how long it
should take to resolve all security incidents, including Infinity incidents.

They have asked the system administrator to create a new SLA that meets their requirements.

A. Define an SLA for Security Incidents

1. Service Level Management > SLA> SLA Definitions.

2. Click New.
3. Complete the form as shown:

Name: Security Incident Resolution
Table: Incident [incident]

Duration: Days 00 Hours 08:00:00
Schedule: 8-5 weekdays

¢ = SLA Definition
=== New record
Name Security Incident Resolution
Type  SLA
Target - None -
Table  Incident [incident] v
Default SLA workflow Q A
Active
Enable logging

Application

Duration

Schedule

Global

User specified duration

Days 00

Hours (8 ]

SLA definition

8-5 weeldays

The caller's ime zone
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4. Add the Start conditions as shown:

Active | is | true AND
Category | is | Security

Startcondition | Pause condition  Stop condition  Reset condition

Add Filter Condition Add "OR" Clause

All of these conditions must be met

Active v is 2 true : AND OR x

Category v is * Securny v AND OR x

5. Select the Retroactive start checkbox.

NOTE: Doing so will display the Set start to field.

6. Choose Created for the Set start to field.

7. Change the value of the When to cancel field to Start conditions are not met:

ap

When to cancel Start conditions are not met

8. Select the Stop condition tab.
9. Add the following Stop condition:

State | is | Closed OR
State | is | Resolved

Startcondition  Pause condition  Stop condition  Reset condition

Stop condition (7 Add Filter Condition Add "OR" Clause
State v is ¥  Closed
or State v s v+ Resolved

NOTE: This SLA will take effect for any incident submitted with a category of Security,
and it will track time until the incident reaches the state of Closed or Resolved.

10. Click Submit.
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B. Test the Service Level Agreement
1. Impersonate Winnie Reich
2. Incident > Create New.

3. Fill out the form as follows:

Caller: Winnie Reich

Category: Security

Assignment group: Service Desk

Short description: Testing Security INC SLA

4. Save.

5. Scroll down to the Task SLAs section.

Notice the Security Incident Resolution SLA has triggered:

Task SLAs (1) | AffectedCls = Impacted Services/Cls  Child Incidents
= TaskSLAs Goto SLAdefinition v
Y Task=INC0010013
Q, = SLA definition = Type = Target = Stage = Business time left
;:zzﬁ:;:ﬂdem A nrc:;reﬁ 7 Hours 59 Minutes

6. Scroll back to the top of the form and update the State field to Resolved.

7. Save the record.

fin
|

8. From the Task SLAs section, select the Preview icon (circle with an
Incident Resolution:

) for Security

Y  Task=INC0010013

}:TC-S-’ Q = SLA definition = Type

LY
- Security Incident

e s
\ Resolution

9. Next, click the Open Record button on the record preview window.

10. Under Related Links on the Task SLA record, click Show Workflow.

NOTE: This Workflow context shows the lifecycle of the SLA for the incident
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LAB VERIFICATION

Service Level Agreement Definition

=  SLADefinitions u Goto Updated v W €€« 1
Y
@J Q = Name = Type = Target = Duration = Table

(i)  Security Incident Resolution SLA 8Hours Incident [incident]

Well done, you have completed the Service Level Agreement lab!
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Module 4 - 4.4 Knowledge Management servicenow

Objectives
* What is Knowledge Management?
* Knowledge Base Architecture
* Knowledge Base Workflows

* Knowledge Article Security: User Criteria
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What is Knowledge Management? servicenow

Knowledge Management allows users &
to create, edit, and view Knowledge
articles to share information across the
organization in a centralized location

- HR administrators can limit access to
Knowledge articles with User Criteria, for
example Benefits for EMEA employees are

only visible to employees who reside in EMEA
Knowledge articles exist within a single

Knowledge Base, which is managed bV - Include HR policies, calendars, and detailed

instructions for reporting violations to reduce
one or more Knowledge Managers _
security cases

Administrators and those with the - In conjunction with Event Management,
knowledge_admin role can create Knowledge Base articles containing resolution
multiple Knowledge Bases instructions can be generated from Events to

fix an issue with a Cl

With Knowledge Management, each organization can have their own Knowledge Base with flexible
controls over who can see the information and who can help contribute.

Users can browse and search Knowledge using a Knowledge Homepage or use contextual search
from other ServiceNow applications, so users can help themselves troubleshoot their issue.

To view Knowledge content, navigate to Self-Service > Knowledge to displays knowledge articles

organized by Knowledge Base and Category, as well as Featured Content, and popular articles (Most
Useful and Most Viewed).

From the Knowledge homepage you can browse and search for articles, then submit feedback on
those articles if desired.

NOTE: You must have at least one ServiceNow role to contribute content.
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Knowledge Base Architecture

servicenuw

The Knowledge homepage displays knowledge articles and social questions (Q&A)

organized by knowledge base and category

M Q - n
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bp POATONS of Te T PO CRANGING T B0 e Ty S D COpESS, recece Sach porson of e ced
e P gy et

IT Knowledge Base

From the homepage, users with the correct permissions can import a Word document to a
knowledge base using the Import Articles button, create a new article using the Create an Article

button, or ask a question using the Post a Question button.

Administrators can create multiple Knowledge Bases and assign them to individual managers
responsible for controlling the behavior and organizational scheme of each knowledge base. Each
Knowledge Bases can have unique lifecycle workflows, user criteria, category structures, and

management assignments.

Category Hierarchy:

» Knowledge articles within a Knowledge Base are grouped by category

* Category groups can help you define the Knowledge Base taxonomy, and can help users find

articles within a Knowledge Base

* Knowledge Managers can define knowledge categories to pre-populate the list of available
categories, and knowledge contributors can select categories, and add or edit categories, if

enabled, for a Knowledge Base
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Knowledge Base Workflows servicenuw

The publishing and retirement processes for a Knowledge article are controlled by workflows
defined for the Knowledge Base that the article belongs to

ol J [ m—— e et You can assign different workflows
| i to each Knowledge Base
e — You can use one of the default
workflows, or create your own
rerm——" P, workflow to define custom
Publish e | publishing and retirement processes
- B ey =
Workflow - for different types of knowledge

The Knowledge Base Workflows available in the ServiceNow baseline instance include:

* Knowledge — Approval Publish: Requests approval from a manager of the Knowledge Base
before moving the article to the published state. The workflow is canceled and the article
remains in the draft state if any manager rejects the request.

* Knowledge - Instant Publish: Inmediately publishes a draft article without requiring an
approval.

* Knowledge — Instant Retire: Immediately retires a published article without requiring an
approval.

* Knowledge — Retire Knowledge: Moves a knowledge article to the retired state.

NOTE: This is only a selection of the base instance workflows to choose from, as designed for
Knowledge Base management.
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Knowledge Security: User Criteria servicenow

User Criteria defines conditions that are evaluated against users to determine
which users can create, read, write, and retire knowledge articles

You can apply several € B G o A e F T o v e Y
user criteria records to ot [ T A Rt i Bt rovacsien [

knowledge content -

User Criteria is applied at

the Knowledge Base level -2 —

Knowledge Bases use User Criteria records to determine which sets of users can read or contribute
knowledge within that Knowledge Base. If a knowledge base has no user criteria selected, articles
within that Knowledge Base are available to all users.

User Criteria definitions include:
» canRead: users who can read all Knowledge Base articles
» cantRead: users who cannot read, create, or modify articles in the Knowledge Base
* canContribute: users who can read, create, and modify articles in the Knowledge Base

* cantContribute: users who cannot create or modify articles in the Knowledge Base

To implement User Criteria, navigate to Knowledge > Knowledge Bases and select a Knowledge
Base. Next, access the Can read or Can contribute related lists to select or create User Criteria
records.

When creating User Criteria, the Match All check box to determine whether all elements from each
populated criteria field must match. If selected, only users who match all criteria are given access. If
cleared, the user must meet one or more of the set criteria to be given access. By default, this check
box is cleared so that any condition met provides a match.
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Section Summary

Lab4.4

* What is Knowledge Management?
Knowledge Management

* Knowledge Base Architecture

* Knowledge Base Workflows @‘
* Knowledge Article Security
Pages 242 - 247 10 - 15 minutes

Lab 4.4 - Knowledge Management:

* Create a Knowledge Base article by importing a Word document
* Approve the article for publishing

* Define, apply, and test user criteria on the knowledge base
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LAB
Knowledge Management 4.4

B . (4 10-15 minutes

Lab Goal

This lab will show you how to do the following:
* Create a Knowledge Base article by importing a Word document
* Approve the article for publishing
* Define, apply, and test user criteria on the knowledge base

After a few positive rounds of Infinity testing, the product has been greatly improved and the
testing audience is ready to be expanded.

Human Resources (HR) has volunteered to lead an initiative within Cloud Dimensions to
advertise open enrollment for Infinity testing using the Knowledge Base.

HR representatives will be granted the appropriate authoring permissions by the system
administrator so that they may create, review, and publish articles.

The system administrator will also assist with ensuring the article remains secure and accessible
only by Cloud Dimensions employees.

Required Resource: Infinity_Open_Enrollment.docx

A. Create a New IT Knowledge Base Article
1. Impersonate Jasmin Gum, a member of the Human Resources group.
2. Self-Service > Knowledge.

3. Click the Import Articles button:
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4. Next, click + To select word files and find the Infinity_Open_Enrollment.docx file

you have downloaded, then fill out the form as shown:
a) Article 1: Infinity_Open_Enrollment (auto fills)

b) Knowledge base: Human Resources

c) category: [leave empty]

d) Click the Import button

Drop word files here 4 To select word files

Files to import
o Article 1 | Infinity_Open_Enroliment (—:-)
# Knowledge Human Resources o Xvw
base

category Select an optior ° o

Import X

NOTE: You should receive an “Import completed” message on the bottom of your screen.

5. Self-Service > My Knowledge Articles.

6. Click the knowledge article Number for Infinity_Open_Enrollment:

Knowledgem Goto Number v .w.

Y All>Workflow in (Draft, Review, Published, Pending retirement, Retired) > Author = Jasmin Gum

ot Q, = Number ¥ = Short description = Author = Category

Q) Infinity_Open_Enrollment Jasmin Gum

44 <

= Workflow

7. Update the Short description to Infinity Testing Open Enrollment.

8. Click the Publish button from the header.
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NOTE: The default publish workflow for the Human Resources Knowledge Base is
Knowledge — Approval Publish. This means after an author clicks the Publish button on
their article, it goes into a review state. Other uses with the correct permissions can view

the article and determine if any changes are needed before approving and publishing the
article.

B. Approve the Article for Publishing

1.

4.

Impersonate Gracie Ehn, manager of Jasmin Gum.

NOTE: Gracie Ehn is also a member of Human Resources and acts as the review board
for new content submitted to be published.

Service Desk > My Approvals.

Locate and open the requested approval record for the Infinity Testing Open
Enrollment knowledge article:

Approvals Goto State v
<
7

All>Approver = Gracie Ehn

{53 Q = state = Approver

b

(D - Requested racie Ehn

Scroll down to see a summary of the item being approved.

5. Assume the content looks good, then click Approve from the form header:

Update Reject Delete

6. Self-Service > Knowledge.
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7. Open the Human Resources Knowledge Base to confirm the article appears:

All Articles Questions

Human Resources Sortby Last updated

Infinity Testing Open Enroliment

Authored by Jasmin Gum e 3 Views e Last updated 3m ago  Rating

Infinity Testing Open Enroliment What is Infinity? Infinity is Cloud Dimensions latest
product offering, a portable holographic projector (PHP for short), which is capable of
projecting immersive environments around you such as a rain forest, grandma’s...
Knowiledge Base: Human Resources

C. Create and Apply User Criteria

The Human Resources Knowledge Base is currently public to all users that log into the Cloud
Dimensions instance and access the Self-Service > Knowledge module.

The system administrator will create user criteria and apply it to the Knowledge Base to
appropriately control who can view the content.

1. Impersonate System Administrator.
2. Knowledge > Administration > User Criteria.
3. New.

4. Fill out the form as follows:

Name: Cloud Dimensions Employees
Companies: Cloud Dimensions

5. Submit.
6. Knowledge > Administration > Knowledge Bases.
7. Open the Human Resources record.

8. Scroll down and click the Can Read tab:

Knowledge (1) = Questions Can Contribute
= CanRead m m Goto CanRead¥

<
¢

Knowledge Base = Human Resources

9. Click Edit...
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10. Add Cloud Dimensions Employees to the Can Read List.

11. Save.

D. Test User Criteria

1. Impersonate Jon Floyd.

NOTE: Remember, Jon Floyd works for a partner company of Cloud Dimensions. We will
use his user account to verify the Human Resources Knowledge Base is unavailable to

access because of the user criteria applied to it.

2. Self-Service > Knowledge.

The Human Resources Knowledge Base does not appear.

LAB VERIFICATION

Human Resource Knowledge Base Article

< * Home General Flag article Create incident m

Infinity Testing Open Enrollment

KBOO10002

Infinity Testing Open Enroliment

What ks Infinity 7

Infirity is Cloud Dimensions latest product offering, a portabie holographic projector (PHP for short), which is capable of
PrOJRCINg IMMersive environments aound you such as @ min 10Mest, grandma’s house, and even a lunar landscape belanging 1o
@ planet marry lightyears awary! How cool is that?!

What does this opan enrollment maan?

Infirity has been tsted many limes over by Ieams Tal am closest 10 & - that is, multiple Cloud Dimensions teams thal support
Infirity hurve had thadir hands on it Tor a few months row

Bacause of how wall the Infirily devices are shaging up, we want 10 exiend e Weating audencs 1o ol Cloud Dimensons

aMpCrRes

User Criteria — Employee Perspective

Knowledge Bases

Human Resources

0 Questions andj 1 Articles
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User Criteria — Non-Employee Perspective

Knowledge Bases

Knowledge

0 Articles

That does it for the Knowledge Management Lab!
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Module 4 - 4.5 Reporting

servicenow

Objectives

* What is ServiceNow Reporting?

Report Types

Creating and Editing Reports

L ]

Report Designer
- Actions

- Options

— Distribution

Metrics

L]

Performance Analytics
* Dashboards
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What is ServiceNow Reporting? servicenuw

~ &

Reports af— [@F
- Management needs to have a report
automatically generated and delivered to her
division for all P1 incidents that happened

Use the Reports application to run predefined
reports and create custom reports that show
results, prepared on an ad-hoc basis

overnight
Use the Report Designer to create reports by - Vendor management needs to see a
modify an existing report, or create a new quarterly roll up of Service level compliance of
report from scratch their third party service providers

- HR may use reports to measure average
Benefits Case load by assignee during open
enrollment

- An agent needs to have evidence of his
performance managing cases over the last
quarter in preparation for his quarterly review

The Reports application allows you to graphically view and analyze data from your ServiceNow
environment. Reports can take many forms, including bar charts, pie charts, dials, lists, pivot tables,
donuts, and more. Reports can be run manually or scheduled to be run automatically.

ServiceNow reports are interactive; you can drill down into the report gauges to view and
manipulate the underlying data.

There are a range of predefined reports that pertain to applications and features like Incident
Management and Service Catalog requests, including Key Performance Indicator (KPI) reports. If
none of the predefined reports meet your needs, you can create your own reports by navigating to
the Reports > View/Run module. Alternatively, you can simply click most column context menus in
any list to generate a report directly from the data in that list.

ServiceNow Reporting can easily answer such questions as:
* Did | meet an SLA?
* How many incidents did my team close in a month?

* Metric Reporting: What was the average time from Incident open to Incident closed for each
Service Desk team?

For more information, navigate to Reports > Getting Started.
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Report Types

servicenuw

The ServiceNow base instance comes with over 25 standard report types

Open Inodents bry Assignment

ridanl Coanl

VP T I IR
L AL a{'”.f"

¢ v F

Donut

Pareto

Heatmap

One report variation, a Pareto chart, named after Vilfredo Pareto, is a type of chart that contains
both bars and a line graph, where individual values are represented in descending order by bars, and
the cumulative total is represented by the line. Pareto Charts are useful to show the significance of
factors for a given question/process. Pareto Charts use the rule that about 20% of input produces
almost 80% of the outputs.

Other report types include: Speedometer, Dial, Single Score, Pie, Semi Donut, Bubble, Multi-Level
Pivot Table, Line, Column, Area, Spline, Bar, Histogram, Horizontal Bar, List, Funnel, Calendar,
Pyramid, Box, Trend, Control, Trendbox, Map, Pivot Table, and Text Analytics.
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Create and Edit Reports servicenuw

Create a New Report from a List

1. Define and run a filter, displaying only the data to reporton 2. Open the Column Context Menu,
then choose Bar Chart or Pie Chart

S ncden n Got Mumder v V' 44 4
= Caller = State = Catesory
—_—— Sort (ato 1) 3
s Sae AND OR  AddSom % Sort(z2toa)
AL ol these LonBRons must e met Show Visual Task Board
Rich Bergie 3 - Moderate
Acties v & 3 e H mn on X 1
Group By Priority |
Pouw oy v  lseneel L Mo OR X Bow Ruggeri 5 - Planming I
Bar Chart
1 Moderste -
e ety 5Py :

Create a New Report or Edit an Existing Report

Navigate to Reports > View / Run to create a new report with the Report Designer, or open an existing report

You can build reports from scratch, but it is often easier to start with a filtered list or an existing
report. When you start with an existing report, reporting configuration choices will be provided for
you. By modifying the provided options, you can configure the report to meet your needs. It is a
best practice to copy a base report then edit your copy.

Use the ServiceNow Report Designer to:
* Leverage reporting visibility and available report types
» Use multi-level filters, filter operators, and sort order to refine reports
* View, create, edit, and schedule reports
* Work with reporting roles

* Use Related Tables (dot-walking and Database Views)

Advantages to modifying an existing report:

* You can start with a report that already has the basic information and make minor changes to
get what you need

* Browsing existing reports helps you learn which of the tables are relevant to the work you do
* Helps you learn different uses for the various report types

* You can leverage ITIL best practices by using Key Performance Indicator (KPI) reports
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Report Visibility servicenuw

My reports Group ey - Global All
Created by you and Reports that are Available to List of all personal,
only visible to you visible to everyone everyone group, and global
in your group(s) (all Fulfillers) reports

v VvV

= Repots | Myrepors | Group  Global Al Q @
Iype

+ Title Table Scheduled  Publithed
» 2 30/60/90 Day Desired State TaskAging  Follow On Task [cert_follow_on_task]
/7 U 30/60/90 Duy Task Aging Follow On Task [cert_follow_on_task]
VAR * Active Contracts by Cost Per Unit Contract [ast_contract

The Reports > View / Run module contains a library of reports which you can run and use to create
your own custom reports. Many of these reports came with the platform and others were created
by your reporting administrators specifically for your company.

The Reports page contains different sections for reports which are visible to different audiences:
* My reports: Visible only to the report creator (Me)
* Group: Visible to one or more specific users and/or groups (Groups and Users)
* Global: Visible to all users (Everyone)

* All: A list of all Global, Group, and personal reports
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Report Designer: Creating a Report servicenuw

Report Designer is an interface used for creating or modifying ServiceNow reports

It features four sections which provide reporting configuration options: Data, Type, Configure, and Style

( Create a report Sadtch 1o elassi

Data

% Report name

% Data source Use a table instea

No dats vourte welecied

Users with the admin role can access the Reports > Administration > Properties module to enable
the Report Designer for all users with the permissions to create/edit Reports. Alternatively, users
will be able to revert back to the classic reporting interface by clicking on the Switch to classic Ul
link towards the top-right of the Report Designer interface.

Each section of the Report Designer provides different configuration options:

» Data: Provide a name for the report, as well as select the source from where your data comes
from. You can choose a data source, which is a predefined data set used for creating reports;
or a ServiceNow table.

» Type: Select the visualization of your report by choosing a report type. There are 27 different
types to choose from!

» Configure: Do things like group the data by a specific field(s) and run calculations against the
data.

 Style: Adjust the look of your report, from coloring to titles, as well as making adjustments to
the report legend.

NOTE: Every time you make an adjustment through these controls, remember to click the Run
button in the top-right to redraw the report with your changes.
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Report Designer: Report Actions and Options

servicenuw

Report info

v

Save report; options to Save,
pe==_| Sharing Menu Insert, Insert and Stay, and
Save as data source

Delete report

Run report, do
j I not save/update

Switch to classic Ul

®

All Contracts by Type

s 5 v - S

Update

Insert D{g

Insert and Stay

Save as data source

The Report actions available to you depend on your role. Many of the Report actions are easily
understood; therefore only some of them are detailed here:
* Update: Overwrite report, return to the report list

* Insert: Save a duplicate copy of the report, return to the report list

* Insert and Stay: Save a duplicate copy of the report, remaining on the report

* Save as report source: Allows you to create a pre-defined data set that can be used for

creating reports
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Report Designer: Report Distribution

servicenuw

Share

To make a report visible to a
particular group or user, use
the Share option to select
Groups and/or Users

Sharing X
Share

Schedule

Add to Dashboard

Export to PDF

Publish

Publish

Steps to publish and view a report:

f 1

& 2

3.

With desired report displayed click the
Sharing menu icon, then click Publish

Click the Copy report link icon from the
report header to copy the URL to your
clipboard

Open URL in browser

From the Sharing menu, you have the following options:

* Share: Allows you to specify who can see the report. Options include Me, Everyone, and

Groups and Users. Admin role is required for Everyone and Group sharing.

* Schedule: Create a scheduled email of the report

* Add to Dashboard: Add directly to a Dashboard on a homepage you choose, or within a

Performance Analytics tab

* Export to PDF: Convert the report to a PDF which can be generated immediately or sent as an

email

* Publish: Create a public URL for this report. Users may need to log into ServiceNow to view
the report and have an appropriate role in order to view all of the data.

When distributing a report, sharing has the ability to make the report visible to authenticated users

within ServiceNow.

Publishing a report makes it available to users outside of ServiceNow but does not necessarily share
the underlying data. Access Control rules restrict visibility to the underlying data but not to all

reports. For this reason, it is recommended to be cautious when publishing reports for external

visibility.
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Reports and Metrics servicenow

When you report on a table (for example, Incident or Problem), information
about the current state of platform data displays

A metric is used to measure and evaluate the effectiveness of IT service
management processes

— Metrics measures data over time to show past history

— Metrics can gather data as the data is updated

System tables are, by default, restricted from the reporting module. These tables include, but are
not limited to the following: syslog, syslog_transaction, sys_attachment, and sys_email.

Compared to reports, metrics are used to measure and evaluate the effectiveness of IT service
management processes. A metric could measure the effectiveness of the incident resolution process
by calculating how long it takes to resolve an incident.

Sometimes a metric can be easily obtained from the data. For example, to find the number of
incidents that were created today, a report will count the number of incident records in the Incident
table with a created date of today. Other times, metrics need to be gathered as data is updated. For
example, determining how long an incident was assigned to a certain group requires collecting
information about assignment changes and calculating the duration of each assignment.

The Metric Definition plugin provides a declarative way of defining metrics, and, once defined, the
data for the metric is gathered, and occurrences of the metric are calculated and stored.
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Performance Analytics servicenow

Performance Analytics enables you to track and aggregate data over time
through elements called scorecards and indicators
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List of available KPI (indicator) trends ~ 1 Detailed indicator trends presented on a Dashboard

Performance Analytics enables you to track and aggregate data over time, such as to measure how
many tickets are resolved each week per assignment group. Performance Analytics is enabled for
the Incident table by default. To track data for other tables and applications, you must

license Performance Analytics.

Performance Analytics samples source data on a daily basis to build a trend over time.

Performance Analytics for Incident Management comes with several predefined elements that you
can use to assess organizational performance, including:

* Indicators: define the metrics to track based on an indicator source, and specifies an
aggregation such as to count the number of new tickets

» Data collection jobs: automatically collect scores for automated indicators and breakdowns

* Scorecards: display scores for a single indicator and allows you to perform detailed analysis of
the metric, such as comparing scores over time

» Dashboards: contain actionable data visualizations that help you improve your business
processes and practices

Performance Analytics for Incident Management is a limited version of Performance Analytics that is
included in the base system, enabling you to become familiar with the functionality.

Performance Analytics premium allow you to create indicators and other configuration records such
as breakdowns, and collect data for tables other than Incident.
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Dashboards Overview

servicenuw

Dashboards enable
you to display multiple
Performance Analytics,
reporting, and other
widgets on a single
screen

Use dashboards to
create a story with data
that can be shared
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Dashboards may be responsive or non-responsive, but are set as non-responsive by default.
Responsive dashboards require the activation of the Performance Analytics plugin on upgraded

instances.

With dashboards you are able to:

» Create and edit Performance Analytics reports and other widgets directly from the dashboard

» Use the Add Widgets pane to quickly find and preview widgets, then add them to the

dashboard

* Easily share dashboards with other users from the integrated sharing pane

* Use quick layouts to snap widgets into a predefined layout, then adjust the layout as desired

* Set dashboards as your homepage so you can quickly access information that you use

frequently

NOTE: There is a lot you can do with dashboards so it is encouraged that you to find more
information at the ServiceNow product documentation site.
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Section Summary

What is ServiceNow Reporting? Lab 4:5
Reporting
Report Types
Creating and Editing Reports @‘
Report Designer
Metrics Pages 260 - 264 10 - 15 minutes
Performance Analytics
Dashboards

Lab 4.5 — Reporting:

* Create a report for a group

* Share the report to a group
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LAB
Reporting 4.5

B . (4 10-15 minutes

Lab Goal

Lab Dependency: Requires the completion of Lab 1.3.

This lab will show you how to do the following:
* Create a report for a group
* Share the report to a group

Members of the Service Desk would like a report built which provides a high-level summary of
all incidents assigned to their groip, organized by incident category and priority.

Winnie Reich will create a report and then have the system administrator share it to her team.

A. Create a Report

1. Impersonate Winnie Reich.

2. Open the list of Reports by navigating to Reports > View / Run.

NOTE: Although the first part of the lab is completed as Winne Reich, any user with the
right permissions can access the Reports application menu and modules to create and
share repots.

3. Click on All from the header options:

= Reports Myreports | Group Global

4. Use the search bar at the top-right to search for reports containing incidents by
priority in their title.
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5. Once the results display, click Incidents by Priority and State to open the report:

= Reports Myreports Group = Global E] Title contains: incidents by priority €3
¢ Dme  +Title Table Createdby  Last modified
A it - . : . s .
7> 17 Inciden Priority an Incident [incident]  admin 2015-11-1306:16:17
/ L:.' " Incident Priority an rthan Incident [incident]  admin 2015-11-13 06:16:59

6. The Report Designer loads with the report displaying information:

( Edit report Switch 10 Clissic U @ ﬂ - “
Data > Type > Configure >  Style o Incidents by Priority and State
R Data source: Incidents. Open (incident)
ow
Data source conditions: Active = true
Priority v
? All
Column
State v Incidents by Priority and State
Aggregation
Count Crieical 1 13 4
Max number of groups
20
« Show Othar e y
1 - Moderate 2 ] 1
4 - Low 1
5 = Mamning 3 4 < 1
* o
w |

7. Select the Data breadcrumb title from the panel on the left, then update the name
of the report to Incidents by Priority and State (Service Desk):

> Type > Configure > Style

>k Report name

| Incidents by Priority and State (Service Desk) |
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8. From the main reporting area, where the data is displayed, click the Open condition
builder icon (funnel) to apply a filter on the data:

C

Data source: Incidents.Open (Incident)

Data source conditions: Active = true

?m

Incidents by Priority and State (Service Desk)

Incidents by Priority and State

9. Use the dropdown menus to set a single filter condition:

Assignment group | is | Service Desk

¥ CONDITIONS

Assighmentgroup w

All of these conditions must be met

is v Service Desk

Xvw

10. From the Report Designer header, click the Run button:

11. Notice the report’s data has updated:

1 - Critical 1

3 - Moderate

S = Manning

? All > Assignment group = Service Desk

Incidents by Priority and State (Service Desk)
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12. Open the Save menu by clicking the downward-facing arrow, then select Insert to

save a copy of the new report you created:

o o [] HENR

Insert and Stay

B. Share the Report

1.

2.

Impersonate System Administrator.
Reports > Administration > All.

Locate and open the record for the Incidents by Priority and State (Service Desk)
report.

Click the Edit Report button:

@ System Administrator ~ o, & ® @

Update View Report Edit Report Delete 1\

From the Report Designer, open the Sharing menu:

@ i] @I Save w

Select Share.

Choose Groups and Users, then add the Service Desk to the Groups list:

Sharing settings X

Visible to : Me Everyone @ Groupsand Users

l Groups | Users

Groups:
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8. Click OK to close the Sharing settings window.

9. Save the report.

Lab Verification

Access Report from Group Category
1. Impersonate Kevin Edd.
2. Reports > View / Run.

3. From the Reports list, select the Group category:

= Reports My reports Global All

v Iype  +Tite Table Created by

Incident [incident] winnie.reich

NOTE: The Infinity report is now available to all users in the Service Desk group.

Wonderful! In this lab you have learned how to modify an existing report and share it.
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Module 4 Recap servicenuw
Service Automation
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For these selected topics, discuss:

Why would you use these capabilities?
When would you use these capabilities?

How often would you use these capabilities?
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‘ Intro to Scripting & Application Tools
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Module 5 - 5.1 Scripting servicenow
Objectives
* What are Plugins?
* What is Scripting in ServiceNow?
— Client/Server Side Scripting
* Script Types
— Ul/Data Policy
- Ul Action
— Client Script
— Business Rule
* Scripting Areas in ServiceNow
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What are Plugins?

servicenuw

Before adding script to
ServiceNow, administrators
should check the list of
available plugins

Plugins provide additional
optional functionality within
a ServiceNow instance
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System administrators have control over when to activate plugins.

Some plugins include demo data - sample records that are designed to illustrate plugin features for

common use cases. Loading demo data is a good policy when first installing the plugin on a
development or test instance. Demo data can loaded after the plugin is activated by repeating this

process and selecting the checkbox. If the plugin depends on other plugins, these plugins and their

activation status are listed.

Most plugins are published, and system administrators can activate any published plugin. But, some

plugins are available only by request due to operational considerations making the plugin only
appropriate for certain deployments. In these cases, to activate the plugin, make a Service Catalog
request to ServiceNow Technical Support using the Request Plugin Activation form at

https://hi.service-now.com.
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What is Scripting in ServiceNow? servicenuow

Scripting in ServiceNow or Platform Scripting is the customization of an instance and/or
applications by using JavaScript

Dependent on how the script is executed, JavaScript may execute on the client or server
side and fundamentally alter how the baseline instance functions and user experience

Request

i
I

Internet Gzl

Response

Web Browser (Client) Application ServiceNow
Server

Client refers to an application or system that accesses a remote service or another computer
system, known as a server. A server is the computer program running as a service; a physical
computer dedicated to running one or more services, or a system running a database.

ServiceNow uses a Software as a Service (SaaS) model; the web browser is the client. The web
browser is the only thing that is installed on the client. The application server and the database live

at the Data Center. Client scripts run on the client browser. Server scripts run on the server (which
includes the database).

Client to server round-trips take time and make the end-user wait for the round-trip to complete.
Request + Response = Round trip.
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Script Type: Ul Policy and Data Policy servicenow

A User Interface (Ul) Policy is a rule that is A Data Policy is a rule that enforces data

applied to a form to dynamically change consistency by setting fields as mandatory

form information or the form itself and/or read-only

Once a Ul Policy is saved, Ul Policy Actions Data Policy controls are similar to Ul Policies

determine what happens on the form, but Ul Policies are only enforced on data

including: entered into a form (passing through the Ul)
' 59“—""8 a field as mandatory — requiring a Data Policies are applied to all data entered

value in order to save the record into the platform; form (Ul), Import Sets, or

+ Setting a field as hidden — no longer Web Services

displaying a field on the form
A Data Policy execute on the server side but

Setting a field as read-only — preventing a A : i
can also run as a Ul Policy on the client side

user from updating its value

Ul Policies execute on the client side Use as Ul Policy on client v/

To immediately implement updates and changes to forms and lists, you can use Ul Policies which
allow you to add sophisticated controls without having to write scripts and define custom process
flows for tasks.

Use a Ul Policy to set fields on a form to:
* Mandatory or Optional
* Hidden or Visible
* Read-only or Editable

NOTE: To apply a Ul Policy to all views, set the Global setting to true.

A Data Policy enforces requirements on field and record data when the data is imported into
ServiceNow or when the data in an Import Set is submitted through an external system. Data
Policies can be opted out for Web Services and Import Sets. A Data Policy is used to set mandatory
and read-only states on form fields. Data Policies can be used on lists to make a field read-only; the
field will appear to be editable, but the update will fail.

The purpose of a Data Policy is to standardize the same data across ServiceNow applications.

NOTE: Ul and Data Policies are not about security, they are about managing the user experience.
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Script Type: Ul Action servicenuw

User Interface (Ul) Actions add buttons, Formbutton v/
links, and context menu items on forms

and lists, making the Ul more interactive,
customizable, and specific to user activities ——

Form context menu

For example: enabling a Create Problem Formstyle | —Mone-
button on an existing incident form

List banner button

| I List bottom butt
Save Create Problem Resolve Delete o e

List context menu

List choice

List link

List style -- None -

"

Ul Actions can contain scripts that define custom functionality. Ul Actions can be server or client
side depending on the 'client' check box selection. This setting determines when a Ul Action can
appear.

Ul Actions include:

L]

Form buttons

Form context menu items (right-click the header)
Form links (Related Links in a form)

List buttons

List context menu items (right-click a record)

List choices (at the bottom of a list)

List links (Related Links at the bottom of a list)

When Order 100 is specified, Ul Actions with Order numbers greater than 100 will display after this
Ul Action, while Ul Actions with Order numbers less than 100 will display before this Ul Action, in
the user interface.

NOTE: When the Ul Actions Active box is checked, the Ul Action is running and visible unless there is
a condition met that specifies otherwise.
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Script Type: Client Script

servicenuw

Client Scripts make “real-time” changes to the
appearance of the user interface, especially
forms

Client Scripts can be created to do the following:

Automatically update the location field to reflect
the value (user) entered into the caller field

Disable the attachment link of a closed record
when the form is loaded so a user is unable to
add or modify attachments

* Display a notice at the top of the page to
confirm a catalog request was submitted

Client Scripts execute on the client side

o the caller bl MADrmar cally Wt the 0 200n Selr vaiee Saned on the caler

E = 3 4 » & F 9 H S §

fuaction onCrangelcentrol, olévalewe, newialue, Lnloading) {
Af (islosding || (g form. islivelpdating &b g ferm. Lslivelpdatingl)))
retern;

A (neValoe = *°) {
a_Toern. setValee! "locatian', ''))
retera;
}
i (g form, el leldl “lacation’))
reftern;
var caller = g_form.getRefereace! "caller_id’, setiocation);
)

function setiocationicaller) {
Af (caller)
a_fore, setValeel " location’, caller.location);

}

Client Scripts allow for browser/form manipulation and verification such as making fields visible on a
condition. An example of this would be an alert appearing when a user changes the priority of an
incident. Client Scripts get executed on the browser, but you may also run a Client Script when a
database lookup is needed; if you think you need database info, and you need the info frequently
(such as every form load) then ask: Is it a field you can add to the form but hide? Is it something you
really, truly need?

Several types of scripts are supported:
* onCellEdit(): runs when a cell on a list changes value through use of the list editor
* onChange(): runs when a particular field changes value
* onload(): runs when a form is loaded

* onSubmit(): runs when a form is submitted

Unlike onLoad() or onSubmit() scripts, onChange() scripts apply to a particular widget on a form,
rather than to the form itself. They are fired when a particular value on screen changes. An onLoad()
script runs when a form is first drawn and before control is given to the user to begin typing.
Typically you use an onLoad() script to perform some client side manipulation of the document on
screen. An onSubmit() script runs when a form is submitted. Typically you use an onSubmit() script
to validate things on the form to make sure the submission makes sense. As such, onSubmit() scripts
can potentially cancel a submission by returning false.
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Script Type: Business Rule Servicenuw

A Business Rule is configured to run when Business Rules can be set to run before or after

a record is displayed, inserted, updated, the database action has occurred
deleted, or when a table is queried

The When setting determines when the
Business Rule executes and has the following
choices:

* Before a record is saved to the database
* After a record is saved to the database

* Async (queued); client and server work
independently so the client is not waiting
for the server

« Display before the record is displayed

Business Rules execute on the server side

Although there are multiple ways to control behaviors in the ServiceNow application, most
customization of platform behavior is done using Business Rules. Business Rules are loaded and
initialized at the beginning of each interaction between a user and the platform.

Every Business Rule includes what table to run against and timing (before or after insert and more),
what conditions to evaluate, what script to run based on the evaluation, and if it is client-callable.

Business Rules are consistently applied to records regardless of how they are accessed-through
forms, lists, or Web Services. This is one major difference between Business Rules and Client Scripts,
which only apply when editing through the form.

Unlike Ul Policies, Business Rules are NOT real-time:
* They do not monitor fields on a form

* They monitor records as they are inserted or updated

Business Rules run on the server, but can be client-callable. If the Client callable setting is checked,
the client can use AJAX to call the Business Rule.

The primary objective of display Business Rules is to use a shared scratchpad object,
"g scratchpad", which is also sent to the client as part of the form. This is useful when you need to
build client scripts that require server data that is not part of the record being displayed.
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Scripting Areas in ServiceNow servicenow

Ul/Data Policies

Ul Actions Business Rules Client Scripts

Ul Macros
Ul Scripts
Ul Properties
Ul Pages

ACL Scripts

Workflow Scripts
Ajax

Transform Maps Script Includes

ServiceNow has over 30 places where code can be inserted to change the behavior of the platform.
JavaScript is used almost everywhere and it is a very flexible and powerful language commonly
known for its inclusion in most modern web browsers. This has made it almost mandatory for web
development these days, with its simple syntax allowing many people to quickly add simple logic to
web pages with minimum effort. Taking advantage of this familiarity, ServiceNow uses JavaScript
both on the server and on the client.

You can learn more about the Scripting in ServiceNow course at
https://www.servicenow.com/services/training-and-certification/scripting-in-servicenow-
training.html and additional information on scripting at our product documentation site
(docs.servicenow.com).
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Section Summary

What are Plugins? I.a!:: 5'1
; i - Scripting
What is ServiceNow Scripting?
Ul/Data Policy @‘
Ul Action E
Client Script Pages 277 - 280 10 - 15 minutes

Business Rule
Scripting Areas in ServiceNow

Lab 5.1 — Scripting:

* Create a Ul Policy with a Ul Policy Action

* Create a Business Rule
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Scripting

LAB

9.1

B . (4 10-15 minutes

Lab Goal

Lab Dependency: Requires the completion of Lab 1.3.

This lab will show you how to do the following:
* Create a Ul Policy with a Ul Policy Action
* Create a Business Rule

Cloud Dimensions would like to continue configuring ServiceNow as much as possible by using

baseline functionality and available features.

A. Create a Ul Policy

One requirement for Cloud Dimensions’ process improvement is to require important Infinity
support data, with the goal to speed up resolution time. To achieve this, create a Ul Policy and

Ul Policy Action to make the Assigned to field required for employee incidents.
1. Ensure you are logged into the instance as System Administrator.
2. Incident > Create New.
3. From the Form Context Menu, select Configure > Ul Policies.
4. Click New.

5. Fill out the Ul Policy form information as shown:

Table: Incident [incident] (already selected)
Short description: Mandatory Assigned to if Employee = True

Under the When to Apply tab,
Conditions:
Employee | is | True

6. Save.
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You have just defined a Ul Policy and set the conditions on which it will be enforced.
Next, indicate which field(s) to affect by the Ul Policy.

Create a Ul Policy Action
1. Scroll down to the Ul Policy Actions section, then click New.

2. Enter the following information on the Ul Policy Action form:

Field name: Assigned to
Mandatory: True

3. Click Submit to save the Ul Policy Action.

NOTE: A message may display indicating multiple Ul Policies with the same order for this
field exist. Basically, this means there are other policies that may run at the same time as
this one, and that the end-result may not be predictable. You can view the other policies
by selecting their names in the message — adjusting either policies accordingly.

Confirm New Ul Policy is Working
1. Incident > Create New.

2. Make sure the Employee field is on the form.

NOTE: If you do not see the Employee field, switch to the Infinity form view.

3. Select the Employee field.
4. Notice that the Assigned to field is now mandatory.

5. Uncheck the Employee field and notice that the Assigned to field is no longer
mandatory.

B. Create a Business Rule

In this section of the lab, create a Business Rule to display an alert, “Your incident has been
successfully submitted” to all users who submit an incident, improving overall user experience.

1. Onanincident form, open the Form Context Menu.
2. Select Configure > Business Rules.

3. Click New.
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4. Fill out the Business Rule form as shown:

Name: Alert - Incident Submitted
Insert: [check]

5. Add a message:
a) Click the Actions tab
b) Check Add message

c) Add message text: Your incident has been successfully submitted.

Set field values

-- choose field - v Te - value —
Add message
Message (D =]+
o I U ~» FontFamdy ~  FontSizes ~ Hi~

LY
u

A~ B~ & 2 8B o | E E E = -

o Your incident has been successfully submitted.

P

6. Click Submit.
Test Your Business Rule
1. Incident > Create New.
2. Fill out the incident form, including values for all mandatory fields.
3. Click Submit.

4. The new Business Rule displays your message in blue on top of the list:

=  Incidents [Infinity view] m Goto Number v -\/t 44 4 1 to200f39 b PP

® Your incident has been successfully submitted. X
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Lab Verification

Incident Ul Policy — Mandatory Assigned to if Employee = True

Employee § Priority (¥ 5-Planning
Location Q, Assignment group Q
Category  Inquiry / Help $ % Assignedto Q,
Business Rule — Confirmation Message
=  Incidents [Infinity view] m Goto Number v % 44 4 1 w20f3 P Pp

@ Your incident has been successfully submitted.

X

Good job, you have learned how to create a Ul Policy and Business in this lab!
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Module 5 - 5.2 System Update Sets

servicenow

Objectives

* What are Update Sets?
— What is Captured in an Update Set?
— Compare, Revert, and Merge
- Best Practices

* Introduction to Integrations
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Update Sets —

An Update Set is a group of £o2 398
customizations that can be moved from @
one instance of ServiceNow to another

Update Sets allow administrators to e

group a series of changes into a named

set and then move them as a unit e Eg O G

. _ ~(o><:v)~c::)0)o:>o)
Every instance of ServiceNow has a

Default Update Set, but users can Development Production
create additional named sets

An Update Set example:

» A set of enhancements to Incident Management can be grouped in an Update Set called
Incident Management 2.0.

* While Incident Management 2.0 is marked as the current Update Set, all process changes
are tracked in it.

* Once the Update Set is marked as complete, it is ready to be moved to a test or
production instance.

Basically an Update Set record is a “point in time” XML snapshot of process records. An Update Set
works by writing changes from tracked tables to the Customer Update [sys_update_xml] table.

An Update Set is used to apply changes that have been checked and verified in another instance.
When merging multiple Update Sets, if several Update Sets have modified the same object, (for

example: the Incident form), the most recent change will be the one moved to the new, merged
Update Set.

An Update Set is a container for configuration records. By navigating to System Update Sets > Local
Update Sets, you can create a new Update Set or set an existing one as your current Update Set.
Use an Update Set to migrate your code. When an Update Set is completed, you can transfer it to
another instance to move customizations from development, through testing, and into production.
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What is Captured in an Update Set?

servicenuw

9

Process Records

* Business Rules

* Client Scripts

* Fields

* Forms and Form Sections
* Reports

* Tables

* Views

* Roles

* Published Workflows

X

Data

New Data Records
Modified Data Records
Tasks

Modified Cls

New Users and Groups
Schedules

Scheduled Jobs
Homepages*

What is captured in an Update Set is typically a customization, or a change made to tables.

Homepages are not captured in an Update Set but can be manually added by navigating to
Homepage Admin > Pages, right-clicking on a homepage record, then selecting Unload Portal Page.

NOTE: Data is not captured in an Update Set. Examples: a new incident or new change record would

not be in an Update Set.

When completing work, you may want to move data records with your updates. These records can
be useful for testing or training. Data (such as user records, Cls, or locations) can be moved using the

Export XML function.
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Compare, Revert, and Merge Update Sets
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Comparing Objects

Changes are tracked and you
can customize objects on a
table with the update_synch
attribute, including:

Tables

Forms

Fields
Business Rules
Client Scripts
Views

Revert Compared Versions

You can compare versions
before reverting a change

You can only revert back to
the most recent base
version

Merge Update Sets

Update Sets can be merged

If two users are working on
separate Update Sets they
can be combined into one
Update Set for easy transfer

You can compare a version to the current version for any customizable object that a user has
modified, such as a form layout or Business rule. The Update Versions [sys_update_version] table
supports this feature.

NOTE: Administrators can suppress versions for specific tables.

To revert changes:

1.
2
3.
4

. The selected version becomes the current version.

View a list of versions for an object.

Right-click a version and select Revert to this version.

Click OK to confirm the action.

If both Update Sets have an update for the same object (for example, both Update Sets modify the
Incident form), the most recent change will be the one moved to the new merged Update Set. The
other update will be left in its original Update Set. Once a merge is performed, the other Update
Sets remain, and if there were collisions, the duplicates remain where they were.

This provides a reference for what got moved and what did not. After merging and validating, it is a
good idea to delete or empty the original Update Sets. The platform will not remove an update from
an Update Set unless it was the one chosen for the merge.
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Plan and Manage the Update Sets Process servicenow

Manage Changes and Communicate Effectively
— Have a plan & identify a common migration path

— Know what is being developed & make sure the Administrators are aware of
developments

Include many changes in one set

— Not: “Many changes, many sets”

Best Practices

— Group like items in a small manageable set

The typical process of retrieving an Update Set includes verifying the Update Set is in a Complete
state, Retrieve, Preview, and Commit.

Check that both instances are the same version since customizations may not work if they rely on
code that has changed between versions.

Determine the changes to make in a single Update Set since ServiceNow recommends limiting
Update Sets to a maximum of 100 records to reduce the number of potential conflicts and make it
easier to identify and review changes.

Ensure that all platform records have matching sys_id fields since some platform records are
created on an instance after provisioning and do not match between different instances, leading to
problems with Update Sets. The best way to avoid this issue is to provision production and sub-
production instances. You can clone the production instance onto the sub-production instance.

NOTE: Newest change will always overwrite older changes.
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Introduction to Integrations servicenuow

To share data between ServiceNow and an external system, ServiceNow
integrates with many third-party applications and data sources

Standard integrations for ServiceNow include:
— Login (Single Sign-On)
— LDAP
— Communications
— Monitoring

— Discovery & Systems Management

The most common processes required for integration are the CMDB, Incident Management,
Problem Management, Change Management, User Administration, and Single Sign-On.

A variety of techniques can be used, most notably Web Services, LDAP, Excel, CSV and email, as well
as any industry standard technologies that use SOAP or REST WSDLs.
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Section Summary

Lab5.2
System Update Sets

@

Pages 288 - 291 10 - 15 minutes

* What are Update Sets?
* Integrations

Lab 5.2 — System Update Sets:

* Review an Update Set
* Create another Update Set
* Make platform changes and capture them in the new Update Set
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AB
System Update Sets 5.2

B . (4 10-15 minutes

Lab Goal

Lab Dependency: Requires the completion of Lab 1.2.

This lab will show you how to do the following:
* Review an Update Set
* Create another Update Set
* Make platform changes and capture them in the new Update Set

Update Sets are a useful tool for transferring configurations between ServiceNow instances.

As Cloud Dimensions system administrator, review an Update Set to identify configuration
changes that have been captured throughout class.

Finally, create another Update Set and capture additional changes that will be transfered in the
next lab.

A. Review an Update Set

You may remember that we created an Update Set in Lab 1.2 which has been collecting updates
we have made to the lab instance. We will review some of these updates.

1. Logged into the instance as System Administrator, open Settings from the banner
frame:

2. Select Developer.

3. Next, toggle on the switch for Show update set picker in header:

Show update set picker in header

—
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Close out of the System Settings window and return to your main instance screen.
You will now see a drop down menu in the banner frame, next to the user menu:

U Q System Administrator ~ o, @ @

This is the Update Set Picker menu. It allows you to quickly select an Update Set to
capture platform configuration changes.

NOTE: If it is not displaying the Default Update Set, it should be displaying the
ServiceNow Fundamentals Update Set.

System Update Sets > Local Update Sets.
Locate and open the ServiceNow Fundamentals Update Set.

Notice how many total Customer Updates have been collected.

How many updates are there?

Find the updates for all of the script types created in a previous lab: Ul Policy, Ul
Policy Action, and Business Rule.

What other items are captured in the Update Set?
Locate the incident records created during the many labs before.

What items are not captured in the Update Set, but were created in class?

B. Create an Update Set

Now that you have seen the types of configuration changes Update Sets capture, create a new
Update Set and make additional configuration changes.

1.

2.

3.

4.

System Update Sets > Local Update Sets.
Click New to open the Update Sets form.
Enter the following name for the new Update Set: Problem Form Changes.

In the Description field, enter the following description of this Update Set:
Added Updated and Updated by after Assigned to on Problem form.

Click the Submit and Make Current button.
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6. A brief confirmation message displays and the current Update Set is shown:

7.

©@ Your current update set has been changed to Problem Form Changes [Global]

The current Update Set is also represented in the Update Set picker:

D Problem Form 4

Modify the Problem Form

1.

4.

Problem > Create New.

From the Form Context Menu in the Problem header, select Configure > Form
Layout.

Make the following layout changes:

Add Updated after Assigned to
Add Updated by after Updated

Click Save.

Mark Update Set Complete

1.

Click the View current Update Set icon, next to the update set picker, to open the
update set record:

Problem Form :]

NOTE: You could also navigate to System Update Sets > Local Update Sets, then locate
and open the record.

Notice on the Customer Updates tab that a new record is captured:

Customer Updates (1) Update Set Logs = Child Update Sets
= Customer Updates Gato Type v
? Update set = Problem Form Changes
() | = Created =Type a = View = Target name = Updated by
\, 2018-03-01 17:54:1 Form Layout Problem admin
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Change the Update Set State from In progress to Complete.
Click Update.

With the status of Complete, this Update Set is now ready to be retrieved by
another ServiceNow instance.

Lab Verification

Problem Form Changes Update Set

Customer Updates (1) Update SetLogs = Child Update Sets

= CustomerUpdates Goto Type v
? Update set = Problem Form Changes
() Q, = Created =Type a = View = Target name = Updated by
@ 2018-03-01 17:54:13 Form Layout Problem admin

Wow! You now know your way around Update Sets.
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Module 5 - 5.3 Development servicenow
Objectives

* ServiceNow Studio

* Delegated Developers

* Application Administration

* Application Scopes

* Developer Documentation
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ServiceNow Studio servicenow

ServiceNow Studio provides
an IDE-like interface for
application developers to
create custom applications

Application developers can
also access Studio to import
or open applications

ServiceNow Studio provides an IDE-like interface (integrated development environment). It offers a
simple way to identify and interact with application files, create files as you develop, and modify
existing application files in a tabbed environment. Accessing Studio requires an admin or a
delegated developer role.

With Studio, application developers can:
» See exactly what files comprise their application in the Application Explorer
» Add new files to their application using a single Create Application File interface
* Navigate to files using familiar search-by-name or by-type behavior with the Go To dialog
* Find code both within and outside an application using the Code Search tool
* Operate on multiple files at once using the tabbed interface
* Operate on multiple applications at once using multiple studio windows
* Publish the application to company instances or the ServiceNow Store

* View information about the current application from the Status Bar

NOTE: Studio is not intended for global applications and can behave unexpectedly when editing
them.
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Delegated Developers

servicenuw

Delegated developers Manage Developers X
are non-administrator Developers ——

users and groups which

Permissions for Kevin Edd

Q, Kevin Edd

are assigned one or File Type Access (3

more permissions to

Adl File Types

develop applications

Each permission grants PRow Dy

one or more delegated-
development-specific
roles to retain control

Sacurity / Entitioment (7

Manage ACLs &

over the system without Programming Tools

having the admin role Mow

(‘n(e n

Delegated developers can be granted the following permissions:

All File Types: Grants the developer access to all application file types including some not
granted by the other options

Integrations: Grants the developer access to web service APIs, REST APIs, and data sources
Reporting: Grants the developer access to reports and scheduled reports
Workflow: Grants the developer access to the Workflow Editor and Activity Creator

Service Catalog: Grants the developer access to catalog related file types such as catalog
items, record producers, and variables

Flow Designer: Grants the developer access to the Flow Designer design environment to
create flows and actions. Script action steps require the Allow Scripting permission

Service Portal: Grants the developer access to Service Portal editors and tools

Tables & Forms: Grants the developer access to model and layout related file types such as
table columns, form layout, and list layout

Manage ACLs & Roles: Grants the developer access to security-related file types such as
access controls and user roles

Allow Scripting: Grants the developer write access to script fields such as those in business
rules, client scripts, and Flow Designer script action steps

To manage delegated developers, navigate to System Applications > Applications, open the
application record, then click on Manage Developers.
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Application Administration servicenuw

Application administration allows organizations to protect sensitive application data by
restricting how users acquire application-specific roles

Application developers and administrators can use application administration to:

— Prevent unauthorized users from accessing sensitive data such as financial records or personally identifiable
information

- Restrict who can assign application roles

— Prevent admin users from assigning themselves access or bypassing existing access controls to a protected
application

You can enable application administration from the application record and restrict the assignment of
application roles from the user role record. Application developers should enable application
administration after completing application development and before adding application records.

The application's administration role only allows users access to the application and does not
include any other admin role. Someone must assign an application user an admin role before that
user can perform typical administration tasks such as configuring form and list layouts, making
changes to application tables and fields, and assigning the application admin role to new users

If you do not want the application administrator to have the admin role, the application
administrator can make themselves a delegated developer. Once a delegated developer, the

application administrator can perform a subset of administrative tasks without having the admin
role.

Additionally, admin users can be prevented from:
* Assigning themselves a protected application role or to a group containing said role

» Overriding or bypassing existing access controls to a protected application by creating new
access controls

* Impersonating or changing the password of users who have a protected application role
* Inheriting a protected application role

* Running scripts that access protected application records
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Application Scopes servicenuw

Application scoping protects applications by identifying and restricting access to
available files and data

Applications developed prior to application scoping are in the global scope

All custom applications have a private scope that uniquely identifies them and
their associated artifacts

App A App B
Table A Table B
Ul Policy A Ul Policy B
Business Rule Al Business Rule B1
Business Rule A2 Business Rule B2

Administrators can specify what parts of an application are accessible to other applications from the
custom application record and each application table record.

For example, suppose that you create a conference room booking application in its own application
scope. By default, the application can access and change its own tables and business logic but other
not applications unless you give them explicit permission.

The application scope ensures:
* The conference room booking application does not interrupt core business services

* Other applications do not interfere with its normal functioning

By default, all custom applications have a private scope that uniquely identifies them and their
associated artifacts with a namespace identifier. The application scope prevents naming conflicts
and allows the contextual development environment to determine what changes, if any, are
permitted. Application developers specify an application scope when they create an application.

The global scope is a special application scope that identifies applications developed prior to
application scoping or applications intended to be accessible to all other global applications.

The system adds a namespace identifier to the front of application artifacts such as tables, scripts,
and configuration records.
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Documentation: Developer servicenuw

service

Build Apps Faster

All of the resources you need to build applications
more rapidly than ever before

Develop Enterprisq smumex =}

developer.servicenow.com is a great resource for developers, but also anyone interested in
developing applications within ServiceNow.

There are great resources here related to development, including: scripting API references, free
training and documentation, and access to a free, personal developer instance.
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Section Summary

Lab5.3

* ServiceNow Studio
Development

Delegated Developers

* Application Administration E @‘
* Application Scopes
* Developer Documentation Pages 299 - 304 10 - 15 minutes

Lab 5.3 — Development:

» Sign up for a developer instance
* Define an Update Source

* Retrieve an Update Set, committing platform changes to the developer instance
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LAB

Development 5.3

B . (4 10-15 minutes

Lab Goal

Lab Dependency: Requires the completion of Lab 1.2.

This lab will show you how to do the following:
* Sign up for a developer instance
* Define an Update Source
* Retrieve an Update Set, committing platform changes to the developer instance

To end class, you will be walked through the steps to sign up for a developer instance on the
ServiceNow Developer Portal.

You will also practice the procedure of retrieving completed update sets from one instance of
ServiceNow to another. This emulates the experience of taking configuration changes made to
the platform of one instance and pulling them into another — just like pulling work from a
development instance into production.

Register for the ServiceNow Developer Program

Even if you are not a developer or plan to create custom applications in ServiceNow, once you
have access to a developer instance you will be able to use it to revisit the topics discussed in
class, as well as have fun within your very own instance of ServiceNow!

1. Go to https://developer.servicenow.com/

2. Select Register from the upper right-hand menu, then fill out the form, then finally
read and agree to terms of use before clicking Submit.

3. Look for and open an email from ServiceNow (signon@service-now.com).
4. Select the link in the email message to validate and activate your account.

5. Sign in with your username and password created in step 2, then read and accept
the ServiceNow Developer Agreement.

6. Answer a few questions to maximize your experience, then click Submit.
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7. Under My Instance, click Request Instance:

service developers FEEDBACK ME) MYLES FERICH = | MORE SITES

PROGRAM LEARN API MANAGE COMMUNITY EVENTS BLOG

] £

Developers and Architects — Come out and Play!

My Learn'ng In Progress Finished My Instance
S
You can request a ServiceNow
Learning Plans instance free of ch
to retain the instance, you must
have a minimum amount of
activity or the instance will be
You haven't started any Learning Plans reciaimed

Courses

JAKARTA L

NOTE: If this page does not display, you can click on the ServiceNow logo or, from the
main menu, select Manage > Instance.

8. Complete the form to tell ServiceNow how you will use the personal developer
instance, then click | understand.

9. You may choose any available version of ServiceNow you would like, but Kingston is
recommended:

Which version of ServiceNow would you like?

B Helsinki Release Notes @ Istanbul Release Not B Jakarta Release Nots & Kingston R

If you aren’t sure which version to choose, start with Kingston.
It's our latest available release and we have an instance ready for you to get started.
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10. After selecting the ServiceNow version of your choice, the credentials to your
personal developer instance will appear under the My Instance section:

My Instance

The credentials to log into
your assigned developer
instance are:

Username: admin
Password: kh1otISNOJ8T

You can also use this link to
log into the instance.

IMPORTANT:
Capture your username and password as it will not be available after the next step.

11. Under the instance log in credentials, click the link to log into the instance directly:

You can also use this link to log into the instance directly.

12. Use the credentials above on the login screen, then change the temporary password
to successfully sign into your instance as system administrator.

B. Define an Update Source

1. Within your developer instance, navigate to Problem > Create New.

2. Observe that the Updated and Updated by fields are not displayed on the problem

form yet:
= Problem o ]
< = Newrecord ’ +— oo Submit
Number = PRBOOM000L State  Open
Business service Q Iimpact 3- Low
Configuration item Q, Urgency  3- Low
Change request Q Priority (¥ 5. Planning
Major problem Assignment group Q
Knowledge Assigned to Q
Short description
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10.

11.

12.

13.

14.

System Update Sets > Update Sources.

Click New.

Name: Imported Problem Form Edits

Click the padlock to the right of the URL field.

Input your course lab instance URL: https://instance-###.lab.service-now.com/

Enter this instance’s admin username and password.

NOTE: These are the system administrator credentials your instructor provided, and
which you have been using during class.

Type in a brief description of the Update Set into the Short Description field:
Modified Problem form fields, adding Updated and Updated by.

Your form should look like this:
< FSl ﬁm;nétance ’ ".__t ooo  Submit Test Connection
Name Imported Problem Form Edits URL https://sfunjr-007.lab.service-n @

Type Development

Username admin
Password ——
Active

Short description Modified Problem form fields, adding Updated and Updated by.

Click the Test Connection button.

NOTE: A brief Connection is OK message will display, which may also include language
about varying version snapshots.

Save.
Click Retrieve Completed Update Sets.

Close the Retrieve Update Sets progress pop-up once it has reached 100%.
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Locate Retrieved Update Sets

1. From the Retrieved Update Sets tab, open the Problem Form Changes record:

Remote Batch Update Sets = Retrieved Update Sets (2) = Update Set Logs (8)

Retrieved Update Sets Goto Name v

? Update source = Imported Problem Form Edits
() Q, = Name A& = State = Description
@ Enable Report ble Report Previewed
Designer
Problem F - Added Updated and Updated by
P
® Changes e after Assig...

2. From the form header, click the Commit Update Set button.

NOTE: This update set has already been previewed — checked to make sure its contents
do not interfere with the target instance. If your developer instance is not running
Kingston, you will need to click Preview and will get a collision error. You may accept the

remote update and Commit to continue with the lab.

3. Close the Update Set Commit pop-up when its succeeded.

4. System Update Sets > Retrieved Update Sets.

5. You should see the new Update Set with a Committed state:

= Retrieved UpdateSets Goto Name v 44 4 1 to2of2 P pp
Y All > Class = Retrieved Update Set
)] Q, =Name o = Application = State = Update source = Description = Loaded = Committed
! Enable Report : Im Pr 2017-07-21
@ v Global Previewed = - ot (empty)
Added Updated
Problem Form - Imported Problem 2017-07-21 2017-07-21
@® Global Committed I : and Updated by P .
Changes For i afer Assig. 09:47:48 09:52:18
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Lab Verification

1. Problem > Create New.

2. You should now see the Updated and Updated by form fields:

Assignment Q
group
Assigned to Q

Updated

Updated by

Congratulations, you have completed the Development Lab, and the ServiceNow
Fundamentals course!
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For these selected topics, discuss:

Why would you use these capabilities?
When would you use these capabilities?

How often would you use these capabilities?
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Capstone Project

To help reinforce the various topics presented
in ServiceNow Fundamentals, we present the
final course component; a take-home eight task
Capstone Project

The Capstone Project is a multifaceted homework assignment.

Specifically, eight typical implementation tasks which serve as a culminating project where you can
safely apply your newfound ServiceNow Fundamentals knowledge in a less guided, more
experiential, set of lab exercises.

As a prerequisite step, and as was with your last in-class lab, you will need a free ServiceNow
Developer Instance.

Capstone Project
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Formats

servicenow

The Capstone Project is available in two formats:

Challenge

* Included in your participant guide

* Provides minimum assistance to
achieve end results; objectives
are given but how you get there is
mostly up to you

Step-by-Step

Downloadable from your instance
Provides full assistance to achieve
end results; detailed instructions
are given to walk you through the
completion of each task

The Capstone Project: Challenge Format is included in your participant guide. We strongly

recommend that you try to solve each Capstone Project task using just the Challenge format. If you
have difficulty completing a task, you can refer back to slides, notes, and labs.

If you find yourself still struggling, or prefer to complete the tasks “by the book” then no worries!
Step-by-Step task solution guides are available. Locate and download these solution guides from
your class lab instance. They are located under Capstone Project in the ServiceNow Fundamentals

Class Knowledge Base.

Capstone Project
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Scenario for the Capstone Project servicenow

IAGIAITY |-

SELETTE

ALIDADE o,

Cloud Dimensions has developed and tested a series of Infinity devices,
used as an example throughout this course

After great success demonstrating said devices at various trade shows and
conferences, Cloud Dimensions has officially begun production on a new
product; the Infinity Alidade

Cloud Dimensions needs a software solution to support new business processes, which are still
being developed, and requires that the solution be able to scale appropriately in order to support
ongoing, rapid growth.

ServiceNow has proven to be the best solution to meet Cloud Dimensions current requirements and
support plans for ongoing expansion. Therefore, Cloud Dimensions is ready to move forward with a
ServiceNow implementation for their latest product, the Infinity Alidade.

A worldwide product launch date is aligned with the ServiceNow Go-Live date, so as a Cloud
Dimensions System Administrator, you have been tasked with the responsibility to customize the
Cloud Dimensions instance in support of technical needs for employees and customers alike!

Capstone Project
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Completing the Capstone Project

Working within a developer instance of
ServiceNow, impersonate a System
Administrator and use the knowledge
gained from this course to complete
eight implementation tasks.

These tasks include topics discussed
here in detail — as well as new topics
giving you the opportunity to explore
ServiceNow.

The ServiceNow Fundamentals Capstone Project is meant to be completed on a developer instance
of ServiceNow. Refer to Lab 5.3 — Development in the course for registering in the developer
program.

Remember once you start the Capstone Project: this is suppose to be a fun exercise! It is meant to
test the knowledge you gained in class and, most importantly, give you a chance to look around in
the ServiceNow platform.

If you start with the Challenge format as suggested, remember to use all of the resources discussed
in class, including docs.servicenow.com.

Enjoy!
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ServiceNow Fundamentals
Capstone Project: Challenge Format

Capstone Tasks Overview
The Capstone has been divided into eight task categories to guide your deployment:

Task 1 — Customize Your Instance
Module 1: User Interface & Navigation

Task 2 — Update Incident Management
Module 1: User Interface & Navigation

Task 3 — User Administration
Module 1: User Interface & Navigation
Module 2: Task Management

Task 4 — Update Service Catalog
Module 4: Service Automation Platform
Module 6: Ongoing Maintenance

Task 5 — Update Knowledge Base

Module 4: Service Automation Platform

Task 6 — Configure the Mobile Ul

Module 1: ServiceNow User Interface
Module 4: Service Automation Platform

Task 7 — Enhance Task Assignment and Communication
Module 5: Core Application Administration

Task 8 — Schedule a Report
Module 3: Data Management and Reporting

These tasks correlate to topics found in the ServiceNow Fundamentals materials; parent
modules noted.

To successfully complete the Capstone Project, you must select the Capstone Project article
in the ServiceNow Fundamentals Class Knowledge Base of your lab instance.

This will download a zip file contains file to your local machine titled Capstone Project which
contains relevant task files, as well as the Step-by-Step Solution guides for every task.
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Task 1: Customize Your Instance

Customize the instance to feature Cloud Dimensions branding styles that are familiar to
both employees and customers.

Additionally, you will create an organization company record to include contact
information and new welcome page content.

Configure Company Settings and Welcome Page

Use the ITSM Guided Setup to configure the following system properties:

Page header caption: Infinity Service Portal

Banner tab title: Infinity Service Portal

Banner image for Ul16: cd_sp.jpg

Header background color: #387bcc

Create new Welcome Page Content text for all users on the login page to say:

Short description: Welcome to Cloud Dimensions

Text: Welcome to the home of Infinity! If you are an employee of Cloud

Dimensions, please use your company login credentials to enter.

Create New Organization Company Record

Use the Organization Application to create a company record with the following company
information:

Name: Cloud Dimensions
Phone: 800-555-5555
Street: 3260 Jay Street
City: Santa Clara

State / Province: CA

Zip / Postal code: 95054

Capstone Project
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TASK VERIFICATION

Q Infinity Service Portal

y Filter navigator

Welcome to Cloud Dimensions
Welcome to the home of Infinity! If you are an employee of Cloud Dimensions, please use your company login credentials to enter.

Task 2: Update Incident Management

Modify the Incident form so that it can support a new process for troubleshooting
technical issues reported by Infinity users.

Modify the Incident Form

1. Create a new field and add it to both the Default and Mobile View of the Incident
form with the following properties:
e Name: Infinity Model
e Type: String
e Field length: Small (40)

2. Configure the Default View and place the Infinity Model field beneath the
Configuration item field

3. Configure the Mobile View and place the Infinity Model field beneath the Caller
field

4. Modify the Category field on the Incident form to include a new Infinity choice.
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TASK VERIFICATION

¢ | = Incident = Incident
== New record =  New recor§| [Mobile view)

Number INC0010004

Number INC0010004

> Caller Q
Category  Infinity
Category  Infinity

ap

Priority @ 5- Planning

Subcategory = - None- =
Business service Q State ~ New
Configuration Q % Caller
item

Infinity Model Infinity Model

Task 3: User Administration

Create a new user group that is responsible for troubleshooting Infinity incidents and
fulfilling Service Catalog Infinity requests.

Create Users, Groups, and Roles

Under the existing Service Desk group, create a new child group called Infinity Support that
includes the itil role and has Fred Luddy as the group manager.

Then create or add the existing users to the group:

¢ Beth Anglin
e Bud Richman
e David Loo

e Kara Prince

e Waldo Edberg

Additionally, set Fred Luddy as the Manager under Kara Prince’s user record.
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TASK VERIFICATION

< — Group
= nfinity Support

Name Infinity Support
Manager | Fred Luddy Q@

Description

Update Delete

Roles(1) Group Members(5) Groups

= erpﬂmb«snm Goto User v

¥  Group = Infinity Support

for Q = User
(i) Kara Prince

G) Bud Richman
Beth Anglin

(i) David Loo

i) wal r

Task 4: Update Service Catalog

Import an Infinity Prototype item into the Service Catalog to be requested, and develop
a workflow to support and complete the fulfillment process.

Import Service Catalog Item

Import an Update Set (cd_infinity_catalog_item.xml) containing the Infinity Prototype
Service Catalog item into the instance. Remember to retrieve, preview, and then commit!

Create a New Workflow

Develop a workflow to fulfill internal Infinity Service Catalog requests. It should feature the
following activities in this particular sequence:

e Approval by the requester’s manager
o The Approved path marks the requested item as approved with an Approval
Action
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o The Rejected path marks the requested item as rejected and then ends the
workflow
Continuing the Approved path are three Catalog Tasks:
o Catalog Task 1 details the steps for ordering the Infinity item and is assigned
to the Infinity Support group
o Catalog Task 2 details the steps for configuring the Infinity and is assigned to
the Infinity Support group
o Catalog Task 3 details the steps for delivering the Infinity and is also assigned
to the Infinity Support group
Upon completion of all three catalog tasks, mark the requested item as complete
with a Set Values activity

Validate and test the Workflow to successfully order, fulfill and deliver an Infinity.
NOTE: Test by submitting a request for the Service Catalog item by a user with a

manager and then impersonating every stakeholder involved, as determined by the
activities created above, to ensure it would work in a real-life situation.

TASK VERIFICATION

Items

¢  Service Catalog > Hardware 20perpage 3 Q Search catalog

_DI Hardware

Order from a variety of hardware to meet your business needs, including phones, tablets and laptops.

I Infinity Prototype $399.99
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Task 5: Update Knowledge Base

Populate the Knowledge Base with a new category that will contain two articles to
support internal requesters and fulfillers. Additionally, you must abide by company
security protocols and ensure the information is accessible by the appropriate parties.

NOTE: By default, all Knowledge Base articles must go through a Review Process before
they are published. You will enable automatic publishing on the Knowledge Base level.

Enable Automatic Publish

Adjust the settings for the IT Knowledge Base to allow for Knowledge Base articles to
instantly publish upon submission — using a publish workflow to bypass any review period.

Create a Requester Article

Create an article containing instructions for requesting an Infinity through the ServiceNow
Catalog, before clicking the Publish button on the article form. This article must be available
to all users and located in the IT Knowledge Base under the Infinity category. It should
contain the following properties:

e Short description:
Requesting an Infinity from the Service Catalog

e Text:
To request an Infinity, navigate to Self-Service > Service Catalog. Then, click on the
Hardware category and locate the Infinity item. You may also use the Service Catalog
search field to locate the item.

Click on the Infinity item name to open the ordering screen where you can customize
your request. Once satisfied, click the Order Now button on the right-hand side.

Create a Fulfiller Article

Create an article containing instructions for supporting inquiries about Infinity requests
through the ServiceNow Catalog, before clicking the Publish button on the article form. This
article must be available to all users with the itil role and located in the IT Knowledge Base
under the Infinity category. It should contain the following properties:

¢ Short description:
Supporting Infinity Service Catalog Requests
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e Text:
If the requester has a question about requesting an Infinity, redirect them to the
other Knowledge Base article: Requesting an Infinity from the Service Catalog.

If the requester has placed an order and would like to know about their request,
please have them contact infinityorder@cloudd.com.

TASK VERIFICATION
= Knowledge m Goto Number v O LI | 1 to200f35 » PP
%
i
= Number v £ Short description = Author = Category = Workflow = Updated

Supporting Infinity Service Catalog

Reg System Administrator  Infinity ’ - 2018-03-05 18:32:49
...

()  KB0010002

Requesting an Infinity from the . ; \
()  KB001000L 5:::“' ol . m Administr Infinity » ©1 ) 2018-03-05 18:31:39

Task 6: Configure the Mobile Ul

Configure the Mobile Ul to allow users to request an Infinity from the Service Catalog
and create a custom application menu with a module to track and manage active Infinity
incidents.

Publish a Service Catalog Item to the Mobile Interface

Update the Infinity Service Catalog item and set its availability to display in both the Desktop
and Mobile User Interfaces.

Develop an Application Menu for the Mobile Interface

The application menu should be named Infinity Incidents and limited in access to only those
users with the itil role. It should contain one module named Active that displays all incident
records that are active and associated with the Infinity category.

Create a test incident by Kara Prince which has the Infinity category and a short description
My Infinity will not turn on.

Capstone Project
© 2018 ServiceNow, Inc. All Rights Reserved 318
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£ Hardware A=

? Hardware

Order from a variety of hardware to meet
your business needs, including phones,
tablets and laptops.

Developer Laptop
‘ (Mac)
$1,499 +$100 Annually

$399.99

Infinity Prototypel

INFINITY INCIDENTS

Task 7: Enhance Task Assignment and Communication

Define an assignment rule that automatically assigns incidents to the Infinity Support
group, if the category is Infinity.

Then, develop an email notification related to new critical Infinity incidents assigned to
the Infinity Support group. Afterwards, test to ensure the email sends correctly.

Define an Assignment Rule
Define an assignment rule with the following details:

¢ Name: Infinity Incidents
e Condition: Category | is | Infinity
e Assignment group: Infinity Support

Create an Infinity Priority 1 Incident Notification

Create an email notification containing details about newly opened Priority 1 incidents that
have Infinity as the category. This notification should go to the current Infinity Support
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Manager only when a new Priority 1 Infinity incident is created and assigned to the Infinity
Support group. The notification should contain the following properties:

¢ Name: P1 Infinity Incident

e Subject: A new P1 Infinity Incident has opened: ${number}

¢ The Message HTML text should contain a collection of dynamic information listing:
o when the incident was opened
o who opened the incident
o the description of the incident

Verify the email is sending to the Infinity Support Manager by creating a new Priority 1
Infinity incident assigned to the Infinity Support group and checking the System Outbox.

= Notifications m Goto Execution Order v ‘/L 44 4«
L-' All > Active = true > Name contains Infinity
Q. = Name = Active = Table = Category = Email template £= Conditions
F.infinity true s [ Unsibscribe and category=Infinity” priority=1*assignment
() : : Uncategorized =Infinity" = -
w Incident [incident] Preferences -y Ll £

Task 8: Schedule a Report

Work with the Report Designer to create a report which displays the number of

incidents that are active and tied to the Infinity category. Additionally, group the data by

priority.

Schedule the report by sharing it with the Infinity Support group every Monday to
coincide with their incident review meeting.

Create a Report
Set the following properties for the new report:

e Name: Active Infinity Incidents by Priority
e Data source: Incident [incident] Table

e Type: Pie

e Group by: Priority

Schedule the Report
Schedule the Report to run weekly, every Monday at 8:30am, and sent to the Infinity

Support group.
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Add the following schedule details which will appear within the email containing a copy of
the report:

Subject:
Current Infinity Active Incidents Count

Introductory message:
Please find included the current count of all active Infinity incidents grouped by
priority.

This information will be discussed during the team’s incident review meeting today at
9:00am.

TASK VERIFICATION

MW 1-Critical=1(50%) M 5- Planning = 1 (50%)
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